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SER#tE
EonHEET H Ui
i H PiEe
12 Won G REIEGE MBI WEMEERE. 2K
HERS T Corr Hltdas 4 .
13 75 (On 5 Off) Loss Compensation (FiFEME) R
. % Loss Comp 454
14 L, %% Points () SREfRIEE],
15 WORNH I ERAE. Ao I E & RFE s, A7
H 2o e . 78 N8972/3A tf, X7~ RF ZEJL#8IR
16 W5, 7 Bandwidth 55D SEEAEEH .
W SEAE N89T2A M 5[] 5 /) 4 MHz.
17 SEMEECH, 5% Averages (CEI{E) SEFABEAH
13 HUL IR BRI A, 52 Center Freq (MO ) 5L
Start Freq ELAMIUR) SEHUBERS
19 Teolg (AURE) WAFE(H, 32 Teold S L.
20 WORIRESAT, R IERIRS T R .
21 T PR, 52 Lower Limit ( FFR) Sgiafdisdl,
22 Y ff BRI R AT, A2 Result (4551 HoY Scale
PRI SRyl
23 NEUIE KRR, 5% Scale/Div (br R/ ZIEE) Thfigks .
24 NERIESE RS, 52 Result F5 ] o
25 N FFR, 32 Upper Limit ( FFR) Thfgsdfstl.
26 F#HE IR, 5 Lower Limit ( FR) Sgiafdisdl,
27 Y fl R B SEE I AT, A2 Result HE5Y Scale S LR
il
28 AR R, 5% Scale/Div 32 LA H
16 $1E



#£1-3

K 1-6

UNRETE]

BRE
B HEET H Ui
i H BiHe
29 IR AL R, 52 Result 5] .

30 EE R, 5% Upper Limit Sz S gl

31 PR 2 W i 7 AT

K 1-6 b | MEAAIRA, % Meas Mode (JUEAIA) HEdshl. BRIA

WoR {49 Bomizdfs K. bid g AT TR, GRS K.
WEHEZRE

DUT Amplifier owncony Off

EXRENSHENX

fERTiREN &K

g1

ot
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L RA

%14

SR,

UNBE=]
HITEIESMENE

AT B R SR &

WA ST QAT TR DN BT s o] A 2 e 5 ) AR U FE 2R

HEnl DR Ixsest, Atk NFA. SREARAT I TR P — 4R, 1%
SO Preset (TH%) %,

M P A A I i DU'T it 2 2 f) P AN ) B A P FLP R AT
AR BRI AR Tl AR A AR AL R A R e
LY o

I S AR DN R S ARG R DR B SR . B NFA L oRg;
Ry AEFHME R HE I, 1248 U s ] 52 45 R BAR T . BRAE A 4
TR TN B AT [ AR D, E R ARV B 0 E NFA B
WHIN, JFHAZRPAR A

ARG BT VE iR, TS 2 &, “ATEANE 7.

T E—ANE L YR, SNS BOEH M S, 1IEH S A BNC
HLZi 5 28V OUTPUT (28 R &4, HifwH 5 INPUT50Q (i A\ 50 BX
i) %%, SNS Al 11730A 45 5 SNS s s, Himh S
INPUT 50 Q i%#%.

LR S A4 A 900 MHz Ait (015 [ S S OB 28, HHbe 0 it
FA BRI ER 1-4 SPTIIOBUR . T On (FIJP) IRk 10. 4%
% B 4 MHz.

16 DUT #ik&
R SENE LiRich ki B/l LBIEL Ik
900 MHz 23 dB 17 dB 3.5dB

B I A D R UL, A A B K
% on FTTTAAS, A0 YR B RE P SE 1o

18 F1E



AR

SR 2.

1% A

SR 3.

SR 4.

SR S5.

ANITHER
HITEEMENE

BT R PR, % NFA A E b — /i, IR E N
Alignment(On) (Eg#E (FT7F) ) o« BRINKE & Alignment(On).

% System. More 1 of 3. Power On/Preset. Preset (Factory).

Yok 1Y) Preset 2 .

R ENR QR DITC 2, 8] DUE 221 #E NFA.
NFA BaNfid. B, GrTLlgid D3R 3 M 4. W25 33 ut “ f Ak
Bt (ENRD #ds 7.

IEH e ENR AR5 L TSPl oe b ASHEUEAS b sl e A AL Y
izt . SNS ENR {E# L#5 NFA.

¥ ENR %, % ENR Mode G#m:bLRi) SEH kS ENR Mode(Spot) (i
M bR G CGRCRED D

% Spot ENR  (HIRLEMELL) g, Wi ENR EEEOMEARE, A
ENR fi.

T A S B (AR AN T A ) ENR A, 7522 A — N 4 i .
RN 15.200 dB.

FH Frequency/Points (Ji% / i) HEEF A S B 5% .

% Frequency/Points . % Freq Mode CHiFfiz0) g, Jfik+f Fixed
(%) EHEE. Freq Mode 3¢ 4t I /x Fixed #x.

% Fixed Freq ([l @ A% ) SEUEE, I FH A0/ a B i N\ 18 A5 2000 1 1R 5
FREAE . AN 900, FH HLALFR S BEL I LIZEE . ALK MHz.

F1 19
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S& 6.
LRA

S|,
AR

P& 8.

SE]I.

UNBE=]
HITEIESMENE

1l Averaging/Bandwidth (- / 755 ) B FF IR0 5 .
1% Averaging/Bandwidth %, 1fid %+ Averaging(On) P (FTTF) ) EH
B, KTl On.

% Averages LB, JHINEA B MEUE, b 10, fH Enter S
1IFZEE. BRAER 1.

£ N89T2A 15 b, ~PIYEB A P . PR EOAE
Average Mode(Point) PR (5D ) AT, AT F, K Pkt
A Average Mode(Point). 13 JCIX PRI Ui, 1525 53 1L “ Ik +
SR 7 A [ AR AU, AR R PRI AT [ 4 R

1 Bandwidth SEE, I S0 B0 P BRI 7 AP O S B ALAE
JHE RS 4 MHz, N8972A {Uiift 4 4 MHz 5 .

1 BNC 5% 15w v i N 5 NFA ) 28V OUTPUT (28 {R#EiH) %
e, A SNS, WY SNS i &EE . By S0 B e i 5 e 55
INPUT 50 Q (it \ 50 W) &z,

{fiF N89T4A F1 N8ITHA RIS, /MUK ks % 3.5mm 18 8 4 5 i
JIER R . ARAE RN FIEM A, 1S W Performance
Verification and Calibration Guide.

NS TN S W SR WTER G W
% Format . Format > HUe, JFERE Meter (JE) K ALA
1% K Calibrate .

PRI, IR, ORI IZPIE A S —Fh e 4
i, VABTERESME T Calibrate B,  #5ERAT AT AT AR A o

20 F1E



E 1-7

FE& 10.

UNRETE]
HATEESRENE

KA IE NFA JE S FTE 5 e /= i . RHEESERE, T4 A
Uncorr CRIEIE) HEHECH Corr (BIF) .

ROt ZEB A SR A8 B BT o AR B UK SR, SIS 58
71 4% RF i A Ek o 7.

R A DN A M e s AT NTFA SN 2 1)

S R o s, S 1-7 3840

TR 0% S B SR R ] S AR I B 5 R

5 Agilent | Freguency

= FreqMode,
- plitle ; O Fised
Freq MHz | NoiseFig d Gain dB Start Freq

900.0000 3.415 22.888

10.9006588 MHz

StopFreq
300600000 GHz

Center Freq
1.56508080 GHz

Freq Span
299080600 GHz

Fixed Freq
900.008008 MHz

Hore’
lof2

R -7 b o gi i s DUT (i) E 900 MHz (11 7 15 AR
B

Bk, DUT #5463 1-4 a1 i) il i R .

F1 21
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NREET]
PITE R STHIRME

PAT I SO A

R L TP R F R File S F 79 Zh A, A1 128 045
o sl iLRE

. {RATCI

. HASCH

o AT

o I

. BRI

A AR

AT AE NFA i Uit #%:00 MS-DOS. 37 2 NFA #i3(
WG AL W AE NFA F Al UG S 4

BB 1. KSR BRI N NFA (I shas (A .
B, 2. % File #. File Manager, {FHUCCAFE RIS EH., ES K 1-8,

22 F1E



K 1-8

L] 3.

T

SR A4.

AR
AT RS HHRME

File Manager (CUF&H88) 3KH

45 Agilent I File Manager

DUT Amplifier  Sys Downcony Off Copy»
Deleter

Rename»

Format»

i Format, #XJ51% Enter, JFUAME ALFEFP .

AR M AL, $2BR Enter ZAMIAER— M

RhEAR A, WA AT B i . NFA SoRas b & B — A%
TOHE, R S, OBt R L= .

k4% Enter, &2 ALREL .
¥ AR P 20 75 = 43 B 1]
S DAE W] LK SO R AT B A

F1 23
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PR’ 1.

P&’ 2.

SR 3.

PR 4.
i5tEA

SR S5.
LRA

SR 6.

NREET]
PITE R STHIRME

TRAFICAF

A LR s (ENR &L RS B, IR B, BUeRaifs) R
frfdt (a) B NFANERSE (c:) .

AP Save S5, #% File. Save.

TE PRI A AR (K SO AL

i, R BRI LI, AR, % Limits  (FRED .
PSR B M RIS (10 20 38i4) .

i, RORAFSCAE 2, 4% 2,

H Alpha Editor (Alpha 4uffe/7) SEHEMAN IR FR. 1l 29
7 “f# i Alpha Editor”.

TR B — AR SRR, I U AR\ 75 . NFA
ARV E EINA M. R EIEFE AN CRAFER ST, NFA &8
NEERINE: File already exists (XIFEEAEM) -

% Tab —, EFEEABRFIIKBNE, A 2 H X MSCAHE T, % Select
(EFE ©

WRIEHPRIAARTIAN Path: (BR: ) 1, S ERAT B 3510 1
noon, X ATERE F—ANHk. 1% Select. AR R T R UK S 5%
([-a-1 8% [-c-1), HFk#o RPG, 58H WoR)51% Select.

1% Enter, K SCAFAFNIKEN# o

24 F1E



WLRA

1% A

SR,
SR 2.
P& 3.

PR 4.

SR S5.

SR 1.
P&’ 2.

SR 3.

UNBE =]
AT STHIRME

BN

AT LA (A:\ ) BUNEENE (C:\) A (ENR &, IRE.
BRI AR BB R o

DRAFAE LU FRCAS (R [ 4 o ) SCAF TGRS B4 0BT [ AF 1) NF AL

IR B ORAF I SO RETOF AN NFA. i, Bife SO s
o Bk scfR M CSV G254y s %, HT PC.

#A7-E Load ¢ 5., #% File. Load.
R AHIEAN T (ENR £, RE. BRI R AR .

1% Tab —, EFSCHFTER RS2, H RPG R BoR [-c-1 8 [-A-1,
SR G ¥ Select.

SEAR IS A NFA (RS00F, 7 Skl T 5 S S SR 44
F TS RSP

1% Enter B (11301

ER P

AT R A ATE [-¢-1 80 [-A-] Rahas BB dn 44 A
% File. File Manager. Rename (Ffifi4), f7H{ Rename ¢ HIjiH .

B R TH AN (ENR &, WA HUb. B, Bk,
BRI ITHD

fltm, WG E I ar 4 ENR R 3C1F, 4% ENR.

1% Tab — 8, EESCHFTERIIRS 8, 1% Select. ARFE Kz 2%, FH T KLt
FRHEIR [-c-1 8¢ [-A-1, #R)51% Select.

F1E 25



SR’ 4.

SR’ S.

SR 6.

SR 1.
P&’ 2.
P&’ 3.

SR A4.

SE|S.
SR 6.

AR

SR,

UNBE=]

AT R SCHRME
PR I A 44 (030, 52 RPG sl kB sehs, S o

AR

% Tab — it \ Alpha Editor /.. SUAFARRAREIE/N (8) MFAFLL
e

% Enter, CAFCHFa 4, JiE NFA g H W R,

& A

Ub—DhRE AV SO RS LA [-c-1 Al [-A-] 9K3has L5 —fr & .
#kA7EHL Copy 2., 1% File. File Manager. Copy.

KO AR A KB

WEFEEAT B VL SCREY (ENR &L IR P, BRI PR . $i4E
I D
B, WRIEAERS DL—A> State SCfF, 1% State.

1% Tab — 8, EPESCIFFTEM KBNS, R EIR From:Path (M: E12)
. H RPG sifikit ot Bon [-c-1 3¢ [-A-1, EHFIENEE, RGH%
Select.

TEREIE AT B DU ST, 5 vt T T AR e A0 B 7 Sk B 58 H A s SO A o

1% Tab - # % To:Path (£: %) . W, JHEH RPG sl kBt £y
SR SR MR YK B4, ARG 14 Select.

WH I IEI 2 RIIN Path: (B8R ) 1, SEH EIR H 3R I 1)
noon, X ARWEBRE E—ANHk. 2 Select, 58 H! BRI RS A
([-A-1 % [-C-1), ZRJEFIKI% Select.

% Enter 5 1 3C1F

26 F1E



SR 1.

PR’ 2.

SRR 3.
LRA

SR 4.

SR’ S.

UNBE =]
AT STHIRME

B SCA
W DIRE ARV [-C-1 50 [-A-1 IRKBh MR AT
A7 Delete (MHBR) 3¢5, % File. File Manager. Delete.

PR A EMIER RSO (ENR SR, R BuL. IR PR, ik
RS -

RIS A EMBR SO T E RS, k4% Tab —, H RPG sl #ikatse
HER [-c-1 88 [-A-1, 2RJ5T% Select.

WRIEHPRIAARTIAN Path: (B8R ) Ik, R WA T H G HRI0
g Lo X R EE SR LA Hk. 1% Select, SEH WoRFTRE HI9KE)
2% ([-A-1 8% [-C-1), #R)5TH1% Select .

PRI MR W SCrk, Tkl RPG sl kB aehs, S8 H Bos 0
HFKo

% Enter, SCPFRIMNER, AR 7E NFA He.

F1 27
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UNBE=]
SIBRAE

SUSEE g i

i, ENR . BREIZ G P AR IR B L. DU AE
RXLLME T 18 D RE KT MEIA o

®1-5 8 PR A%
Q- A ...
i ZZIE S LN PNI R T S Tab

B T Sk 7 A5 A SR T

Home (JRfi7) ##

BRI % H B2

Clear Table (J5BRFEHG) ZH
et

MEk—17%H

Delete Row (HI[R4T) 3% g

B> 4 H

Add (3D SR

R R 1 LA AT

Row Up (] LE—4T) 3EH

it

B WoRg&m MR —AT Row Down ([a] FE—1T)
B

R n) LB — ATtk Page Up (Ja] [ —T1) M
it

Bk RS — A T Page Down ([i] FE—T1) 3¢
FLgE

AN — M E B N

Zb— AN St HUGE S ) B B

TE PR 28 i #ik Btk RPG

a. BRAILRAR AL — MR T A P AR 45 SR RO 2 S P A £

fHo

28
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& 1-9

UNBET=
f£MA Alpha Editor

¥ Alpha Editor

Alpha Editor j&— AN RIKS 1) SCF AN RS . 18 H SEPB R N 45 208
W TS, IR A A . AR B, 1514 4] Back Space
GEK) #t. 5CHSING, 1% Enter 822 1L,

Alpha Editor fe¥r#:

o [RAFSCEFI A S 4

o 7 ENR i A\ 5 2 S AR AT 5 10 7 B4

o A HT BT External LO  (AMZAYE) SRR T (15 28R T2 $5

%

LO Commands Alpha Editor (A&#&$54 Alpha %7 HHE 2 KT
FrgEIiaT A A, 2 E 1-9.

Alpha Editor %4
| Alpha Editor | Aipha Editor ["Aipha Editor
ABCDEF 6&» abcdefgr O™
HIJKLHMHN» hijklmn NP
OPQRSTW opgrstu +-X/¢> =
VHXY Zr VWXY 2 1/5N{30 D
BAX npTH B#SZ" &
Space Space Space
Hore[ More More
1of3 2of 3 3of 3

F1E 29



UNEE]
{£f Alpha Editor

MR 5177 8 Alpha Editor. 7Eufr, @A77 —A =P f 30445k
— NEW.

S 1. i HIUKLMN £,
S| 2, N,

> 3. i ABCDEFG #.
LB 4. 1%E .

W5, 1% VWXYZ .
HB] 6. 1% W

30 F1E



ATERR WA NFA EATHARE SR A0, JF U 5 K2 M0 m =
RIS -

31



HATEANE
FEARRE

AEAFRE
TR BT NFA 55, A —MEATEOGR NFA 0615500
TAAE S e TR R AR L

. AL (ENR) ¥
o BEIE

o BEEAFEAOTL

o BTN

o GRS R

o FEABORAR M 25451

32 H2E



BEATEAN 2
MANEBEELE (ENR) #iiE

LRA

E 2-1

mAERE (ENR) %5

T LU IEAEAE ] e A I ENR Sl /5 20 SR sOR oRi A . BER
P TAE LRI BEAT I A PP BORE B ] 3BT ORI, s Y T

HEAS BRI v

A PR AR MR, 0 Agilent 346B, ik 5

PRI XL ) ENR Sodfa i 240 1] LLRT A7 e BB K ENR 2 5l

B MR LT KA . 3PP, it Agilent N4OOOA, 24
REME U (SNS) , wJ LA B skeeif K L3 .

wFEILH ENR %

RET AAERGAEAN I P AR 3] ENR 2%, s 78 DUT Bl & ik f
A5 P A9 P AN () T A A 0 I, S mT DU P AS [R] R I AR v
ENT .

ENR &2 7 81 MF ri.

WAERHEFI & A AR A9 ENR 2%, #% Common Table (JLH3) iR
B, 1Pt Common Table(On) (JLHE (F17F)) ; ESHE 2-1.

OB E . 7R, Cal Table (ReHER) LHATH .
277 Common ENR Table On GLH#EMELLRITFF) g

Common Table
0ff On

ENR Table»




K 2-2

LRA

TR E
HWAEMELE (ENR) #iE

BRAE RS HEFI I 2 1HF A E ) ENR %, # Common Table 23, %
Common Table(Off) (LA CGCHD ), WEZE 2-2,

i, Cal Table S v LU . o H TR HE NFA [ 75 )5
ENR #%. Meas Table (Jllf3%) H Tll5i. 7 Common Table(Off) {1,
ENR Table (ENR %) J& Common Table(On) 3+ [{] Meas Table.

275 Common ENR Table Off (GLAiEmMHREH) KHagk

Common Table
0t On

Meas Tabler

Cal Tabler

WA % & Common Table(Off) I ff | SN'S, #75 %1% & Auto Load
ENR(Off) (HBEANMMELL (OCH1) ), JFd H Fill Table From SNS (M
SNS H5%) K. 1S 5 42 10 “F SNS ENR i 8\ &% oifs
M. 7.

MAATEESEERN ENR 25035

L PR el ENR 21078 Ui A ENR % -

o LT A ZORI AR ) ENR (H

o MU A EFR LA 3N ENR 2

o MU EE I A2 3N ENR Hodls

o il GPIB#HAENREH:, 7451524 Programmer's Reference.
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WLRA

WLRA

K 2-3

SR 1.

BEATEAN 2
MANEBEELE (ENR) #iiE

Agilent 1EH B S YE ENR EATEIENLSE B X428 ENR {HIRER A
Agilent B pE Y H A 1 LURHESR 75 78 2UAE I3 — 00 U I AARE R £ 3241

BUF T RN ENR RE04E

WA NFA kAT, B2% k4N ENR #i, ENR &B IR A .
T L% Clear Table  (Ji5FR#) , 7ELLATCZfE K NFA g s7 b fik
Ulo SRS LI 2-3.

5 T2 1R F8) 5 U ENR % :
1% ENR Zf1 ENR Table CGEM:LLE) SEH4E,

WondrP L ENR Table, EHAYEH MUK SR B, TS K
2-3. HREMATEN, THSHL 28 T “ ALHRK 7,

2= ENR %

Use 'File' key to Load or Save a table.

Edit Table»
ENR Table
Frequency ENR Value Serial Number»
Noise Source Serial Number | T
— — — ID»
Noise Source Model ID - - Fill Table
Fram SN

I ENR Table

35



SR 2.

SR 3.

SR’ A4.

SR S5.
P& 6.

SR,

SR 8.
SE]I.
S’ 10.

L RA

HATEARNE
HWAEMELE (ENR) #iE

ERS R

% Serial Number (/75 g, JEHECAEEA Alpha Editor %y A\ s
P

XA Alpha Editor s, 1525 29 i “ {4 Alpha Editor ”
i

D (A% e, ISR Alpha Editor i A Mg s 57 S
1% Edit Table (44 S, ARSI ENR (i,

SIS 2 H LA ot R ) i T

8 IR SEAE AR T NI AR AP A SR PR 2 A

i Tab —> #, #H BB 2 ENR {2, JiA ENR & b R
ENR fi.

2 ENR N, &aTLUMEH] dB. K. C 8§ F s, K. C 8l F £ Hpkdk
e, fEFP RN dB.

1% Tab —> #, WM WoRBE 2R, I ENR E# PR —AM%
.

ERLES =T, HEMAIATERIAAN ENR fH.
st ENR £HiN G, 1% Prev ## 5k ENR 4z 1] ENR 32,
EHPR

—H5E 7 ENR #dlidi N, H File #{/4F ENR #%.
ARAFAFHIVERS, TSI 39 1 “ fjfFf ENR % 7.

ENR &Hdls /& BRI 5 KR 581 (Restore Sys Defaults (k5 5%
GEERMED BRAN o BHFEH M ENR i, i Je =05 A Bk .
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K 2-4

L RA

WLRA

ST’ 1.

HI& 2.

BEATEAN 2
MANEBEELE (ENR) #iiE

WA A ENR £
= Agilent | Edit Table
ENR Value 15.400 dB
] Row Up
ENR Table
Frequency ENR Value Row Down

Noise Source Serial Number %%g%%%%%% m; ggg% SE
[3318A14197 1.00000000 GHz | 15.360 dB Page Up
2.00000000 GHz | 15.120 dB

3.00000000 GHz | | 14.970 dB

Noise Source Model ID 400000000 GHz || 14.91@ dB Page Down
5.00000000 GHz | 14.850 dB

3468 6.00000000 GHz | 14.900 dB e —
7.00000000 GHz | 14.860 dB Add

5.00000P00 GHz | 14.390 dB
9.00000000 GHz | 15.910 dB
10.0000000 GHz | 15.110 dB
11.0000000 GHz | 15.260 dB Delete Row
12.0000000 GHz | 15.400 dB P
13.0000000 GHz | 15.440 dB

Use 'File' key to Load or Save a table.

Clear Table

T HZAE MR /2 ENR R4 H @ A%, B4 NFA 2 Qs N2
KRS 2R A H

it EAEARE L ENR Hdls A8 S5 RN, S AEIX 2 il B 3h I 4k i
fE.

BRMFERESR P EAN ENR 45

U RS AEAL T (R P Y ENR He 2 vh 4 A £ 2 (R s LR i AE R A
AT, AT LKz ENR a8 R 41007 U8 NFA.

Wi ENR SCHAFEAEREE I, B iididd AN NFA R A I Eh 28
H RGNSV, SR 25 1A 7.
% File .

F2F 37



HITERN S

HMIANBEELE (ENR) #iiE
SR’ 3. 1% Load X HLEAF U R4 .
SIB 4. % ENR SZP 5,
SSB 5. % Meas Table Bi, Cal Table > .4,

hoR [-A-1 80 [-C-] WKahas BRSO e SR B S 2 S
.

SIB 6. % Enter .

BAHES: XOEFER—LNE, Erss taHRR, BRIV SE
%, TN, SEERNSTEIR—WIRE, P30, C:xxx.ENR file
loaded (C:xxx.ENR YHE2EHAN)
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ST’ 1.
PR’ 2.
SR 3.
SR A4.

P&, S.

S& 6.
SR,

SR’ 1.
SR 2.
SR’ 3.

LRA

BEATEAN 2
MANEBEELE (ENR) #iiE

#77 ENR %

fEnT LU R 5177k ENR #4847 % NFA 1) P37 s e
J% File .

4 Save SE L4,

i ENR SEHUEE.

% Meas Table &\ Cal Table > i, ok, W &L fEH SNS, A —4
SNS SZ g n] itk A .

I B Alpha Editor, o VR4S T SCE SRR

WA\ ENR 4.

HZE 29 W “ 1/ Alpha Editor” T A7 Al g HERE I VRS o
7L B P B S RAF R [-A-1 IE [-C-1 JKBhes.

f% Enter TRA7 1.

#\ Spot ENR (kgL {1

A8 LA B AR A B, S8mT DU N — 5 [ 2 A0 T2 ) L A rk
ENR fif. ki ENR {E ] DUW T 5 ARV .

#xim A Spot ENR 14
1% ENR %, %X)51% Spot ENR 3% HL4,
1% Spot ENR ¢ ¥4

MmN — A ENR {5, RIS B2 b 8fE. BRAE N
15.20 dB.

D RS AEAE AT C s A v ENR 3G 5 A i, R FLEGEAY S AR RS
ENR fif, %245 ENR 5 .0 pyadi—Nd 4 18 .




SR 1.
PR’ 2.

SR’
P&’ 2.
SR 3.

SR’ 1.
PR’ 2.

FITEANE

HMIANBEELE (ENR) #iiE

#k/5 H Spot ENR #x{

¥% ENR 4, J{1EF ENR Mode(Spot) CHEM: LU (kD) ) SEepdk,

1% Spot i, I+ Spot Mode(ENR) (HUkif, CGEBMEEL) ) SErf,

#\ Spot Tyo1 (BURHERE) H

ERATF BN, T LU — AR IBORE Thop (8 H0KE Thop (0N
TR TR

i\ Spot Tyt 1H:
% ENR #, $XJ51% Spot .

1% Spot Thot X H

BN A Ty {8, FISRAT LIRS & iRl . BRINME R
9892.80 K.

# )5 H Spot Thot #5X

¥ ENR #, Jfi%+% ENR Mode(Spot) =i FL i .

1% Spot KL, JEi%FF Spot Mode(Thot) (IR (HUERE) ) EH.
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5
S 1.
SB2.
S 3.
it

BEATEAN 2
MANEBEELE (ENR) #iiE

5 R BE T P IR

WA SNS 5 NFA [ aee it &R, NFA (BOAE LR SNS
PERMEFE YR . WA SNS A5 NFA M, WA T 55

16 RN 7 R B T

T AR P Y P AN i R, IR EEFE T AL Preference(Normal) (it
i (IE%) ) Preference(SNS) (kI (SNS)) . BRIAKE
Preference(SNS).

AR I P M 7 Y5 A 0T

1% ENR #.

% SNS Setup  (SNS #&'&) SEHUAE,

% Preference U5, K% HUE B IML Preference(SNS) Hiii

Preference(Normal).

¥ SNS ENR HdEH8AILHE.

T LUA I NFA, K ENR % A2 BRIt aRre BiliorJa i B 3l
A SNS iEH:4 NFA (1% g /5 1, % & Auto Load ENR(On)
CAZBAREEEL (TF) ) . XaaH ENR 8dl, Az R, R
AR SR ENR #dli A3) FE R, 4% Auto Load ENR(Off) ( H 5
NEEELE ORI D o

U AR L4k % Auto Load ENR(Off), %A LA /1] Fill Table From SNS (A
SNS 7% s, NSNS L#k ENR %fi. Fill Table From SNS £ 1.
BT ENR Table Sz i R 5. %3¢ P KA 7L SNS RN A REERL
XAV EIE BT R ENR s 1% ENR %.

PILHAINT 20 I NFA i L WiT .




L
SH 1.
SH 2.
S 3.
SH 4.
SH 5.
S 6.

20ty

TR E
HWAEMELE (ENR) #iE

¥ SNS ENR iR BB RSLHER .

2 SNS U 4% #: 71 H. Auto Load ENR(OnN) #% )5 fllf, Common Table(On)
CEHE TP ) #iashwE. Bk, SNS ENR #i#g#id A ILH ENR
*o

& AT LI H Fill Table From SNS % g N SNS 3k ENR %045, X R4
1F Meas Table (JlllE ) B¢ Cal Table (KifiR) 2z [REATIESE, HIHAEN
ENR %451 H ity

1% ENR % .
% SNS Setup SZ i,

% Auto Load ENR (B3R NHEMELL ) SiEise, ¥ H 4%k Auto Load
ENR(Off) ( Hzh# N#BEEEL (MDD ) .

{% Common Table (L&) SZmgE, 1L 4 Common Table(Off) (L]
* COCHD ) .

1% Meas Table 1 Cal Table SZ HL4 .
% Fill Table From SNS Sz U8, S54RI £l k.

PR HRI S 20RE AU NFA S BT
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72 38

P&’ 2.
AR

P& 3.

BEATEAN 2
MANEBEELE (ENR) #iiE

WE Teolq (BRE E

FEAN RIS BE A NI, ST USRS Togg 18-

BRI AE BN 296.50K. Togq s BB Teold(Default)  (Vifi 82
(BRAED ), DML SEZ BRI L

A =R Toorq M . I A8 H [ e s Y A

o - MUNEEH TR AR R EYE, I RVFETE T A Teglq

fl. BRI ERIfRR WEE 43 1t “ LT3 )7 X % User Teold (H /%
BRED H 7.

o SR MOTEER T SNS YR A5 LEKEE, IRt e
BEUE . MRV R WA 44 11 “ K SNS Teold %% Update
Automatically (HzIHEH) 7.

o MriEEH TAEH SNS WE S, IR SR E . R
TR RRE ILEE 45 1T “ % SNS User Teold (SNS H /A
{E ”0

UFEBIHRES User Teoglqg HPAERE)

A User T g fH:

# ENR %,

1% Teold S g .

{FEH SNS i, SNS Tcold (SNS Al JE) ke A2 A SNS Teold(Off)
(SNS A (el ), —IhReA et

% User Tcold =2 i, K% 5UE MW BRIA(E User Teold(Off) (HH AR (5%
1) ) H %k User Teold(On) (JH/AIRE (T ) &

ENR g R 771 Teold S BEILE# % A Teold(User) (VAEE  (H
FU ), DA S A ) e 108 AR




SR’ 4.

L RA

SR 1.
P&’ 2.

HE’ 3.

HATEARNE
HWAEMELE (ENR) #iE

¥4 User Value (f)"'(H) gk,
RN A Toorq 15, AT L E SR B2 1% 50
B K JFRD) « € (RIK) B F (B .

R 0K, EREN 29,650,000K. ERiAE A 296.5K. K {HIH4 5
5 i A °C Fi1 OF el

¥ SNS T 1q 1N Update Automatically (EHZHEH)
ZIhAE A 7 SNS 5 NFA MR A feffi

A E SNS Torq fH:

% ENR .

4 Teold KL,

Wi LE, % SNS Teold i, 4 IL1% 4 SNS Teold(On).

ENR S R 771 Teold S B EILE# % 4 Teold(Auto) (A% (H

21 ), DMERZ S AR )2 il BER
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SE' 1.

HI& 2.
AR

S’ 3.

TR 4.

FITEAN 2
HMIANBIELE (ENR) #iE
% E SNS User T,qq (SNS H/AARE) &
ZIhE A 72 SNS 5 NFA M8 A el .
#E i User Tegg 1H:
% ENR .
% Teold SEHLEE

i/} SNS I, SNS Teold ¢ HLif# 0425 1 4 SNS Teold(Off), th—Ihfg A figk
7)‘(“&0

% User Tcold 32 51588, K20 MERIAE User Tcold(Off) 54
User Tcold(On).

¥ User Tcold From SNS (M) SNS Zi X\ AR ek,
NFA A SNS [#; Tcold {&, J#7F User Value > Fu4 o i 1% 504

ENR 3¢ 5188 T J5 1) Teold i A BLAEH BN Teold(User), LU RZ SEREAE
PRI IER e




it

LRA

SR,
P&’ 2.

HATEARNE
WENEmE

BEMEMR

FEVCE Ay BN R IR 0T, B EE R DIRB. T =R
T PEAE A -

e Sweep (Fffi) — WEMHRIGEIGMEIE (G OAREED %L
SO s R

o List G — WA A H SIS

* Fixed ([f5E) — fER—[UEHRIATHRME . A —AvEd]
JLEE 18 T« HEAT [ E A 7

ek SRS B

FEARIIRBT, PR BT MR A A R (O A
) o ROETTFEBE N N XL AR B S 0. dR
o 401, BOARECY 11.

N8974A #1 N8975A NFA 5238 T —MHUMALHL,  fSeVFAE RF ik
VO FE AR JE [l 2 T e e W SRAGAE A T B ye i 3.0 GHz x4,
HUBOTSRIT A6 HUBOT 50 TSR A 2 H AT R

I3 24 ) fR R I 8.0 GHz JF Rt

RET AAEAL AT IR [R] 4% Full Span (v D, ReliR o [z [0 22 24k NFA 7
TR B, WUREAERHEZ G AT I DR, JF B E SRR MR
Vi FE P REATACHE, AL

ARAE — A ARSI A0 [ 0
% Frequency/Points (Jii% / fi) #.

1% Freq Mode (B E0) Eul, HWOR % N Freq Mode(Sweep) (il
FREA (FHD ) .
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BEATEAN 2
WENEHE

BB 3. WEFRUE, JiELH Start Freq GEIAHIZE) Fl Stop Freq (£ 1147
%) o} Center Freq (.00 ii%) Fll Freq Span (JiZILHE) .

FHEC /e B NS A B A . FH A S s 2 b e
S 4. % More 1 of 2. Points 37 FLig .
SBS. A A S 2. 1% Enter 822 1L

it RA JIT e A R RO, ) A I TR




SR,
P&’ 2.

SR’ 1.
SR 2.

HATEARNE
WENEmE

EFEHE AR

T PR 2O VI ALE A T WU S A B A NI R K R VP ISR e T
i\?ﬁ%ﬁﬁ*%%?ﬂlﬁE@*H?%Bfﬁji?’é%?ﬂ!ﬂiﬁ, A SCVFAREI A 43 A i)
s Ry 401 N4 H

WCBCE NFA, A b i et -

% Frequency/Points. Freq Mode 3¢ 5.5 .

1% Fixed SE L, KRB BN Freq Mode(List) (FAE G ) .
TEAT LU R 4 5 s A

o VT AdRE A

o MHERUTER, KR E DHESUR T B ATE NFA SO0 (%3G H A A4 s
AT R AR R (R SR

o INBAFAE A 1 P9 A7 sl A BN TS

o {EGPIB L#NE T, WRERHLMHZ 71k, ES 5 Programmer's
Reference.

BRUTF BT R R

% Frequency/Points f, J{#% More 1 of 2 S L4 .

J% Freq List 3 L

BRSSP HI— Frequency List (JiEH) £,
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K 2-5

L RA

g S

Freqguency List

Use 'File' key to Load or Save a table.

Frequency

BEATEAN 2
WENEHE

| Freq List

Row Up
Row Down
Page Up
Page Down
Add

Delete Row

Hore’
lof2

BITEAHE NN BRI AR, P NFA 2 AW /N EER Iy

KR A

B 3. % More 1 of 2. Clear Table SZ .4 .

SHBLER, FOREAHRIAZSE, St — D RER ORI AN 2 B AN B oA Ao
. fHXI% Clear Table 2 i . JiFFRRMINBERVIETITIHIMA R, AMFAE

LA R AR IR 45 H

RPN R R

ST A HEC s NS A A PR . s R A SR P 25 e A
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SE]S.

SR’ 6.
SR,

LRA

ST’ 1.
PR’ 2.
P& 3.

HATEARNE
WENEmE

1% Tab —> ##8{ Row Down (Ji] F#—1T) a4,
AR PR — MR R PR,

FHEC T/ INEAS RO LA 28 1 BN — AR
FREOPR S, HEWEREM.

Wik, F File 0K Frequency List (14745 NFA Wi . HxiX
TR, 1ES R H 24 00 ARAF S

W EARAEATR A, WA e R B0E . X T#0 Power On/Preset
CHHIETF A / B0 RO AR, S0 211 1 “ @ CHEIETFR /
PBERA 7.

MAHE R LR

FRT DL AL A R 5 Bl 2 ST AR P

fcE NFA, AR 4 U -

1% Freq List. More 1 of 2 37 HL4j,

T4 Fill 5

RS 1T IE 7 S U DR E K P E S U AN L TR SE SN TE ST
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WLRA

SR’
P&’ 2.

SR 3.

BEATEAN 2
WENEHE

o0 ] 2 A R

I 5 AR AR A E A A B PR AT DI N A o AT PR, 55
PR 2F 18 U1 AT ] g AR I 7

D R e AR B AN ST S T B AR G 1 7 U ENR He, 8% 24
&Mk ENR i, f# ENR B30 ok .

ARV L ] 5 A

% Frequency/Points. Freq Mode 3% ¥4 .

% Fixed 24, KRB B0 Freq Mode(Fixed) OB ([fl5E) ) o
Fixed Freq 58 LA v AT H .

i Fixed Freq g, A FH 20 BRI AL 28 E SR LB AR AE




AR
SR,
SR 2.
AR

HATEARNE
WEH TG

BB A1

AP P AN AR T KR
FRAI IR A — B RIS BRMARRE), AT (5

BN Y B
WA SE B, M RE EIE M H , DR R i 2=

PIERFIEE R, I ERHERG, OGRS PRI R 8. (A2,
WA 05 e PS5 T PRI ) 1A 1o

DAL, 7 0 A/ k2= 2 ) A AU e %

7£ N89T2A M5 |, ~PIYME RSP TCIE M o IR mi s 1

PR T E

RN 550 4 MHz. A 0 9641 -

1% Averaging/Bandwidth .

M HTHE 5 2 /E Bandwidth S L

iz Bandwidth S U8, AT TG S0 R o ok 8 15 A B4 H AR e

7 N89T2A M5 b, i W A TICIAAE ] . 4 SE [ € 4 4 MHz,
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BT

SR’ 1.
SR 2.

BEATEAN 2
WEEEMTY

WETY
WOPPES 2l B0, IF SR EHER O LG L, ARk A% Il R
o KPP 999, BN 1, AEATH T2 B 1.

AiE L E Averaging(On) CCFY (FTFF) ) AP . R, ®E
Averaging(Off) ¥y (i) ) .

WEFHEHE

ARBCE A B P

% Averaging/Bandwidth %, %X 5% Averages > L5 .
MBI AR B A B ] Enter S48 1% {H .

o e

IR LA Average Mode(Point)  (CFEREEL (A0 ) 8-
Average Mode(Sweep) P (3H6H) ) .

X PR P SRR 22 A T

o {£Point (0 FXrh, BB HR PR T — AN S 2 BTEsE—AN 500
FIie FIE A H AT & . — RGN E . Wi Sweep(Cont) (]
o (ARE) ) gIEFE, WEEF I

o {£ Sweep (F#f) Bz, e I REAS SO B — P I AT I &
PR A 2 A 45 R RARA RURS I E R, AR AR RO
HEPYEE H BT E . CPRMETH R R i s, )
Sweep(Sing) (33 (F—) ) B ghikss, MELR, wmE
Sweep(Cont) (FIf (4k4l) ) #odkde, WEIRLL, MR M TEECE
o

RPN B 2 DRI R S0 SR — IR A 8 B AT A B R

PP

FIP Y T K B S AR ], BRR ER 22 YR A RESRA T IR 1121 34)

fHo B2, STETAMERBPRAYIMG LR .




EEMNE

B ITROE

HATEANE
BAES Y

RHEDHTAX

RAME N AR NFA BRI AR SHERSE, 7B BIATRE.
KeEfEd DUT  CIREEED APIRGL Il NFA f A oA 8 R
PR R o ek RS, 78 DUT gz IR0 T 448 1E R H] T & .

WARATRHE, R A ENRAE, JF & TRV D A
B, WL PR,

IR IEAERHE NFA JG SR Ja i, 2k NFA PR SO R 1E

WA B RS R EEAEREAT I — RO R 2 iSRRG v, DU AR 3] e vt
AR ITR 2P S

I R A HE A REA T8 1 I e 2 A J B R TR HETC 2o
BRAREEHEAT, BRI T B PIR J5 z—
o FEDT it DU ARG R IAT RS HE
o PUTREBIENE
o CREIIE AR S SO BT R B (R R

T K ReAE T AHE R S PR BEAT B IR 2l AR T I A AR sl vy
>

BB R AIETEN, BT e

o X NFA 847 i3

» Tt NFA

o REFEANELH 2 RTRZEE 0D R B

o FERSERI B E TF BiR

o AR

o HXIEA

o BN E—UAELUK I IL T AR KA AR 1L

o TCVEFHE I — N RE R N SR A v I R A S KT
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BEATEAN 2
BAESHTY

o UM BITEALSE RIS, WA “xx” FRiZROL. WS 82 T “ frR
TREER

RIESER B LR S, o NFA SR A HRSR, s
BAEE TRIE B2 NFA WA AEAEATAR AR TR 0N, L T BosdsAa R A corr

(BIE) el Uncorr CRIBIED o 8] 2-6 SR TiZdR7shric.

& 2-6 Corrected/Uncorrected (BIE / RBIE) Er-krid

Corrected/Uncorrected ({&1E /" RIEIE) $§RFFRIC

RIERIE 24 NFA AR AT AR Ay i 4G = 25 R, T Bongsta
FA Corr Il & 4 0 (411 Corr.

fit Agilent 8970B i NFA 51 RF yu %5 #id Agilent 8970B, 5 Agilent 8970B
RPERA ANE], AT XTI AR 15dB ENR M b, ToatiAT S
j(o




SBR 1.
SR 2.
S& 3.

17

& 2-7

17

HATEANE
BAES Y

RPAT I HE

B O NFA N IERH ENR %, U0 NFA fii At ENR
fif.

PENIN 22 33 L« A EEE (ENR) it 7.

PoEEAEM TN ENNESE PEREH . S A58, PR
H

Rl i B NFA S NE# .

W EATH N89T4A 5 N8ITHA M5 AT I —20 8K, 75N F 1E M 1) e A 3
FERG % 3.5 mm MEFEART, FEAGIM NG o RIERAG A ICIEREAS 1 U6 A IE 1
HAEHITR, i Performance Verification and
Calibration Guide.

FIE® B EIERTT NFA 8&#

00caoo

000000 9

O||cooo

T80T BE TR AT A AR G C A AR T AR ok e A s S NFA SN %
o SAFFMEREA N Y AAREN b . W RS I g, R
I Loss Compensation (HiAEFME) , DU RME I B4 Be s i 18
AEATHIFE. A3 IOX 7 THARRE, 5S04 98 T “ A HIBIURERME 7o
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SR A4.

SR S5.

WLRA

BEATEAN 2
BAES X

WK, ARG E, T4 Corr ZEAI Input Cal - (it A\
WEUME) e, B B N O N T

B IRV, 53 58 1 “ ikt RF iy N Ewiiul 7.

WX Calibrate 4, HIUAILHE.

B IRZ B, SR, BRI IR, P IRILETh e A T B
118 =AM R Calibrate £, HEERBUELHE .

NFA $ATEHE, FEAERATRHER 8o H 43 ek 2.

KUESE NG, AHEFE /b RC M) Uncorr CRIBIE) W R MCh 1)
Corr (BIE) ©rr. MbAh, DA T LIMER] Corrected S it . iX i &t
ITBIEECARE ENE, J7i02 7 BILE Corrected(On) (IE1E (FTJ7F) ) Al
Corrected(Off) (IBIE (M) ) Z IRk,

PATEHERS,  NFA PR 5 R O 200 B 45 R R AT A R
A BAERAEL R R SR, S EEFX AR R 2 —, DMERRIX




Kl 2-8

SR’ 1.
SR 2.
SR’ 3.

HITERNE
BAES Y

% RF WA it H

7 10 MHz % 3.0 GHz () RF SieREHE )RR, NFA f—A Rk OdB
% 20dB PIERN AN RGEE . FEERUE D, RHEFREAT b ki, P
HAH B AN FEIRAS VO AL . IR PRI IR VO K, T(ﬁi‘ﬂiﬁﬁﬁt
Z, Iﬁﬁkﬁﬁ‘/&ﬁﬂﬁ?%%‘éﬁ‘]Hﬂ'ﬂﬂﬁ

FED R I R B N, W R A AN k. R ORAnE DUT #8825
WJEHJJ?JW\/EI%H‘MT#{E, TR R A ARND, AR5 A 3G E’Jﬁ(ﬂiﬁﬁ
WRHE . R EAE S e 2o, wlFE 2-8 FE 2-9 i woR i —Ff. Wil
NFA 462 Rz Ans, W8 msb s, JHEH Loss
Compensation & IEM—5 k. AT HIL— IR, 635
55 98 T “ A FHIRERME 7S

WERAEACHE R R b B R TR, U SRR e . AIERAS S BE I A 1R A U
L S T, R 7S

Bk $ RF By N0
1% Corr ({BIE) .
1% Input Cal ZE g, EREA EAEH R TRIEH .

FH Min RF Atten (I /D500 F1l Max RF Atten (g KU ek Sg
VRISV, AT PR R A B A A A

N8972A 71 N8973A R ABIE IR

Points 11

Att —— dB

TR TRHRIC BYIRRIRIE
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K 2-9

#2-1

ST’ 1.
SR’ 2.
SR 3.

BEATEAN 2
BAESHTY

N8974A #1 N89T5A ZHiaa~tric

Points ll

Att ——/—— dB

TR RHRIC

F3 RF 8 RHRICFIA MK IR R ARIE

EPERB N TG

N8974A H1 N8ITH5A M5 hfy — A i yulH . 7F 3.0 GHz &

26.5 GHz (M u B pEL e, NFAf5—A4 0dB f&HERER A3
WEE . 5 RF ZEhkas AR, S s pdas ok A s B . RcE T geid
FEWRBHL RS . FERZHUNEUL R, 0dB HIiRAiE. A A R 2 1)
WIANIIEIR, ESHE 2-1.

IR RIS
&34 BRI IEAL DUT #$4E
0dB -30dBm LA SETE 416 NF
DUT<25dB 13
15dB -20dBm fEAl JEVE 415 NF Al
DUT<35dB #3
30dB -10dBm FEAHF BT 41 & NF Al
DUT<45dB #3
PG 6 Rl I8 i A\ k-

1% corr (Corrected) 4.
1% Input Cal 2 U, EREIE A 54 I ks [

HI Min UW Atten  Ci/NEO%ZERD Fl Max UW Atten (e KO ZED 3250
SEBCE REIR AL, AT S bR A S A A




SE' 1.
PR’ 2.
P& 3.
SR 4.
SE|S.

1 AA

HITEARN E
BAES Y
B ERHE G B AR

o ey JoVE B EhHES . I, FERET R, LT3 T A
T AT, AR R R E NFA . #se & o A T

1% Sweep ## .

1% Manual Meas. More 1 of 2 S HL4H

i Fixed UW Att (8 i o) S fbi, PRy AL FH M e i
% More 2 of 2 S L,

1% RFIUW Atten 0l / Tl 800 SERLEE, 3 H] RF/UW Atten(Fixed) (]
B/ sk CFEED D .

WA E B E RE BNTENRL, VSV o o i N 20~ R il B 1
RF fy NFE o SFEFIRAIL, R 2 A 8 s B R 3 v 2c
Fixed RF Att ([E @ S0 .
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LRA

BEATEAN 2
BETRNEER

EANESR

NFA i —f 17 BOKR SRR — A SR, Ao VPROM I R
(B BT SR HR A/

T A T (A

oG A (O

o LRI AR R R I S0
o G (SR LA R

o AL, e R R R

o IR

o SRBURIUE. TP

o KA DLHUIER RA7 A  2

o HTTTSRH

o TR

W5 NFA BRI 47 Remote Grfe) fsr2s i, #5iii
System (LOCAL) (R4 (AL ) BEEHZ R,

et AT YN

45T DU BA T AR R A o ol B 5 L
NCHZEEN

E S SN

o MK

BRI R e X R R e A PR BRI 5 o . IR R, R




HATEARNE
ETRNEBER

AT LR AT A # ik BB S E BRI A4 R S8
BEE TRk
S 1. % Format (F%30) 4.

BB 2. % Format £ 55, %+% Graph (EIJE) . Table (£#%) o Meter C(l5E
0O g, EREAEMHNE R, HZHE 2-10.

& 2-10 H B
I Format
Graph
Table
Meter
ity L)
I A E I BT H 2R (B HESS H Wos e e A e 20 BRAE S I B
15 AR FERAE BN 2 Ak 2 i, B I 2 2 500bs 8 A LA — N ek e .

62 g2



E 2-11

EXHAER

L AR

wRER

L RA

BEATEAN 2
BETRNEER

X B R

| Frequency
| s

DUT Amplitier wncony OFf

Sweep

Start Freq
1.00000088 GHz

Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

-1.664

Freq Span
1.00000088 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

IR, Hehr T n T VY . i v LS
P B

(ER AR DR, MR 24

R0 DU AN W s AR s 2 th RS BRS FR g . I D e DX Ay A 7tk
AATHEE . % Full Screen (£25) BRI AHF. FHXIZ Full Screen £ iR 7]
Hr—ANEoR e BT AR I 20, RN EERRSN: Zoom  (HETD
Next Window ( F—/% ). Save Trace ({ffF#hiZF) . Help (FEH) .
Preset (Ti#) . Print (4TE1) . Power Standby (HJFINE) Al
Viewing Angle (¥{ff1) #.

Full Screen 43 1] DL =24 5 e U o

F2F 63



LRA
ST’ 1.
PR’ 2.
SR 3.
SR 4.
WLRA

HATEARNE
ETRNEBER

P BRK S RRE
SRS D P LA S R S — o 28

T LAAE P B TR R [R) — g R i AR XA, S ARIRESAT
BR—iHE Each result type selected must be differ from all
others CREFIEREM 45 RIS D200 P A7 AR TARD &

= e Su R T T NI RN V) R VRS A

o MpFiREL (dB st

o i3S (dBmkkth)

o Y &% (dB kb

o Teffective () OFK—K; #&K—C; £K—F)
e Phot (#zh%) (dB =ikt

e Pcold (A¥i%) (dB si&ft)

ARiE BRI RS R
I ) e B

DU I 2 T HE S Y s
% Result (4550) #, P WoR gl KA,

e NS 53— -0 e R LI R
J5 Result 4, TEFEIE 75 28 7 ) 46 S |

5% Scale (b)) BRI, DU IR 45 R A0 FR REE B 2 B
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K 2-12

1% BA

BEATEAN 2

BERMEER
B AL
gL

(AR SUBE Y, (T B T SR8 T i [Bed) i, e 2-12 7
R LIRS SR B RV KA B LU

B
_|
DUT Amplifier Downcony OFF Autoscale

Units
dB Linear

Upper Limit
40,008

Lower Limit
-10.668

Ref Level
15.000

Display Ref
ff On

Scale/Div
5.0608

W TR R, b N A,




HITERNE
ETRNEBER

FER—ERHAEHA B’

T DS W i BN A S O A R, BRARE A
Combined(Off) (& KM ), EBIIERAE.

AR HEWNEIERE, Y bR RBREIAR TR ENR, WAEERNAESAaNY
b R4 R Bl
AEG A EE:
HFB 1. % Format (kL) B, JFEZ5C CiL#E Format(Graph) (iafk (&
JE) ) .
I 2. 44 Combined(On) (414 (TJT) ) sEffg, 44 FE—EIEHIPA M0 %
NIEE .
& 2-13 FLPEER—ER A A RE BIR
- Agilent | Format
DUT Amplifier wncony Off FO[;':I;EE,
Combined
0ff Oni
Trace,
Data
Data ->
Memory
Graticule
0ff On
Annotation
0ff Oni
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BEATEAN 2
BETRNEER

B R SR UL A AR 2R L

MR SE R — IR SEEE R JG,  Data -> Memory (B3 -> T7fifias ) 32 i
B o

BB RAE BAT5 2%, % Data -> Memory 3515 . % Data -> Memory 3¢5
5, Trace (HLIE) SEAEEMINGS.

WA AARAE K BNIZE, MR F% Trace £ Memory S i . A7l S U AE s e
L.

WAL DRAF PGB AT T L B2, iKYk 4% Trace 711 Data & Memory (X
MUk ) S .

RIAKE AL M AT B 4028, K IH% Trace Fll Data SERLEE. IE M ERIA IR E .

1 BR 1% Autoscale ( HZIEr ) NS TP A2 P B hr




HITERNE
ETRNEBER

TR 5 4%

¥ oh Graticule(On) (J5#% (F17F) ) I, Bikep WoRits. BN & E .
BN Graticule(Off) (7 4% (Rl D B, BRSO E R .

FRFT FF B P T H
S 1. % Format .
B 2. 1% Graticule (J5H) S, M4 ZSKiEFE Graticule(Off) Ik Graticule(On).

2-14 Tk 5% PR A S 2 IR

| Format

DUT Amplifier

Graph

Combined
On

—
=
—+

Trace,
Data

Data ->
Memory

Graticule
On

—
=
—+

Annotation
0ff Oni
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SR’
SR’ 2.
K 2-15
LRA

BEATEAN 2
BETRNEER

TIFER M Bt

%4 Annotation(On) (fltvE (FTIF) ) I, BEFErR WoRflbid . BRI 3%
. ¥4 Annotation(Off) (Httv:: (SCH1) ) IF, R AR SRk,

FRFT FF G AL -
1% Format % .
% Annotation (Hlty1) SR, R ZEKiE+E Annotation(Off) B\

Annotation(On).

i < P e G S 7 P 7

| Format
Graph

Combined

0ff On
Trace,

Data

Data ->
Memory

Graticule

0ff On
Annotation

ft On

1 $¢ Annotation(Off) J H [R5 4 Test(On) (X CHTFF) O B, [
Tl 2 MR s A0 Bl 2
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HITERNE
ETRNEBER

WERR
(ST LI BLH B D B 45 A OB B AR, 44 Scale (50 L.

1% AR MESILHETE, % Result (4550 i, MEFEH —ANNIESEO A, 1%
Scale % &F &S Hhr o

& 2-16 FEETE B i SRR 7R 4R 4

DUT Amplifier 5 Off Autoscale

10.88 Units
dB Linear

Upper Limit
16,008

Lower Limit
[.668

Ref Level
4,000

Display Ref
ff On

Scale/Div
1.6608

ST DA E I 5 2 80hs R 4% Autoscale (BRI S, 4%
Autoscale, i%£# Upper Limit ( ['fi{) . Lower Limit ( F[R) F1 Scale/Div
B/ ZIED I

L] WU PR Ze 4 % 0 Display(On) (lbzx (FT7F) ), JF HIX T Autoscale 5
P OB S, BRAIZE AT AN 2 A s 28 P B
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AR

AR
SR 1.
SR 2.
P& 3.
SR’ A4.
SR’ S.
SR 6.

AR

BEATEAN 2
BETRNEER

WA A PO HBON o, JF HA% T Autoscale B A R, frfitids
BULTTREA S PR s ds P L.

BWERERERR

LUR R IRIE ] T HoAh g SRR

AICATIE 75 R U8 A I B O v B g R f e S 8, A R AR .
% Result # .

% Noise Figure (WS F5%0) = i,

% Scale .

1% Units (IR SEHLERE, JRIERETELL 2 Units(dB) (L (dB) ) akiZk
P4 % Units(Linear) (EEf7 (ZtE) ) .

i Upper Limit ( Bf) Sk, H RPG sR¥cr s i IR . H s
NEUE, WAL dB, H Enter B2 EXUE . WA RN, H BRI
TRESREC A L A

¥ Lower Limit ( FIR) s, H RPG a7 8t o PR . T
NG, A2 dB, F Enter B4R FHUE . WS PALAT SEEe e, HIBoRAY
TR IR R B 2 A

PR RBRAAR R/ ZIBE A A4, PRI SO — AN, AT RES S
oAt (e
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SR,

AR

AR

72 38

SR’ 2.

HATEARNE
ETRNEBER

1% Scale/Div 5t . JH RPG sl 8 S ohs R/ 20 K i i A\ KL
H, WRHfit dB, i Enter 824 EAUE . WERAALELNE, MWK TRE
FHK L R

BESHHET

22 WL S (A e et PR A4 R FRAE b RO B A AR RO B R Y

ZH i U 1L Display Ref(On) (\2/nZ2% (3171 ) #a N4 ReH 2.

WA BRI BB B2 %5 1, $% Display Ref (/R Z&7%) SRHL
B, TRIAWE N Display Ref(Off) (W/n5% (SCH]) ) . W 'H Display
Ref(On), {1 IFZHH .

1% Ref Level (ZF WP ik, 1 RPG s 2t F S . M
TSI NEUE, T Enter S22 - EUH.
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LRA
SE] 1.
S’ 2.
&l 2-17
P& 3.

BEATEAN 2
BETRNEER

fEAARIE

HAFEEIEA% X A fe A AR iC Dh fE .

Fric D REIE I AR B (1 — A s ETBCE AN AR AR T AR A R 4
Ko BRI & R R i ) 45 R

R TT LUR AR BCEAE LU ORAF B (APAdias) BRI a7 (Bl $huk EIf
22, DMEERE R .

NFA V44N rid: Marker(1) (Brid (1)) . Marker(2) (hrid (2) ).
Marker(3) (hrict (3) ) FlMarker(d) (ki (4)) . dricy FEEZEA |
B A

AR PAE N IER . Z e i brad e o LA R /e I Dl g
X R . e RbRICgE R B R LB E e, ST Rl gl ok
Ja s MBS AT T 2o,

EHRRIL

AL AR :

1% Marker % .

% Marker SR, EREAH CARIL -

BUHFRICAE Marker 2 LRI N RIZbRid. 52K 2-17,

T RIL B AR IS
Marker
1 2 3 4

Y State CIRZA) SEHEE, Jf4% Normal C(IFH) SEHHE, S8 SoRZbRC.




HITERNE
ETRNEBER

& 2-18 IEFRESIRT

| Marker
Marker Frequency 1.505000000 GH

Mkrl 1.5851 GH=z 1 2 ngkez

State,
Mormal

Band Pair|

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off

WAEAT —XHE SR CBCEAA AL L. ¥5) RPG, sl B a2
I HPIE i b, B FIECT S AR R o bric S A & 24 B
LT . BRI T RE R

XA BRORHIBLHIFRIC, 4% State SELEE, Jf4% Off (KM K. IXAFFIL 2R ER
BT 107 B AR S S RO Zh BE X AR A o

ARE I AKRIC AL bR G B E A Marker(1). AKFEECERAFRIC, 1% Marker S U8R, IXFE
22K AR IC AN Marker(1) 7 %5 Marker(2). R ZE 5, B ARIC A
Marker(2) ¥ 2> Marker(3). 5 i%FE7, H 2 IR[M| Marker(1).
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BEATEAN 2
BETRNEER

K 2-19 M4 EE#AREIR D

o Gl | Marker
Marker Frequency 1.8801082040 GHz

Marker
1 2 3 4

State,
Mormal

Band Pair|

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off

BREFARERRIE  SOCHITERFRIE, % Markers All Off  (FRid 2EB0CH) o XFES LT A 1)
FRic M ARSI HETE o

EhricRE

#hiE A EMERIC State(Delta) CIRZ: (ZE{E) O SBEAEDUT bRIC iF 2 ji 7 BRCE NS Hbx
e ZMEFRC R MBS S H Rl M Z AR LA B 2. 10T
RPG, H5ZE(Ebmic s EAE A IR L R e BRSO E R R A
Ao ZEAEPRC S I LK 107 B2 25 bR ef AR i 45 R 2 A AT Ak
BRI A DI REX P s . TS & 2-20.




K 2-20
SR’ 1.
PR’ 2.
P&’ 3.
#hfE R RIS

HITERNE
ETRNEBER

JB R ZEARERTS

| Marker
Marker Frequency 1.859568965 GHz

Marker
& Mir2 497.5 MHz 8.758 dB 3 11 2 3 4

State,
Delta

Band Pair|

ef Mormal

Trace
ata Memory

Searchr

Markers
All Off

BBE ZEE AL -
1% Marker % .
% Marker =g, EPRAH AR

1% State S i, JF1% Delta S iR Wonizbrid. M RPG R Z={ibric
2P M. SRz,

State(Band Pair) CIKZ IPXD) ) SEPEEECE I/ Mrid, SRVFRIEREBE ) IE
WhRCH S E i, 1%IhAES State(Delta) AH11bL, R [F] 2 Ab S 4 ] LU FAS 5)
EE—Arid. SEPRCIAERFEAZ, 5 Band Pair(Normal) (i}
GEHD ) eyl v, HIHAd RO B g brid. 7idid# Band
Pair(Ref) (Ti7%) (Z%)) SN S RcAE B bR A R 75720 BA
e U FRIC PRI B 25 2R EAE BB BT . SRR A I H
hEEX h R, HSHE 2-21.
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E 2-21

SR’
P&’ 2.
SR 3.

SR A4.

SR’ S.

BEATEAN 2

ERNELR
B WA SE R C X
- Agient | Marker
Reference Marker Frequency 1.136326523 GHz
Marker
1 2 3 4
A.461 dB | ————
State,
Band Pair
Band Pair
Ref Mormal
Trace
Data Memory
Searchy
Markers
All Off
BRI T bR s
% Marker % .

1% Marker IR, EFAH AR .

I

Band Pair Giix}) 3Z#94 (K] Band Pair(Ref) £l Band Pair(Normal) 3 FU 5 A
R 2R .

M RPG I A RC NS H R H . b BoR S 2 FIEF bRic A7 & 2 0] i 2
H.

% Band Pair = LK Band Pair(Normal) ¥ 4 [l 52 bric, RSB shS % b
it FFX% Band Pair 324K Band Pair(Ref) 300 [l & bric, L ERENIE
whRd

F2F 77



K 2-22

HITERNE
ETRNEBER

JB R IEH AT B Xt

- Agilent

Marker Frequency 1.748826523 GHz

H.461 dB

| Marker

Marker
1 2 3 4

State,
Band Pair

Band Pair

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off

78
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P& 1.
PR’ 2.

AR

BEATEAN 2
BETRNEER

PRiCTFAE AR

Frac v ABBCEAE A AR UL L iS5 67 50« o 4 i Kodhs HZ A A
FEREERANLE 7, PRI A A UL I BT . ERINBLE A Trace(Data) (i
(ZE) ), bR poiCE DU 0 L.

BOKG brac OB AE A A7 as U L
Ja H Trace(Memory) (HLiF (f7fifids) ) e
Bt 75 B8 FH (K AR % 0 Normal. Delta B¢ Band Pair.

PRiC BB A A P b i % U FL P ) Trace(Data&Memory) (B
CHEIRATAE2S) W B, 7 Trace(Data) (FhiZk CHED O FI
Trace(Memory) - [A]5% # 7] {E 40308 2 [A] 3 dbric o

AR FRCHEBEA Trace(Memory) Jf ELA# S HUL AR W, ARid LI EA 2 B

7No




AR
RIRRgESR
K 2-23

HITERNE
ETRNEBER

FtricEI

Search (83 LML T2EM, & T30 AV — NI bR I i &
IS B N S L, (EAK SR 4T Normal (E%) mk Delta (1)
K&, &1 Band Pair IRZSES, &07 LU S50 ) Minimum Peak
(BRI 4 Maximum Peak (EmldAE) o 80T DL 2ok H ke
NFFEAWER, ST 3% Find (A48 SR,

IR FRREAY S, bl A M, Fonk M RbRd. i v
BAPFRIE, A7 AERERE. WURE TSI, HEEAOR DR B A2 I B
T

T ERAR RS A Normal 5 Delta, A R AT ARl s 5«

EREREIE R R AR S

| Search

Mkrl 1.8714 GH=z 3.443 dB ] 1 9 ngkez

Search Type,
Maw

Continuous
tf On

Find

N = B
E S TR

I 1. 1% Search 2 HL4,

80 F2E



BEATEAN 2
BETRNEER

S| 2. 1% Search Type (48T 25M) g, 1EFF Search Type(Max) (48T
() ) o

$B] 3. 1% Find SEHEE.
B e BILAE W 3R 7 0D ) e e 2

WIS IE A HEF AW L A R P g 0, 1EFF Continuous(On)  (F74k
FTFF D .

23 Peak to Peak &7 ZE ¥l IRAEIE N Band Pair, 74 #8347 Peak to Peak # 5.
(EZEIE) &

2-24 #r#: 3| Peak to Peak

= Agilent | Search
Reference Marker Frequency 1.362068965 GHz

Marker
1.898 dB —4.047 o AR R

Search Type,
Pk—Pk

Continuous
tf On

Find

B 1. J% Search SZHL4k

$B] 2. 1% Search Type Sk, E+¢ Pk-Pk.

HB 3. 1% Find S,
rAc BUAE A 0B R B ) d e AR G R
USRI A B RS A RN b I d i R AR AT, 1% 4¥ Continuous(On).
FTE R PN 1R TR ZE 4
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HATEANE
EREHER

TG R

FE TR s B A R BT R 46 SR, B e T 22 1 2 i DU IR, F
IR NSRRI o I AMERME A E SRS 3 b A AR 7] R Bk i 7
INATYIV/ IV

AL I A AE LA JC R ROR DL o IR EOIRDUARGE ™ B Y, A s dx

P PR
HEH 7 g«
#£2-2 ToR s RARGUHES T
HeF i 7 ToR G RRG =P N
1 AT E < B I % “__»
2 ToVEHTIE IE T “xx”
3 MR S = o “.r

A 2 A AR TE SRR /R —FR O~ 4 2k
o EZIN B AT R N AR A HE
o HAVEH CRHE, EIZ R AR TR
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BEATEAN 2
EREHER

BHAMETEE & RF fiA

NFA w DRI 2] REF 53 A DD 5065 T 24 i A S pded im SRR oL . X4
73380 RF f N ) o8 T-VElH .

X LEAR B bR c B Y BERAS / e A 4% B 5% k510 4 RFO BX RFU, 433K/~
H K FE Y RF fiA.

FE G A r] B BRI S DL EAE: 24 RF oA, RIMEA o oK
ANTER, oK BB B D AR AR T, AR B B AR TR RN
Bro TAE A E PR PIX — b o

R E AT RE ILI R DL A5 Biltn, =4 RF S A8k C2e i e a2t —
B b, BN A 2 R EUL AP B 4. T et RF S TE
i 1 20V L e P AN P 1 5 S LA O — s

B A TYE B 41 IF B

NFA figig I 2 1) IF Sy A B Bk i 2400124100 TF S\ e e slid
ARG X253 51 2 IF S A B Bt i s +-yu

IXELIRBUAERRIC T2 s / M H 55480 TR0 81 TFU, 20003k
B TE I TF FA .

O AT BRI IS DU ELHE . > RF 8] 76—/ TN s P i
fgE b, JF LR IF Brscrim ATl s, RUEEH &K IF 2k, IF
B s EA AR TR LI . A S v Y RF S
s SeVF RF S AN TEsmlas A 300 B v il ook — i




#2-3

HATEANE
B AR 25 B 2451

FA BRI E L]

M P A 2 A 1 i DU'T it 2 2 f6) P AN ) B A 7 PR AT
M PR K EURCYHE N AR PR A P AR PRSI R A R e
LIV

AN & DUT 8o Wi AT S AME 75 45 Feil S Ao Fh AR A . A H]
(1 DUT J&— SR = goREs MR EE >y 20 MHz % 3.0 GHz. %
IO WA 2-3.

5 DUT #i#%
pJE S(EAe LIEh F B/l SRR F A
20 MHz % 19 dB 14 dB 3.8dB
3 GHz

LRA

ZAOBPRG A AR %4 1.0 GHz % 2.0 GHz. W& H &8 TR
SE IS 45 R U AT SR T

B I A D R UL, A A B oK

PR EEAN &, %5 NFA Meas Mode (550 LB A BRINEE
S PREHEIE N A S L7 o

e DUT: Amplifier (JHK#8)
e System Downconverter (RZ5 NAIAE) . Off (M)
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SR 1.

AR

PR’ 2.

SRR 3.

SE’A4.

PEATEAN 2
EATA 25 B 245

REHERR P TR BTN
2 R NFA, DMESAE A 20 i IE AL
1 On FTIFACH, A LR R 56 K

AORTF T PRGBS e NFA ik b—/ N, FReh
Alignment(On) (K (FT7F) ) o« ERIAK & A Alignment(On).

% System (%%:) . Power On/Preset (R4 JT / 1) . Preset
(Factory) (T (L) ) ), JHZEE(H Preset (i) ##, {f NFA x| T

%2 ENR GEM:EL) . ENR Mode(Table) CGEEM:ELKEIE (4% ). Common
Table(On) (GLHE (3TJF) ). ENRTable GEBE:LLE), A& ENR
{EO

ABIHAEH T —/> 346B S, %M A EA 5] Frequency/ENR
O /Wbl fexs, fmoh 2 GHz (fE2:kr 1.0 GHz 2 2.0 GHz
BAETE D

% 2-4 kg E YR ENR/Frequency &

Frequency | ENR

() GERM:EE)

GHz dB

.01 15.29

.10 15.39

1.0 15.17

2.0 15.10

% Frequency/Points (B3 / i) B, W& N EMERESHL.
* FreqMode (i) — Sweep( i)
e StartFreq (JHzh4i%) — 1.0 GHz

$2F 85



BEATE AN E
FATRUK 25 T 2 24
e StopFreq (Z1Mi%) — 2.0 GHz
* Points (si) — 15
B 5. 1% Averaging/Bandwidth (135 / 77 58) B, W B A HEAE I v RT3
AL T 51 B A«
e Averaging C°F¥y) —On ($T7P)
e Averages (FHfH) —5
e Average Mode CFHFi) — Point ()
e Bandwidth Cii%) — 4 MHz
SB 6. 1% Corr. Input Cal, ARHEEK ¥ E He /NI RKHTA BT, .

A1 43 514E F Min RF Atten(0 dB)  (f/NMifAizEk (0 dB) F1 Min RF
Atten(20 dB) (i KHS Ak (20 dB) ARG/ N R KB N ZE 08 o

SBRT. WFEE 2-25 Pron, 1 BNC HUZ0R B S A%k 45 28V OUTPUT (28 {k
D S, IR ERE S INPUT 50 Gl 50 BKER) i .

AR ] N89T4A F1 N8ITHA M-Fitf, /MUK AE R 3.5mm 4 fe 5 F ik
HIEWIREA . AR RN T I I AR, 15211 Performance
Verification and Calibration Guide.

& 2-25 FiC % IE % R AR HE R B
ID oooooo|)
3 588588
Qo
0o ||
- . gggogo
R e ormme g 8550
e \l'\ ® ¢ O
J
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BITEARNZ
EATA 25 B 245

B 8. 14K Calibrate i, KHE NFA.
— HECE 7RG . R, sies o — AR E 2-26 (1)
K.
REHETE G, W ARIE AR MR, 150 Corrected(On) (fXIE ($T7F) ) [
BN R AR AR 0 dB. X Ui NFA CZ0Ks b /o045 Ml & RGP
Bro HHTHIAAMER, KILSAER L FEL).

& 2-26 RHESE RS I S8 2L B T
DUT Amplifier Jowncony Off Freq g‘\?e%[ef
9,808 Start Freq

1.80880880 GHz

MEIG
Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

-1.664

Freq Span
an 100068808 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

¥% Format %, ¥ Format 2558 4 Table. < B/nZL T 2-27 145 .
g 75 Fi8 KR4 25 O TIUYIE N O dB. el 48 F R i A% AU R A X sl 1L
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E 2-27

HITERNE
B AR 25 B 2451

Rt SRR AR

| Frequency

DUT Amplifier

NoiseFig dB | Gain dB

Sweep

)
T
@®

el

Start Freq

Stop Freq

Center Freq

Freq Span

Fixed Freq

1
1.0
1
1
1
1
1.
1.t
1
1
1
1
1
1

1
2000000 GHz

More

rt 1.6 a : u " j Sz 1 of 2>

HATII R
ARAEASEHE 5 18 e BEAT W P i B 0

S8 1. KM NFA 150 Q A\ Wif.

HB]’ 2. % DUT #4#: 2 NFA 19 50 Q i\

BB, 3. MK 2-28 r, s RS DUT iE8:.

1.80880880 GHz

2.80080880 GHz

;

;

;

;

;

l_.

t 1.500BBR08 GHz
[

;

; 1.00906000 GH=
L —————————
;

;

14.7500880 GHz
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BITEARNZ
EATA 25 B 245

K 2-28 %8 DUT #7E

00000

O||oooo

DUT

£ DUT R i, WS %ﬁfﬂTNFAﬁTﬁ#‘rﬂP WRAEIR,
1% Restart (FEHTAEN) « WAREA BRI R, %52 Sweep(Cont) (F]
B ) BAH. WABIANEE .

SRR RLT K 2-30 45R
& 2-29 ME R RBFIRER

3 | Frequency
creatods,

DUT Amplifier owncony OFf Sweep

N0|seF|g dB Gain dB

p50

Start Freq
1.00000088 GHz

Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

Freq Span
1.00000088 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

$® 4. 1% Format 4, ¥ Format 2% A4 Graph (KB . 2 BRFBITE 2-29
BT 45 5
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TR E

TR 25 2 21
& 2-30 WEFHRBERLSER
- Agilent | Frequency
DUT Amplifier 5 Do Ff Freq g\-?e%;e:l’
Start Freq

1.80880880 GHz

Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

Freq Span
an 100068808 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

K 2-29 F1KE 2-30 o g R ] DUT i~ 2 s fa 80y 8.35 dB, 4
ai A 18.50 dB. [Hit, e B A AT SRR i FBIA 5 32 7o 0 LS
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ATl A i A P e 7 e A AL PR BRI e R AE A2 T BE

YA HEAT T B A

PN NS IB
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AEAFRE
AT PRI

L PR e AT B A e 00 e e/ ARG

A BUREAME R BUREAME T TR IE S . TR s 3 e S5 A1 P
REGHRE. JEAh, AT S2P S sUH T B AME K

HAT T2
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#RE PR B &

WERBIZAEE

L RA

RIF—FIRBIZE A
ik

e
WERHIZ

BE PR HIL

A DABCE BRI, A AR AT R LR R, 53 AhIE mT L A PR
2, Al AR RS R Z I 1) S H R S . RS P A% R RIZR S ] T —
FIE, Bl VR E L RRATT R

NFA 05 VY& 3007 (PR 2k . Limit Line(11) AT Limit Line(20) N+ L
K, Limit Line(3\) f1 Limit Line(4l) 5~ EH1%,

BRI 2 52w o Limit(1M). #ACE SO FRZR bR, % Limit Line (Rl
) E. XAEAK IR FR R FRIE M Limit Line(11)) # %5 Limit
Line(2M), FRXIZZE e, KPR ~4ric A Limit Line(21) £ % Limit
Line(3l). HHE %P, H [ Limit Line(17).

fmT LUK BRI 2k FRRECR PR, AR 1% R i 2 v A i izt

AR RIS, i SR A B PR 2 T, i Type(Upper) (G2
CE)) s Wz BRI AR TP, %$e Type(Lower) (57 () ).,
DY 4% B il 2 3420 53 ) W

A IS H A B L T P A PR e S TC B A L R e i PR A e, o —
2 B2k T LUK 7R 22 BRI RE 53— 2 PRI e DA ok PR A o

65T LLRRAE ZERIE b MR B T I . LR G SRR,
€] 8-1 i o /e AR . AEFeRRB i, e T LU SR 4 1 45
i

AR B2 B B IR, A S 75 R A5 45 1, 4% Test(On) (IR
FIIF)) 5 WA A G 450, 769% Test(Of)  CIIIR (S6H1) ) . U
S BRI BB




AR

& 3-1

R PR B &

k< A1 BT BRI 2%

WLRA

BRIIEE

WERBIZ

IS S, A4 R LIMITS FATIL: (PREGIMEE: O F5nbrid, HEEY)
#:7 Test(Off), |2k 5 4% Restart.

(Ll s Ny ay it

=2 Agilent

TS FALL: :I

' ’ \ BR s R f TR AR

s mT LR P /R — 4 BRI

ARAE R R IREIZE, 1%4% Display(On) (or (FTTF) ) o #ARHELE
K s BRRIZE, 6% Display(Off) (Wi (SEF) ) o DY PR I 70
Ir R .

BT E IHIZE, % Limit Lines All Off (SR HCH]) o« 3K RN
KT BRGIZ, Toit 5 BRI AH R 2 A TR s,  JTiE Test(Off)
1 Display(Off).

BRI G, FRZ K AN B2 .
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L RA
SE' 1.
S’ 2.
& 3-2

g IRE
S ERHIZ%

#2237 PR 2%

ARBLE R, i E R E IR Y B DU A i A BRI %
o MRBIZORE DR HEK, B D5 H AR SRR R GIATE R .

Limit CRRED oY BERE—NIEdERAr, NIEE R Y S 2, M
TR Y BhbR AL

ML LR SH,  Limit 50Y S EFARAS . I i T B T i
{H.

AR T BRI 2
¥% Limit Lines ##, EHFEA HE IR HIZE .
¥ Editor (ZmiEFEF) S,

28— Limit Line %,

PRl Lk &

45 Agilent

Limit Line 1

Frequency

Limit

Connected

Use ‘File' key to Load or Save a table.

| Limit Editor

Row Up
Row Down
Page Up
Page Down
Add

Delete Row

Clear Table
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SRR 3.

SR A4.

SE]S.
LRA

S& 6.
AR

BRIIEE

KB RFIZ%

BN — MR . 4% Tab .

HINEE—A Limit 580 Y #8007 {8 . % Tab 8.

23 NIES T S o B R bR FEE A IR A H — AN P 1 B R 2k AT
kil Connected (G With Yes (J&) B No ().

2 Connected #1%°4 Yes B, WP Z s 5a5—A midEd:, BN —4&EL.,
W 25, # Connected %4 No, 4Kz i S —ANilbir. K 3-3 &
TNIERERGL, B 3-4 Won R4k Display(On) I (1) B 45 53

PR BB Test(On) JF HLERMIZE B — Bl ol iy, SRR 2
AT, Behh, WREAEREAT e SR, T e iR, PR AIZ
A LLLE S BT I

BRIZPE, HREWELE . REILERERZ T8 201 M 4H .

PR T2 4 72 o 4% Prev 85l Limit Line SR (1B 12k 52 4. RAT BRI 2k
KO, WRHEEIRERHBIL ST, ES R 24 7RG 7.

ARFAS LR MU, THS 5 28 10 “ ALBRA 7.

TR DL — AN BARTORAT (BRI Ze o (H2, 5 24 e 1A SN 10 BT
gty WP 25 7 WAL 7.
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g IRE
S ERHIZ%

& 3-3 R SR 1) PR | 2R B
Limit Line 1
Frequency Limit Connected
10.0000000 MHz | 2.40000 Yes
100.000000 MHz | 2.45000 Yes
300.000000 MHz | 2.50000 Yes
400000000 MHz | 2.40000 Yes
1.00000000 GHz | 2.50000 Mo
1.50000000 GHz | 2.70000 Yes
2.00000000 GHz | 2.85000 Yes
2.10000000 GHz | 2.50000 Yes

Use ‘File' key to Load or Save a table.

& 3-4 BRI PRI LE B

RER— mEE ARG &

P

EEFE Y PR 2%

e -

Trace (#hifE)

//,f/
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SR’ 1.
P&’ 2.

BRIIEE

{E A FEAME

fit F R Fe 4=

ST LB NFA, SRS L0 0 . BB R AR
T O BURE . I8 BURE AT A B4 75390R DUT 21 (DUT 28 A1 /
sife DUT fI NFA HiA (DUT 25> Il o D AN A T i
1 5 S5RE A 0 1 o T 93 P T A 96 B O AS OB 8
BHURERME, (ERMBIU, RN A H L IR e Py il 53877 LA
e P A U L

3T LUK T2 23 BT 1) S2P 30 3P s S BUFEAM S 26 . NFA
45 S2P SCIHH SUBHOR BRERME L.

. F R A M D T

RN AIE Ay

L BATRCF AN IO, BORBCAAT BOAE 13 7 8 22 R HE e 2% o
2. WIRE, ERPCA S A SRS .

3. AF 50 Q ety (Btn s LI I S FUBORAR ) 5 BESRIC 24 DL L R S s Al

4. MT s SWR (GBEBEL) R & REpas w2 o
o GRS AR SR ) OB, R LI 45

(o}

Tic B [ 8 AR A M
ARO[ UFEAME 3B T 5T
% Loss Comp (#ikEfMz)

1% Setup (X E) X, Il Loss Compensation Setup (HFFEAMZE
) K. ESHE 3-5.
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& 3-5

SR 3.

WLRA

SR 4.

g IRE

fERmFEIME
WAEAMERER
- Agilent Before Comp
Before DUT Off
e | Off
Loss Compensation Setup
Fixed
Before DUT Off
Before DUT Fixed Value Table
Before Temperature 6.08 K —
After DUT 0ff

After DUT Fixed Value
After Temperature B.00 K

Mowve the highlight to select a field using the 'Tab' keys.

7E DUT Z Bl & HiFesh2 T, FH Tab #90% % Before DUT (B II%EE 2
B 1, e Fixed ([fE) g, R wonzee i, K DUT 2§y
BEAGE o

) Before DUT 15k After DUT (#ilZEE 2 J5) R A €, Toiki
N BV OS] PR M . AR PR [ e SREAMEEAE, 58 TR Fixed 2
g,

wAE DUT Z A & ke sME{E, H Tab 8% 5 Before DUT Fixed
Value (il & 2wl e HuE) 8k, 4 DUT Z ik A= 08 SR K e (E
WK 3-6,

M NES N AU, P SR ksl dB A B2 BB
NFh -100.000 dB, [-FR5 100.000 dB, Zkikfih 0.000 dB.




BRIIEE

{E A FEAME

S$®S5. £ DUT 2 Jalic & fistshzns, A Tab 8% % 2 After DUT 18, %+ Fixed
SErpgl, S BNz, K DUT 2 dch e . i3 WK 3-6.

SB6. 5/ DUT 2 a8 Hoesh2{t, H Tab # % 4 After DUT Fixed Value
AR 2 E D 88, I DUT 25 & A2 2K A .

M N RN AU, P SR etk sl dB A B2 BB
NFh -100.000 dB, [-FR5 100.000 dB, Zkikfih 0.000 dB.

& 3-6 HEFAMERERPERE Fixed( FE5E )
# Agilent Im
After DUT Fixed
Off
Loss Compensation Setup
Fixed
Before DUT Fized
Before DUT Fixed Value 5.000 dB Table
Before Temperature B.08 K —_— |
After DUT Fixed

After DUT Fixed Value -3.8608 dB
After Temperature B.06 K

Mowve the highlight to select a field using the 'Tab' keys.
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g IRE
ERHmFEME

ACEHFEAMER
AR B R A BFEAMES, AT RL T P BR
$B 1. % Loss Comp %
HB 2. % Setup ¥4, fFHl Loss Compensation Setup #. 1% & 3-7.

& 3-7 BFAME R ER

- Agilent I Before Comp
Before DUT Off
— e ——__  _—_ Off

Loss Compensation Setup

Fixed
Before DUT Dff
Before DUT Fixed Value Table
Before Temperature B.08 K JE——
After DUT Otf

After DUT Fixed Value
After Temperature 6.06 K

Mowve the highlight to select a field using the 'Tab' keys.

HFB,3. £ DUT Ziic BR& M BesM 2, 1 Tab ##30 % 4 Before DUT 4, 4%
Table (A%) S, R BRizeiit. WK 3-8.

R BUREAME S 72 DUT Z i b4 i di s FAUE AR ] . 1525
55 103 T ¢ AL HUFERMER 7.
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BRIIEE

{E A FEAME

S® 4. 4 DUT 2 Jald & # sz, B Tab @ %64 After DUT 1, iE#
Table s, S DoniZgss, iHS MK 3-8,
{FEH RS RN 5 E DUT 2 JG kA2 rh 38 2 I EUE AR R . 1521
%5 103 7 “ @ HAEAMER 7

&l 3-8 EmFEAMERER D %R Table (Fi&)
= Agilent Im
After DUT Table
| Off
Loss Compensation Setup
Fixed
Before DUT Table
Before DUT Fixed Value Table
Before Temperature 0,68 K . |
After DUT Tabls
After DUT Fixed Value
After Temperature B.88 K
Move the highlight to select a field using the Tab' keys.
15 AR AT LN — A LT IR AE IR AR o (HE, ISR B4R e iR MR 2
After Table (Fit%2 o) ifjE Before Table (A& Hi) . WS 25 W

43 %‘2)\1{# ”o

102 $IE



L RA

L RA

L RA

SR’ 1.

e

e mFEAME

BILHFEAMER
PHEAMER IR Z T 201 N H . ARSI HUREAME R, AT LU PR,

el Bontnfim N Before DUT %. WS &8 A After DUT %, #
ELA R0, ¥ Before Table 2 B 4y After Table F#44# .

I AR B R EAME R, (2 NFA b O LU RS 5 s, &
] LL¥% Clear Table iERrFAS) , MIERLARTIEHE . 28R WK 3-9.

Before DUT Table (#ill%& & 2 i) " ifikesMzR AR EH H DUT 1
WASUE LN, After DUT Table (ZE#GII%EE 2 f526) WA DUT i
RN . XA TR DUT il & ol ] 240 NS gs it 17> 5,

% Loss Comp % 1 Before Table Sz it

BRI Loss Compensation Before BUT Table (H{lIZEHE 2 A
FEAMERD , R I —MFEICR S oR, EZSE 3-9. St 4a
IR G RN S I H o A OCRASAT N, 1E S 2 28 T ¢ AbHiER
1:% ”O
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& 3-9

BRIIEE

{E A FEAME

FRFEAMER

Loss Frequency ——-

Loss Compensation Before DUT Table

Loss Frequency Loss Yalue

lUse 'File' key to Load or Save a table.

I Before Table

Row Up
Row Down
Page Up
Page Down
Add

Delete Row

Clear Table

A7 FH B Bl s N FEATR A o A FH SR S PR B A 1 A

% Tab #, H558H Wt BHGEMEAF, IF5ANS N BRI
LR BFEERT, EATLMER dB B linear L PER . (U, RighNg R

2l dB IR,

e Tab B, KPS R SR, AT MBS,

ERIDER2 4, HEMAIH T E SRR RBUEE.

ENIFEAME R NG, $% Prev Hol Loss Comp iR [Pl FE /M50

— HSEN T BURRAME SR N, T File HORAFIFEAMEEER
T RGAF AR VERS , TSI 24 00 “ RAFICIE 7
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TR

e mFEAME

1 BR WHR A RAEFEAME R, WP RE R EEE . IXEU T4 1) Power
On/Preset (HLUETTE / i) R, AU, iS5 211 7 “ &
SCHETT S/ TRBCIRAS 7,

AR T AL AR AT IO AE AR AN B3R TPl A SRR / 5060, PO NFA 2 H
EIEVINANIDNEIE TR SIS i el
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LRA

1 AA

SR 1.

SR’ 2.
P& 3.
SR A4.

BRIIEE

{E A FEAME

i S2P. S1 f1 S2 e

S2P s SCrF s Bt IA S H T 2 ANy SRR 1 2 1 X 44 S 40
S2P o442 LlbrvE ASCII Touchstone S2P #% =X i 7 ik [ 9 2% 73 B A )
e AU adE . S11. S21. S12 M S22 Mk sk, FEIEITE
X SHH NFA /. NEA {5 # C SO BOFEAR (4% S5 L K&
B AT A FEAE ) S21 S5

TRAZR A L5 S BT Ay S2P Hiiis xUlT, 18545 2B Bl 4% /1N 21K IR A I
FPARAT o

S2P k4% . UL Before BUT Table 5t After BUT Table 1724k K%
FEAME RN NFA. NFA 82 a W8 S R4 SCfF: s2p. s1 Ml
S2.

NFA (W REEN S2P S0k, HTGIETRAT S2P S0k e (AL, W LU
I NFA B3O R D REFS DL MR E B i 44 3K L8 S0 5

WRAE NFA P ARF LTI S2P S0, %047k Los X1t

HA S2P. S1 = S2 3

woks S2P 4% A SN NFA, AP 53N DR/ 7 REAE BB ek 2
(Los) CAFAHIA. THEAFH nos. s2p. s1 Fl s2 KA SCI#E A R4
TR PP B AT 1B

K Am N NFA (38 mzh s .

AR BE— SN, WS FH 25 50 A 7.

1% File .

% Load S B AF LA R 8.

% Loss SZ e .
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e

e mFEAME

$® 5. 1% Before Table &l After Table > it .

2 BN [-A-1 Wahds LRI SCHE . SRR BOE 4 ) S0k A
B/ B4 s2p. s1fls2

B 6. % Enter 4.

BRSPS HI—N Loading file EAEZAH) HHEw, $RREk
Ja, LRI .

iz WAZ L S2P S 2T CVAAE I WIFEAMER A sl T 2N, KA e 2
Before DUT Table &k After DUT Table %.
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BRIIEE

{E A FEAME

WEIRFEEE
MRV E BB, PATLL R D,
$B, 1. ¥ Loss Comp (FikEthz) 4

SB|2. 1% Setup (W H) 4, ffH Loss Compensation Setup (HIFE#MEW
) #. Wz KE 3-10.

& 3-10 EBFEAMER E R PiEE Temperature GERE)
5 Agilent I Before Comp
Before DUT Off
e | Off
Loss Compensation Setup
Fixed
Before DUT Off
Before DUT Fixed Value Table
Before Temperature 294,08 K -
After DUT 0ff

After DUT Fixed Value
After Temperature 304,68 K

Move the highlight to select a fizld using the 'Tab' keys.

$B3. £ DUT ik &R, ] Tab % = Before Temperature (i)
D B, IR DUT 2 Fi A A= 22K U B S FE {8

MEC MR AN N UE, I By Az K. C BUF 2R3
i C ul F s 2 b4 H et K.

TH%0.0K, % 29,650,000.0 K, EKilEh 0.0 K.
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e

e mFEAME

$B 4. s DUT 2GR, ] Tab %0 4 After Temperature (IR
Ji) B, IEA R AL DUT 2 )5 (3SR s S B .

MEC MR AN N UE, I By A K. C BUF BEZ i 3fE .
i C ot F g g 251 B 46 H e ol K.

R 0.0 K, B4 29,650,000.0 K, ERiAiEh 0.0 K.
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LRA

BRIIEE
HITFFME

HATFhE

IR T A/ AR T el . R EAEAE A SNS 81 346 &
BN FE YR P o XS bR NFA A8 e s 53047 16 [ shill 5 o
TAAE, LTINS ] DA A I e A s SINGS e R Y5 ik 4 T G P g
FYEHEIT Phot  (#4Th#%) Fil Peold (ATha) & (177 208 H IR E A
I & 55 A5 P R A YA T R SRR, AN ) 2 A AR T RN R S T R
INSERR 5 — AN FYEF— AR UERE . AU (FIBESED MRS T2
IERERRE . RS, BRAE gk T, S mes. R IE
MR PR, L YR T AR AR/ AR Tl A IS 24 1) Noise
Source(On) (M7= (F7JF) ) F1 Noise Source(Off) (MEmJ§ (KM )
Thie, WS JEaHT R oCH, il Noise Source(On) #2141 Phot.

LUF B SHR B 1 PR B o AERE IR i EORPAT LD IR

N8972A I N89T3A M5 o e i i, I HR bt AN . Mk, 7
AR RFIUW At G40/ T i) SR FBE N 4 3 FRAE RF Attt Cff
W) SEEE. BEAh, Fixed UWW At CFE MDD Bt ToVEE
H.
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L RA

L RA

e

HEATFHNE

AT TF-Bh A, TSR YA S 40y

1. LEXT bR e AT e sh 2w, 2iide NFA g s — AN e .
FAF BE AU 7 o 1 T SUE B 2 A% 7 5 1Y) Accept  (F:52) SEHVEE,

2. DUT @2 5 e 2 a0, R eE NFA BN ikss. Mg
PR WO Z A AN T2 B v A [, T2 1B RF/IUW Att(Hold)
CHPH / plesik (BRF5) ) B RF/UW Att(Fixed) S 451/ filinl 28k
(e ) o IR E R, {4 Fixed RF Att/Fixed UW Att ([ 2 5t
AL, / T 2 T 98D S LR 0 1] 5 2 Dk B A1

3. WAV IF sEidas AE A HERTI & 2 0] 3 ZhHE

4. DRI HE S (Y5 T FRRISC D RPN e 4 (e A Ya4T
TR ¥ IF FEpkas rEr M il e, 77k ik # IF Att(Hold) (HPiiss
W (RFE) ) 5L IF Att(Fixed) CrRgliges ([E5E) ) o e IF fX
i, A H Fixed IF Att  C[E] 2 s Sempsdss e ble TF 2 ikis (.

FEHE— RAVIR S, Hop—AN S L, B FHEE IR ZIR S R
%, % Calibrate (F:¥E) f#, FTRRUE.

WE— RPN S, Hob—AN S L, BFEE I IRREZIR S R
5. % Restart (FEHr/B5)) #, EXKI=.




& 3-11

i Agilent

LRR

SR,

SR 2.

BRIIEE

HITFFME

FAW 2 kg AT F & B
Manual Heas

DUT Amelifier Sy T Or M s

Manual

Freq GHz | NoiseFig dB Gain dB Accept

1.000000 3217 19.980 Calibration
0ff On

Noise Source

0ff On

RF/pH Att

Auto Hold Fised

Freq Power IF Att

1.000000 GHz  -1.896 dB Auto Hold Fieed

Hore’

lof2

FIMERF

FEAREP BB 0], 308 55 0 S R Bl o8 n bic i ok, FRAREE AT
a7

AR D SRR -

AN E RF/UW - G/ ) Sk -

K Ty &5 DUT s A&, - DUT st 5 NFA &E#%.

o=

% Noise Source(On) (s (FTIF) ), i Ty, A )i Y5 = g
A
3. #% RF/UW Att(Hold), &AMl &2 # e RF ks .

i
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P&’ 3.

AR

4.
5.
6.

R

HEATFHNE

Bt DUT, fsme ity NFA &R,

% Calibration (On) (K7 (4T7F) ), F Phot £y & [fm S TAL
i

% IF Att(Hold), i IF ZEyskas (e /e b, s 40 LA e S IF
Att(Fixed) i .

% Accept (#:%2) , {7t Phot &Kk 14k,
% Noise Source(Off) (=5 (SCH]) ), %EF Peold ki .
% Accept, f7fiti Phot i1k,

LN

1.

¥ Calibration (Off) (vt (KM ) .

2. Ky DUT %48, K DUT 5 NFA iE#:.

3. 1% Noise Source(On), %+ Phot i5:%¢.

4.

5. 1% IF Att(Hold), i IF %y [ e A B e b, A ] AR E U IF

% IF Att(Auto), fuvf IF s AshHS.

Att(Fixed) 1f .

6. 1% Accept, f7fiti Phot Jll&45 4.

% Noise Source(Off), Jfi« Accept, f7-fiti Pcold Il .

R BCEAR S TR — R, 1% Point (10D SEPEIFHIA K
B W MR GOTRER DR, HREIA R 5.

TEAAZM 3 I o




BRIIEE
HITFFME

114
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HATY IR E

AR TR A i R PR R AT SR e A R A
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HEATH TSR E
FEARRE

AEAFRE
AT PRI

P B TSI B ABIA
IERHER

8970B Fil NFA Z5|J # AL
P wCE AR

EERG

BN EAH DUT

v AT AR DUT i &

il ARG8T A AR A T I i )
A VG BIEAT R G0 T AR A A DNl
A Bl

116
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HATH RN E
EEY FImE N EE

L BV RN ERid
RO 4 FEHIR 52 0 D A5 0.

B 1. ¥ System ##, H GPIB. LO GPIB #1 External LO 3z .15 H A4 2 sk fic
B ERGESH

#4-1 RS

2 i

NFA Address (NFA Hifil) XAERL 2V B NFA [ GPIB Hidik.
HREHHEMN 0 2 30,
RIAHHES 8,

External LO Address % %5 LO GPIB ¥ &0

(AN YR AL External LO GPIB Hutl.
ik 0 £ 30,
2RAHHEA 19,

LO GPIB Address W EH:E LO GPIB [ fth s 2 H

(AR A O B 2k Hhl) T5 NFA # ik,
Hautbk N 0 2 30,
ERIAHE A 8.

8445 %% E External LO $844E35 . B

INE ) Command Set(SCPI)
(}§44% (SCPD ), #1F%5 SCPI
M LO. 4 External LO A5
SCPI e 25 A & Hilfia 4 i A
iif, {4l Command Set(Custom)
(&% GEdD ) .

LO Commands (A#E$E4) ZHFE External LO Commands
(HIMEARYETRS) R ZRHTEA

#1dE SCPI 75 11) External LO 5

%,




*4-1

HEATH TSR E

BCE Y FTIMFE N E 8tk
RGESH
¥ i
SE AT I (7] ¥ & External LO ff 2 A7 R o 25
7t External LO %525 55 0 J 4 AR
A7 IR o
Min and Max Frequency % & External LO [ Rl 5 w4
AR 5 AR %,

$B] 2. 1% Meas Mode ##, it & B 75 5 B0 Hr Al i
5 Al A AR TS, WS 119 0L« EE 7,
IR 3. % Mode Setup 5, - AR R 0 & i S a4

& 4. ] Frequency/Points Il Averaging/Bandwidth Zit & Il /& (U EAR G
B, 0 R ORI PR A o

A ORBC B 1 VRS CRLSAIHE) , WS P50 31 0T 2 &, “ BATHAN R 7
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ATAER

L RA

HATH RN E
MERKX

W ER N
W A HE G ATITAR 1) Meas Mode BERE(t F 9B 58

o DUT Wlll%eE) &R BRI REMBON SRR R . O SEA
AR, PRI NFA BRACRTEH A . SEZ 2 84 1T ¢
FEATEOR AR 24451 7

o DUT & MRe#AEN RSB BB Bk A AT KT AR R I
(ARG TFAHD « LIS T, LO arLU2 e LO snf 42 LO.

o DUT 2/ Fadids (AR A DUT A5, A AL &t
BEMBO o LO LU E LO 822 LO.

o DUT 2> bAghids (R RSB A A DUT A5, A AL &t
BEPBO o« LO W LUEREE LO sinf 42 LO.

Amplifier JE BN TAEMARATZS DUT, WHRBOCE . JEBEE . =

FE N B IE N AT b BG4 o BEA T 75 i S
o Agiue DUT 1A 865r. #ldn, DUT 52— G iR sz o .

o RBUEI A MNABCE K. H EENFAS ARG F 5 & s DUT ik
AT, D G SRS ARG S I = A e, DUIRRE %0
AR NFA 155G A




K 4-1

HEATH TSR E
MERK

NFA n2ifE DUT H sl fF 4 B in System Downconverter (R4: 4840
) BT AR, o NFA /EARJE Y edsii s . NFA & nTLUgH
SCPI 54 sE Hlfe4 fe il LO Y. Al deizdssl 15t LO #E T4,
FEAN R — T

FEAM SR EER 4-1 P BoR, AVFEREE MR E S 2 .

AR S TR RO B — M

BeetE
WP
[ﬂ[::IE >
MR
WP

[c:m» put
/
PAT KB IEM S 5, 45 AW m 2 G Fra SO s i e 4. Ak %

BIEPIHPATRAE S, NFA & A 5 A RO seEE k. faTe s
Rh, BHAERCEIMT MR B IESSR TR ER, gl DUT R,
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LRA

LRA

HATH RN E
MERKX

TR, NFA Bk

DUT (#MRE) Amplifier (X

System Downconverter | Off (%@
(RET LR

Jirfi NFA 255 Eif) RF S\ 584 — A A3 3.0 GHz (RIEIE S - £
AT I R DB e BRI, 5 B IR A HEAT Ui ] o

7E N89T4A I N8ITHA M5 b, SN/ 1 BATILIE DI e - AERHAERI
SRR O RIDE B A EOR I, B LI PR AT U] . AR TR
3.0 GHz JF R ER, X —mith 7y H
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WLRA

HEATH TSR E
MERK

T4 DUT
FEZAA, DUT W — 6 NARBCREE, Fai s sk s .
ST PR ] e £% -
1. w74 LO iz IF .

FEREAT T Y, NFA BUEAE MR, LO #7434,
2. [ s LO fin 4 IF .

FEREAT T Y, LO BUEAE MR, NFA ST,

FEPRPRE REAT LI I, G EEHAT LS, DMERR BRI . AN
IR DU R L PE P A Y 0 B 5 AEAHE R AR RN B B A rh . (HE, AR AR B
fEEgAE T, R DU ASREAM::,  DURRE DT AT AR B
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HATH RN E
MERKX

Fixed IF Variable LO (FEZH#E4A#K) (8970B #= 1.3)

PO VB AR AT 5 B . 2B 55 187 T “ R [RE 7, T faE i T
AR BRI A TS5 163 1T “ AT DUT ilH 7, SR AR
MBI s T LSB. nrE LO M e IF s ey . HE,
T B, PN A& ML T RE . A RTINS, 2
140 vt “ P2 DUT 7,

{F Measurement Mode Form CMEAIAFE) &, WE FHIH:

DUT (#mzEE) Downconv (TZ50)
System No Access (TCiEA7HD
Downconverter

(RHET TR

LO Mode (FiRiE=) Variable (®JZ%)

7F Mode Setup Form (P W EFR) H, W FAHIIH:

IF Frequency (/3i)

AN — U

Sideband Ga#)

LSB. USB :i DSB

LO Control (FiR#EF)D | On T
External LO Power W ANEUEIH dBm 5%
Level (4hEARIREF) W 2 EHUE

External LO Power Level £ dBm # NFA # &5,

{E Frequency (W) sEifid, Hikidseh RFE CGiAZ DUT) #i%k.
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HEATH TSR E
MERK

Variable IF Fixed LO (R[4 e 4$x) (8970B £z 1.4)

WA VAR AT 5 (B . 12 P45 187 il “ B[R 7, T faE i T
AR BRI A S0 EE 163 10 “ AT DUT ilH 7, SR ARIH)
MBI s T LSB. FlE IF frn 4z LO & ey . HE,

R B, T NI ) JE DI RE -

140 vt “ JEAH DUT 7,

{F Measurement Mode Form 7', ¥ F#ITiH:

A7 XT3 TRV

HZ

DUT (=) Downconv (T35
System No Access (TCiEA7HD
Downconverter

(RHET TR

LO Mode (F#miEz)

Fixed (EE>

fF Mode Setup FormH ¥, & FAITHH:

LO Frequency (Z&iR5H
)

AN — N UE

Sideband Ga#)

LSB. USB : DSB

LO Control (Z&#RizEsD

Off (5¢i1) 2 On

G
External LO Power W ANEUEIH dBm 58
Level (4MEXIRBETE) W 215l

External LO Power Level /£ dBm 74 NFA B 7R.

7t Frequency ¢, SiZgyliige  IF (N DUT i) iz,
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AT RN E

MERKX
E25 DUT
FEZAEA, DUT W — A LAHCRE, flinfeimas.
ST PR ] e £% -

1. w74 LO il e IF.

FEREAT T Y, NFA BUEAE MR, LO #7434,
2. [z LO fim 4 IF .

FEREAT T Y, LO BUEAE MR, NFA ST,

F4E 125



HEATH TSR E
MERK

Fixed IF Variable LO (FE g4 #K) (A& SUM A
8970B #=; 1.3)

W A FH AR A B T s (R F S . 15 2 58 187 1 “ IR IR 7, T ARE
T AR RS S5 1563 7 “ #4741 DUT Jil& 7, $R1AFARL
A —ANEp. Es B oRAT LSB. [ IF firm 4z LO MEmfL . H
s AR, JFNYAE ML T RE. A RTINS, T2
5 140 7T “ WEAH DUT 7. fEARH, A fevrikis DSB &

{F Measurement Mode Form "', & F#IiH:

DUT (ks> Upconv (EZE5D)
System No Access (TCiEA7HD
Downconverter

(RHET TR

LO Mode (&i#R#&Est) Variable (®]%F)

fF£ Mode Setup FormH ¥, & FAITHH:

IF Frequency (&3 WA EUE
Sideband Ga%#) LSB &l USB
LO Control (&iiZH)D | On (770
External LO Power o ANFUEIFH] dBm 5
Level (SMEAIREF W 2 50{H

AR External LO Power Level /2 dBm 7t NFA 1 i,

7t Frequency ¢ irf, Siigidae A RF (jn DUT ) S,
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HATH RN E
MERKX

Variable IF Fixed LO (FI&HHEEA ) (A& SUM LK
8970B #= 1.4)

W A FH AR A B T s (R B S o 15 2 I 28 187 0 “ IR IR 7, T ARE
T AR RS A S5 1563 i “ #4741 DUT Jil& 7, SR1AF AR
A —ANEp. Zs B oRAT LSB. [ IF firm 4z LO MEMfL . H
s AR, IV AE M e RE. A RTINS, T2
5 140 7T “ ARSI DUT 7. fEARH, A fevrikis DSB Jil&.

{F Measurement Mode Form "', & F#IiH:

DUT GEEE) Upconverter
(LTS
System No Access (CEIEAFHD
Downconverter
(RETTHB)
LO Mode (&#R#ER) Fixed (E®E)
1FE Mode Setup Form ', & & FATIH:

LO Frequency N — AU
(EHRIE)
Sideband (&%) LSB & USB
LO Control Off (<i#]) B¢ On
(AHRIEH)D €iEiD)
External LO Power W ANEUEIH dBm 5%
Level (4hEARIREE) W 28 140l

15 BF External LO Power Level /£ dBm 7& NFA oK.

1t Frequency 3¢ #uh, Jiisiitsse b IF O\ DUT %) Sk

F4
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LRR

HEATH TSR E
MERK

ARG TR

DUT & SAFAhke &, BlnmsoRas sippeds, HAURE 1 NFA 1l
JaHl WA RGN ESR A, H DUT MRS A A 5 A2 4

AT PR AT IR $% -
1. mAgdin LO A e IF .

FEREAT T I, NFA U/ MR, LO $AT+4i.
2. [ LO Mz IF .

FEREATBEIIN Y, LO BUEAE MR, NFA $drd.

FEPTRP B BEAT I A I B, T EERAT L0, DMER BRI A4 . AL
(I DU T A DB 1 B AR HE R AR RN B Bk A b o EE, AR
FEBRAR A, G U A BRAEAMa:, AR AT oAbt ik .
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HATH RN E
MERKX

Fixed IF Variable LO (FEZH#nE4A#K) (8970B #= 1.1)
WA A AR 20 BT T IR R . 5 S5 187 TSR R T E

TAB I PRGBS TESEE 174 00 BT RGN RPN R ", SRIGARE
A —MNEH]. ZE SR AT LSBL [ IF Fiml 28 LO & i fe

Feo AHZ, B R OB, RN HIE i pE T RE .
TSI 165 U “ i R 58 P A Hias AT IR 7.

{F Measurement Mode Form 7', ¥ F#ITiH:

A7 RIX T3 TP

DUT GRS Amplifier (ka8
System Oon (3199
Downconverter

(RET LR

LO Mode (&i#R#ER) Variable (#J%F)

{f Mode Setup Form ', W' FAIIH:

IF Frequency (/3i)

AN — U

Sideband Ga#)

LSB. USB :i DSB

LO Control (Fi#R#EF)D | On T
External LO Power W ANEUEIH dBm 5%
Level (SpMEFRIRBRTE) W 2 E5E

1% AR External LO Power Level £ dBm # NFA # &5,

7t Frequency 5, Mg b RF () DUT ) 5%,
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HEATH TSR E
MERK

Variable IF Fixed LO (R[4 e 4$x) (8970B = 1.2)
WA A AR 200 BT T I R . TS5 187 T “ MR 7, TS

T ARG REI A WSS 174 00 “ 34T RS NS 7, RAFA
B —AEH] . EART, A RVFIET DSB Wil . iZupl 2 7s a4k

17 LSB. [ IF fimf4s LO Py . (HAE,

R e, PN

& EThRE . AR TERS, S 165 7T “ i HI R G0 T A

AT 7

{F Measurement Mode Form ', ¥ F#ITiH:

DUT (#HUED) Amplifier (X8
System Oon (317
Downconverter

(RET TR

LO Mode (&#R#ER) Fixed (E®E)

{F Mode Setup Form ', W' FAIIH:

LO Frequency (iR
35E)

BN

Sideband Ga#)

LSB = USB

LO Control (Z&#F#EsD)

Off (5¢H1) 2 On

3T
External LO Power E NEUE I dBm B}
Level (ShEXIREF) W & EHUE
i) External LO Power Level /524 dBm 7 NFA iR,

1t Frequency =i, Biigidize oy RF (i) DUT fA) M.
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AT RN E
8970B #1 NFA R E1&5K LLik

8970B #l NFA &7 & A L
* 4-2 11 TH8 8970B HIj Kt 8970B I HAA WU 4 NFA R 41 &

i
*4-2 8970B # A b

8970B NFA %%

B 1.1: Swept LO  (H#iAH) System Downconverter
(REG FAMES)
Fixed IF Variable LO
CP] e oA AR A

i 1.2: Fixed LO ([ AH System Downconverter
(R M)
Variable IF Fixed LO
Ry AR Hh B ] e A=)

P 1.3: Swept LO (1A Downconverting  ( F4845)
Fixed IF Variable LO
CP] e B A AR A D

i 1.4: Fixed LO (Fl@A$R) Downconverting ( FA845)
Variable IF Fixed LO
CRJ A 501 ] 5 AR )

fic s SUM i i 1.3 Swept Upconverting  ( 4845

LO (HfATR Fixed IF Variable LO
([ AR ) . USB

fic % SUM 471 i 1.4: Fixed LO | Upconverting (_A845)

Cl 7 A4 Variable IF Fixed LO
CrrAE o e AR ) « USB
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LRA

HEATH TSR E
&R 5 EFR

S REANR

wEATRE NFA #1795l &

PRI, LO W A E T NFA 1 TF S . %24
1O W LW P H BT TSR SRR

UL AR R R I T LO, SO 5405 4% LO
WL BORE, R A8 B E — LO fER RGN L4 — B
FARAL

ST BRI, LO AN 15— M T LO % TF M
P

w1 LO #4455 Mg EXHE L 2 1 SIS & 1 mm

LO 1107 AP IS S RFF AR L. AT P25 A S0, UL
e ISR A% TF AR i, SRALORE LA LO M Cimd
KT R4 AR -90 dBm BLF. WS R RSB e, LO
(KW P TR, R0 TR RE S B SR LO W

WA NPk Lo & TR hae iz, Xathenl s, A7 TRk,
TR A W] RE Se i LO MR aind, AT B el A e A AR A

L & T2 i Mias i LO 27 45 5 A e VFIZ L5 S 2 TF iyt i1

NS
He o
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HATH RN E
& 5B AR

A NFA %844k

PAR e HE LO I 2R ) JLIUbR A -

1. LO 4 f—Aidaprk DUT BeRia . IF JeE AL fsaia .
2. WRT AT A2 LO e, 448 GPIB _ErT L] LO.

3. LO N1 g DR kiR Migs  GaH A +7 dBm) .

4. LO PCAA MR E LN G SR NFAMFD .

B, R RS AR — D U] £ NFA R, A =Fosuis
MIEBAE, X =R b A i, A BeAe TR AT HER I . B A i
FE RS BON LO 2R U 2R M, #ldn Agilent 83712B Zity
CW K /tds.

W DM H Al LO, HR 201288 LO BEATMNK,  DASEAf & FEk A ARAIE,
P LO Mg o AE R Mies / LO A& R a8 in, JF T el REnE L
AT At LO o ey . w2 O R S B e A% 52 (1
o RSN ZE R R I G a5 WUAs 5 R AR I, L B2 .
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HEATH TSR E
&R 5 EFR

% & NFA, K344
PAUN R H T A DA (e ISR 7 Al LA B I 2 T AT
» &# External LO Hikil:
o WERACHE S LO Sk
o WEENINA
% & External LO #ili:
$ B 1. 4% System . GPIB = ¥4t
System GPIB Form (RZMMEIMLR) HIME L RE L.

SI® 2, {fif] Tab 4, <4 7~ External LO Address i, & 4-2 s FITk
Wbk, P/ MR E External LO Address, 31/ Enter &4 11

& 4-2 External LO Address (4 EA#EHHE)

% Agilent Ext. LO Addr
External LO Address 19
Ext. LO Addr

System GPIB Form ?

Moise Figure Analyzer Address|s

External LO Address 19
LO GPIBE Address 8

Mowve the highlight to select a field using the 'Tab' keys.
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WLRA

SR 1.
P&’ 2.

P& 3.

HATH RN E
& 5B AR

WHRAE NFA SR EPIREITH B — W4 1% 91S GPIB Error, Write
command timeout (GPIB #%i%, GAIESER) , WFRRITLIEE ANIMNE
LO. Rrffgse FolibEs —:

* GPIB HZ0RIERZ LA K .
o 4MELO K4T7F.
» NFA 15k LO ik ix.

W NFA RZ IR LR TvEE S LO, MauesE, BSEpra sk oid ik
oo JPMEAE RS AEMEAA R AER RS, 5k LO EIEH .
wEREMER LO M%E

1% System . External LO 3z 4,

2 Min Freq CIRARMIR) SERHE, AN B AR

M NRE NS, A a2 Bl s RPG s Il s 2=
FORMBUE. A External LO, SRAGA T ROEAAEMIH LO &R
#. BOMEAN 10 MHz.

% Max Freq (i) S, A mEiE(E.

M NRE NS, A 2 Bl sl RPG s Ll 2=
FORMMUE . A External LO, SRAGAS T ROEAEM K LO 5w
#. BUNMEHN 40.0 GHz.
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& 4-3

PR’
PR’ 2.

HEATH TSR E
&R 5 EFR

B E External LO {5 1SR AF A E L I 6]

_ =
DUT Amplifior Downcony OfF ch?mma"& Sstfrﬁ

LO Commands»

Settling Time
108.0 ms

Min Freq
10.00660008 MHz

-A.154

Max Freq
40.0080068 GHz

BB AL H]
% System 4. External LO 3z ifift,
% Settling Time CGEfZIN ) SR, A Settling Time 5.

I INREE NS, A e B R B, s T TR AR 2 LR L
HR BRI . BAMES 100 mS.
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AR

ST’ 1.

P&’ 2.

P& 3.

SR A4.

HATH RN E

ERRR

4-4 M 4-5 WoRiE R KD, T U TIcME NFA,  AEAe e ol
DUT, Jigd MM LABIRMES . BORARIE /IR s . 1ZBR
TR PSR A AL, DA BR AR AT JC 2041 sl A P s

BEBRFEIRE X

AT LS 10 MHz %2 2% . ik,  NFA 1 LO BeiE 767 — i
XA E . X UM NFA ) 10 MHz Ref Out (10 MHz Z%%it) %
LO 10 MHz Ref In (10 MHz %% A) = LO ) 10 MHz Ref Out
(10 MHz z#%%iit) % NFA (% 10 MHz Ref In (10 MHz Z%%i \)
e IRAT HAMES 5t . AR T IR A I b R iR AR HES % .

Az NFA 3470 & -

7£ NFA 1f) LO GPIB Jr futi i i ds MAK) GPIB E#4% 2 a4 4R
GPIB w145,

TGS, 1% Preset B, {if NFA iR [o]—Fh CRPRAS .

NFA mf Pl — @i ngk (LO GPIB) ##ilAdR, Tl H oMz
Efilas. NFA A3 GPIB %% LO #Hilf54 . LO #Hliom it

LO GPIB 5& .

¥ ENR e NFA. 52504 33 00 “ Mkt (ENRD #ds 7, T #
SEIRIL LS5 1D TR

BERAE RGP, EADE S F R ECE DUT.
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HEATH TSR E

EERG
K 4-4 ARG T BN
LO (&%)
: ‘Lo GPB Sfl[oooooo
R 228858
: (KiRER S
BB E ?ED.EE%) 3 S0 00 I
W 5)|888. ©
~ AV 00
AY] AY]
Y,
LO
MERE i;’io bl
ﬁﬁgsﬁ ° 000 000
n, ny
DUT |
~ ~
J
138
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HATH RN E

& 4-5 255 DUT Ji &

ol E88883
BHERE E ggooao
0o ||
- 0000 0o
T 7 U 8 806
000 000 9|oooo
L Q‘(\ ® o OO )
J
LO
K 0y =]
PERE =
o
o
82
e 75 IR - ~ 8o
. K EaV O
AY]

DUT
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HEATH TSR E
MEFESH DUT

ME2m DUT

& 4-6 245 DUT il 245K
_— - s
3 SISEEER
00 ||
‘ : 5ERo o0
L e ommee9)|555. O
- Q'\ 9 o [©]®)
/
LO
. :'I: ........ =
R E S e =
o
=]
a8
W P e — 55
: " O
:.’ % %
DUT

FEARA A, DUT RS E P IATAR. HE, ERERCE PR,
WS E 4-6. BAEBCE A H S SOvF NFA I A 50 B 5 i 45 4L
RS o ANV NFA K 10 AR B AT e e
o WEHTE, NFA WS DUT RsmAsiE, JERHK B S ENR
RIEHEME, Wi DUT, En T A 4.
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L RA

HATH RN E
MELH DUT

AR STVE XTI B0 P AR AT VA, R ISR S5 NFA. A7 Pyl
EINHASESE iBIRUE

1. DUT LO #4345, NFA #4#%% DUT [ IF.
2. DUT LO [il5E, NFA g4 .

R DUT 35— AEGE LO, WAEIEH S — ki, Wik DUT i —4
Hh LO, AT AR — k. WESESEmA NFA, PFILREasR
Tt fevr NFA $AT P s geie, JF% i LO.

X Fax s g, NFA S8y
e DUT: Upconv ( I4Z4i) 5 Downconv (A&

AR AN AR R A BT AT AT ) DU, Joie e ) 5 (1 i
e, R RIRI AR SR A S o
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E 4-7

i

HEATH TSR E
MEFESH DUT

hH I E G

X AR ARSI b, ST 5 S T KRRV ], Rt A
BRI IEERAE g . B, o] BeA7 A LRP AR (0 RS (K7 1%,
Ik 5 20T i AT FDE B &% B IE R A 0

A ER

Fus 'Flo

iz

Flo
Fio-Fisb
HER

NFA A LSB #iA USB #iA
S

RF il LO #5522y Ly s AR R s i A5 5o Rl e 37 [A
SE AR A E LO SR, A PRI A S AR AR 0 AR . ik
s IEAER 4-T v BoR.
RN P AN R AP P M P Y Y, DRI A T RESSAE A A AL T
i A AT TSR TR R A 1% R A AR S A A4 B NFA
P AR A IF ey s . NFA MOX PSS 10 O A s i o e
Fio BEOWBEHLYERE R, DRI r - AR S AR IR 7 R e S5 R,
NFA PN A A e 58 (0 550ty P AC e A S (KO 7 o A AR 5
AL SRS s (K AR SR X0, B DSB.
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HATH RN E
MELH DUT

M HH GO BB RO s, B USB, R EG BRS R
ik, BILSB.

FRBEALIR A o L — AN AT Ny :

RS VN ERERER: IRV P

2. 32 LO 55 KRB Hm M N .

3. RIS 5 A LO i =

AT Feh— 2890 KA AT S BT i, (ER SRS AR AV P
HBAE, XHLGIEA G LIRSS N Hit o

5 Simit

RS B AT 5 BRI M TR it OB G, DRI A e P P A 8
VAR A5 S iRl s A2 TR R, BRI ENR UK R 222
1, s R RE 2 IF Jit ™ E .

LO Jsitt

LO D3 i TR SR A E A B KA 5 Bl P Fis S i
A5 S 7KPAREL, ok BRI 4t 1K LO DhAattiis AP Rk, 7Rl &
2 DUT M, 75 222% 18 LO .

Wk LO BRAR1%, NFA RF 73 A ugsas (3.0 GHz IR iEsas)
arehdd, LO tskoafE NFA 1) RF A s£mas 53508 — A
BURmEE . XK AT R e  DUT e A$a4. v L7 DUT #il NFA
Z IR — G IEB A, BEr LO Bk, LA LO it sl i) s igf
e
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F4-1

HEATH TSR E
MEFESH DUT

LO #3%

TR R th T 3% LO {3 S, RS AR TR LO it
o AL RS T LO My AT MR X R A2 T4
VSR, SRR TF . AT AR OUT A LO i3
KT T LA R LO £ 5 A e RAT By A TS AN E XA
BIUK [F, ) > TR TR OISR B N U

[ForFp) + [2F o2 F ] + [3F g2 F p] + [4F g2 F p] + [SF g2 Fp] + .o

E AR 7 B SV Bt DUT (M S . (L2, st
AT RO, AR TE, TR A R TR

k8 DUT p3HARME S

#5143 7 “LO Jwitt ” 22 dhid 7 NFA RF 4\ 20kt B 3051 1) ) 4
(O, F IR R (5 5 T DOl I 984T B 3hHES NFA ) TF 88 28 7250 1
JNERAE NFA W E U . NFA G —A i NFA A 55— &R LO
I B SN R ], ALk NFA R %2 10 MHz 1925k, NFA
AR TR g3 & 160 i i 11 A%< 10 MHz DB RS 5™ ik . 16 4%
A GEIN A A 7R 10 MHz LA (T HIAE 5 ol e s 50 e 454
LN
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HATH RN E
MELH DUT

BihHNE

RZHORAEE N ARG il (SSB) Wsi— LSB 5 USB, it

TG A AR A R TR AR I DU T AR TR A REA T PR R M . BE4T SSB

I SR B YE AR R R TC T S T LO Il LA HAth T8 HIVR A ™

dho A AESY EORAEHIARSEOL N L i &5 B8 &%, ATLE ] DSB i HAE 4

e BT EATRE A, WA AR R G BB TR 200 Sl

TUUELE,

- IR S ROk R

1. Yo AR MR A, LO fifm .

TS R AR IR

T8 LO IS U i MR v

EFE B TSI DUT Z W FIIER A, 1% D8RR AL AT H (K5 A

HrERE, SRR TE e AT L

5. %1& LO HiRyull  CRNERD , 22— G IERas Ry NFA A, Al
A0 - 3.5 GHz Yu [l A LO itk ?

6. LEF - GUENA, W REiEASE DUT M1 NFA 216,

WIRARAT_ERVEE R AR, e Ras ZORTCIEAT, AT LRI > — 4l

BONNE L, BF—ASE B A R D8 B o

ik DUT 22— & SRR, WA fe L2 & /el AH S H LA i

LR A TR A HOUE IS T o TR AR AE S 28 N R Py v 2 H DL R £ )

R, A A R RO ARG T, DR R i R g e 7 i

SRR T A UE B D REAH AT IE B Th fE -

W N
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K 4-8

i@

HEATH TSR E
MEFESH DUT

BRI RS &

Flo BURT Fio, A&EEE DUT
Fio-Fiso N kiR, BB LO R
. B

O EN
HNRMERE —

v

NFA iGN LSB i USB #iA
ik
Kl 4-8 Lox SSB AR CRARMgs LSB) , JLrp gyl #8482 1ok ik
e W TF SR EEG, NFA #IE2RE5i%, USB A1 LSB A
Baes LO S (0 5. X s AR, wilf IF d—D %
%, NSk B —ANTCHEEAT HED A1 SSB e 11 o ek 2% 1t 3 BB o) LO
ol IF iR A 700 = s

NFA Jy & IR T R . o) NFA 5381 LO Bk, {112,
s I S B SR A BB T G e

TR ARIEE (IF) KTFHRANE (RE) .
EAEREARLEE P BTWASE (RE).
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& 4-9

i@

HATH RN E
MELH DUT

NFA mJ AR N g5k £ SRR 4b 3 SSB RS il & -

* DUT: Upconverter ( F7ZWiids) 5 Downconverter ( [7Z%54%)
e LO#&R: Fixed ([flx) 5k Variable (n]7%)

* Sideband (i) : LSB ¢ USB.

X P &

DSB BoRBEMSIEAT A M AR Bl it 2504 18 LA 5 i

o WUIRTCVAIRAEH T E S SSB I IE 2 PB4 TR

o WURZAL S IPARTEHE SSB JERAEs A AT BB A RIS 4702

DSB Wl & - ANHERR UE R T 5K, BRI AT BRI T T VBB . i
DOBAPEREAE R T HEA 2 R ARG

X &

|:usb' I:Io

jZ3 71

NFA A LSB #iA USB A
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HEATH TSR E
MEFESH DUT

[ 4-9 SR UL FASL IS K QAR RE S0 AR A TF
S, AR

DSB 7 (00 755K 1 — A EBHES LO 505 F L 53 B s
PRI TF S0 (0024 A, TR, AR R AP 4B 4P BEiE.
PRy T SRR ENR. 3920 IR PO L 15 P 2 0 S 4
B SRR T T D0 B R 46 B0 45 S P47 O £ T L
e — LO Hi.

Kl 4-9 ok 5 P8 AAT I S AR e R A A, e AR R, Y
DUT ki&#ent, A48 b+ IF k) i .

WER ST S HHEWIA LA 2 W R T 7 AT ACTIRAS IR &G 2, X E
PR R e P KOP Dh A — £ (B 3 dB) . XAERHEE RS K
. IR AT LL8 ] Loss Compensation ¥ jii . #ii A\ -3 dB Before DUT
Value. Ji7 Before DUT Ik Fixed T LMEIE. DSB DM & 44
KA Hot (3O 1 Cold (V) MLl DUT # b p=Az f e
7. 1] H] Before Temperature il B2 {45 € 45 1% 406E . i 5 Cold
A (A 290 Kelvin) nf iz iEik—kid, NFA &44H 5 SSB i
] RETS S AR B IE S R

W IF S, sl Sk gefe A A s i 424, Wkt
Wik DUT #Egeske =i ENR TR [F, +F,,] SESEENAIRR, WA
& A d ] DSB &3 T &

HEAT DSB I, 000N O e I TR e 7 oK
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1% A

HATH RN E
MELH DUT

LO iR (FE#ADSB R

LO itk i g ny LUE R AE =T 3.5 GHz i i LO (7775 7 LA b 47
&7 3.0 GHz, LO iwitt29%5h NFA $nf A\, LAk, i NFA
IBUREAN AL, oIl A s RO 7 8. 5 T 3.0 GHz,  NFA )%
NIEP s =i LO {55 . x5 T LO kT2 3.5 GHz i) DSB 424
il A BRI A . DAUEFEEUE IR, A REAEINE ) IF S
Filnt . LO M E E b o 2028 LUK LO Jhititikob 22 10 NFA 4
ANRIEM i (10.0 MHz - 3 GHz) B K1

fERZ 4 DSB MASgE I, X RF ATLO Bk s, IF Bk
%, P pEas fr R A RE 2.

FUA R L D e A IR D8 3 245 7T REAE MR IR Sl 3 AR e A ittt o T
REA L ZAE ] — XM I B A B, A4 RFD . DUER R 2 By
FEAR T8 A A4 B A T DRk o

LO #&E (HE#ADSBFER)

IRZ WA LO WRAN SR dhox o B TR AAS ORI, X887 f 0

A HEAS B AL AN B M AR A A R R L KO . Oy TR SRIX IR DL, £

YA DUT Z (Al — A SRR s WERAS S IO ks, W Reie

TAEAZAL B — A I A5 .

BT EATRIE RS, B MR R . BRI T LA

J&:

1. e SRR MR A LO fif .

2. 5 LO B U i MR .

3. IR LO A b O b, IEFEAERE A DUT 2 [ JgCE 4>
Wik, RORAEA AU E L, BHIE LO . R R
J7s DR REL A g AN R BRI ], AV A AN ] 0 D 5% o
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HEATH TSR E
MEFESH DUT

4. %18 LO WiAyEl (FUER) , 2 Eikdeds, R~ NFARA, iz
7t 0-3.5 GHz Ju [l N A LO Jsithjaifs ?

5. LG UENGE, WA LI E A DUT M1 NFA 2 Jd].

NFA 7] PUAE d1 A g £ R b 2 DSB J A as Il & -

e DUT: Upconverter ( I“&4iids) 5 Downconverter ( [7AZ4i#s)
 LOMode CA#RIER): Fixed ([fz) ok Variable (n[7%) .

e Sideband (i47): DSB.
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K 4-10

HATH RN E
MELH DUT

5 IF
e IF #Crh,  NFA o) IF S w4, LO Sy, $ur

LN

@ IF &
A S
F 3
"%
231 A ngb'FIO
S LSB #iA
Flo
........ USB i
Fio-F
) s
‘4
A
21k >
Fi

K 4-10 Sos/EM ST I DSB A FEAR . Mg g IF.
WAt AR HE DUT S AR E e DUT B, oh
DSB B Lg%

WAL, AN RN EE,  SoRA TR m AR 1 LO i8R
o T BOEBONT 2.
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K 4-11

EEFN)

#®ik

FE )

HEATH TSR E
MEFESH DUT

e LO

5 LO B DUT S S AT FET, Pi R0 A I, JOF
S RFEAE . ARG TRR S 200 DUT, 30l i TF ki
RGOV RS (LR W 1 56

(1T LO MUK (A A, NFA MG TF S 1 4-11 67 i%
BB

e LO W&

-* Fio-Figp

TEE I

LSB#iA USB #iA

n
»

Flo e
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1% A

AR

HATH RN E
#4735 DUT &

#4725 DUT Jil&

FEZEEHEG T, NFA BABUE/E— MR, LO AT . TR Tl
il ArEdazEsl, HIF gaafiie LO M. sbhh, IRl
VBT B ARG N o AEBRER R TE R AR E D AR AT T
o

B ARG FEARHESR L, WA E % NFA ) RF S &R, AT
. DUT #0808 /M R NFA 2 ), #-A7 12 B & .

pify NFA 45 ) RF S A0 W4 — 3 3.0 GHz (RIEIE R &% . 1
ASHE A 5 o b R e A BRI, T BRI AR AT B o

75 N89T4A Fl N8IT5A RS, THBAMAN D WRATILIETfE. AEMRIIED
S IRHERIIN B BRI, il ZOR AT . AR T 3.0 GHz JFKIM
4 IF M, X—mh i,

B e IF fiarag LO #47 T34 DUT & (8970B #
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VIR BT I AR P
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LO Mode Variable

Meas Mode Form

LO Mode

Calibration Setup

Moise Source

Device Under Test
System Downconverter

AT RN E

#1755 DUT M E

Dawncony
,7
Yariable

| L0 Mode

Fixed

Variable

’—EI:I:D

Moise Source

Measurement Setup o.'.—Q_G_PIB

S 1. % Meas Mode 4. I/~ Meas Mode Form (& 4-13) . ¥%5Z Device Under
Test 33 #71% & Downconv (i%#¢ Downconv SZHLEE, S8 H o RIZSEReED)

2RI\ Device Under Test % & 25 Amplifier.

L RA

FEAN A A, 1S TC1E Tl System Downconverter 1.

BB 2. 1% Tab i, /%% LO Mode 1, 1% Variable S5, FAF4r LO W8 .

F4=E

155



K 4-14

ST 1.
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SE]S.
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1T DUT ME

EHFEARE
EARER
4 Agilent LO Control
LO Control On
Off
Mode Setup Form
On
IF Frequency | 1.00066000 GHz
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Sideband LSB
LO Control On

External LO Power Level | 10.868 dBm

Move the highlight to select a field using the 'Tab' keys.

1% Mode Setup . /8 Mode Setup Form ([&4-14).

R AV IF R, wE LO 24, FEORLs .
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FEZIEE T, RS S S a i N\ LSB.

% Tab £, W% % LO Control 3. ' LO #4i.

TEAZEHI, 42 BRI On SEH T .«

% Tab 4, "4 External LO Power Level 1%, %'E External LO H°F,

fEizdapI, A NN 10 dBm, IR H SR A B 4 iz AU
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AR A 163 ¢ Nl (e IF FimrAE LOY 7 ik i
LSB #2720 (H2, SRR MmENRE, Bk LSB K&, H1F
LSB #/%, #f Mode Setup Form ™', EFILW LD ) USB.

fECAEA DUT B, 5 dE as O AR S A\ v+ r 2. 50,
HEBESK E BN BRI AR T REME NG I, G RIS R DS
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Xl s 55 163 o0 ¢ Al E (e IF Fimf4 LO)Y 7 ik i)
LSB W& 2fl. (H2, SRR MEAE . #E LSB /7, 7t Mode
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XL B E S5 163 1 “ iyl (e IF frmf 48 LO) 7 Ffiis i
LSB &2 72l . G LSB f2/%, f1F Mode Setup Form ', EHILHT
TP DSB. 7f Meas Mode Form ™, # LO Mode ¥4 Fixed.
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NN ERCE S 153 iU ¢ il e (e IF fefAE LO) 7 R
LSB Wil &7l (R, st ftuipcie s . M5 LSB Fiy, 1
Mode Setup Form ', EHEAAFLELI K LSB. 7 Meas Mode Form ',
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Lg% IF fE e LOD

i RCE S A 153 5L ¢ N IiE ([ IF Fef A LODY 7 ik i)
LSB Wl Sl (Hd, st ftufpche®. M5 LSB Fy, 1
Mode Setup Form ', iEHELMFILEII K USB. & Meas Mode Form'[t,
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1 8970B #= 1.3)
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7f Meas Mode Form ', ¥ Device Under Test i} Upconv.
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AT ERCE S 163 0 ¢ Nl s (e IF A LOY 7 ik
LSB il s #2726 l. (He, BTt gtygyles . %95 LSB #/¥, 1
Mode Setup Form "', ZSZiliwrikIi i) LSB #ikFE. 7F Meas Mode
Form 1, ¥ LO Mode i Variable.
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LSB il &F2)7Jl. (He, st gtugpdies . %95 LSB #/¥, 1
Mode Setup Form "', EHHEIH ) USB. 1 Meas Mode Form ',
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JRG AR R o YDA W AU AL T REAT A HE A R P A
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1 AA

HEATH TSR E
HEITRETEMBNE

T2 IF fifE e LO (8970B = 1.2)

FEZRT, NFA A ASR AR, LO oy BE i . LO Sl
ARG BB AT NFA T TF 1R 4.

R LO A5z NFA g, 240K LO FISR{E%i N\ Mode Setup Form.

A TF AT, GRSk adiai il o DA 5 A0 Il = i TP e
FH ()35 AT DR o

A AT B HE 5 7T A8 LO Pl s AT (R HEAH [F], 75 20 DR DB
PRCEAE ] AT RS R B 1A

EERG

WA AR AGEARERIN 1S, ESHE 4-33. R WA —75 NFA 2
gy, LO mhf GPIB W%, W4 A3k LO Sk,

@k LO Joikidink GPIB N sl H e 454, 0T LU T30 77 R i f
PElE s M [ e E. H2E, WFE NFA f) Mode Setup Form " A%
1.
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HATH RN E
BHITRE T EMBNE

K 4-33 RYTFRIBREA
LO
iGap =
R E 25 ol
&ﬁ% ODDD [a]=]w=] §§§C\
n [V
O
AV AV
J
LO
NEHE : : ;._(:) ?‘E:|]3 ©O00000
&Eﬁ f\l m ° 000 000
DUT o % %
_/
TiawE (ara IF fiE e LO)
NI E E S DSB WS RTESRAL, WS 175 j XU
(e IF Aimf42 LOY 7, {H2, SRR tyEpE, Bk USB E1&.
G DSB #2/%, f{F Mode Setup Form ', HEFILTFIET A H LSB. 1F
Meas Mode Form ‘¥ LO Mode %4 Fixed.
1% RA ECHEAN DUT [l b, K08 i 2 F5CE 7E TR AT A N ity 17 A A Mg 7 Y o

Sty EE AR, REEEOR A R INRE E A B e A AR AT RERE N TSI, 3
JRG AR R o YIRS W AU LA P REAT A HE AU R P A
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HEATH TSR E
HEITRETEMBNE

Lg% IF fEE LOD

s R E S DSB MR RIS, WS 175 1« A Il
([E IF fmf42 LOY 7. (B2, BHERAEN RS, Bk LSB Eig.
& DSB #2/¥, 1F Mode Setup Form HiEFFA LI+ H USB. 7F Meas
Mode Form 4 LO Mode # % Fixed.

5t AR fECAEA DUT FIRET, 58 & 50 A1 TR AR Ay A\ i 110 A2 16 7 it
Sty EE . AT, RELEOR A IR A B e AR AR AT RERE N TS L, 3
SRR R o YIRS U AU LA T REA T A HE AN R A
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HATH RN E
R PR I

A R 1
h T DR AR AR B B X e R S B R, AR T IS TR
FR) R FRIL A o
FRFIARTER
#* 4-3 & MREIARE B .
®4-3 FHIARE
ik i
frp 5E IF
frLo il 2 LO 4%
fLo External LO #i%
fsir RGN
fSTART [y ey
fsTop 21Tk
IF K El DUT #ii%s% NFA 145
A
RF DUT St 4m A
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LRA

HEATH TSR E
53R PR

— f PR
ERBER T, B LR — AR
o [T Fprp 2 51 N A R 5 A7 RS A Fsrpoum

fSIF(MAX) E X, i, N8973A FH fSIF(MIN) =10 MHz #1 fSIF(MAX)
=3 GHz.

[l 52 LO % fpy, o BN 3 f1 4M% LO W BARRIE 5% £ o) B
fLoamax) & X, %ML System=External LO 3 i .

Ttk AFi% 2 RF &2 IF 5%, Frequency 3 1 H T N ix Lo
fH.

o X RAME IF B, SJuH fapan PRI fsTop - fsTART-
o XTTHAWAIF M, Hisiz fSPAN R R fSIF(MAX) - fSIF(MIN)°
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HATH RN E
R PR I

T2 DUT
R, DUT W& —AN FASUE . fiin, Aol

Fixed IF Variable LO ([ &35 4A#H)
PLUR & T A R
LSB R4 7 LSB 1, UL FBRHEH T Fixed IF Variable LO f%:

* fRRSTART) > fFIF

T RAZ IR BB FT B, 245 Mode setup error;Start freq must be
greater than fixed IF freq (BizUWEHIR; ALK T [H
SEHHID .

WA FRZEE ARDL, 90> fprp B8N fRPSTART)-
USB [B#l 7 USB ', LLRNR#EH T Fixed IF Variable LO £5xt:

* fLosTART) > fFIF

W RZ R BB FT B, 242 Mode setup error;Start LO freq must
be greater than fixed IF freq MBIzl BHIR; AU ARIRIUR L
ZR T[] 7 D o

AIEBRZ DRI, D fprp B8 N fRFSTART)-
DSB [B#l 7 DSB ', LLFR#LEH T Fixed IF Variable LO #i:t:

* fRFSTART) > fFIF

W HAZ R BT i, 24K Mode setup error;Start freq must be
greater than fixed IF freq BizQiEA 1% UG AIK T [H
TEAD

BOH IR ZRSORGL, /> Frrp BN fRE(START)-
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HEATH TSR E
53R PR

Variable IF Fixed LO (W25 H i@ & A3E)
PLR 238 T AR 2 PR il
LSB BR4#l 7 LSB ', DU TR#iEH T Variable IF Fixed LO #(:

* firsTop) < fRrsTOP)

WRZ IR BT B, S/2E% Mode setup error;Stop freq must be
less than stop RF freq (RzUBCEMNIR: £ MBH/N T2 L
LD

WA FRIZEE RO, 890 frro 50> fipgTop)-
USB BR#l 7 USB 1, PUNRRHEH T Variable IF Fixed LO i

* fir@sTop) < frLo

WRZ IR BB FT B, S/E% Mode setup error;Stop freq must be
less than fixed LO freq (B EH; LA NIUNT[H 2 A
P .

ARG BRZ DRI, 80 frpo 208 firgTOP)-
DSB BR#| 7t DSB ', LUFBELEH] T Variable IF Fixed LO .

* firsTop) < fRRSTOP)

WRAZ IR BB FT B, S2E% Mode setup error;Stop freq must be
less than stop RF freq OBEAWE R ZAbBERULAUVNT 2000
B o

BRI BRI RO, B0 fpr,o Bk fIF(STOP)°
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HATH RN E
R PR I

E2Z25 DUT
fEighith, DUT Wa—AN LA, fi, R,

Fixed IF Variable LO ([ &35 4A#H)
PLUR & T A R
LSB R4 7 LSB 1, UL FBRHEH T Fixed IF Variable LO f%:

* frRrsTOP) < fFIF

WRZ IR BB FT B, S/2E% Mode setup error;Stop freq must be
less than fixed IF freq (B EHID; ZAbAR NN T [H 2 4
B .

WA FRIZEE ARDL, B9 fprp 50> fRpsTOP)-
USB BR#l 7 USB 1, PAUNMRHEH T Fixed IF Variable LO £

* frrsTop) < fLosTOP)

WRAZ IR BB FT B, S/E% Mode setup error;Stop freq must be
less than stop LO freq (B EHR; ZILBERULIUVNTFZIEA
P

ARG BRZ DRI, 8N fprp 208> fRRsTOP)-
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HEATH TSR E
53R PR

Variable IF Fixed LO (W25 H i@ & A3E)
PLR 238 T AR 2 PR il
LSB BR4#l 7 LSB ', DU TR#iEH T Variable IF Fixed LO #(:

* firsTop) < frLo

WRZ IR BT B, S/2E% Mode setup error;Stop freq must be
less than fixed LO freq Bzl EHIG: ZbMUEE /N T [ e A

WA FRIZEE RO, 890 frro 50> fipgTop)-

* fIR©TART) > fRF(START)

IR IR BT, 24 Mode setup error;Start freq must be
greater than start RF freq (BIzUSEHIDE; LA LIUK T
LR .

AR IZE ORI, 90> frro S9N fIR(START)-
USB [®#l /£ USB ', LU RREIEH] T Variable IF Fixed LO #x(:

* firsTART) > fFLO

IR R BB FT Y, &4 Mode setup error;Start freq must be
greater than fixed LO freq (FBIzUWEHTIR; ELAMZ DU T [H

AIEBRR A DORDL, b frr,o BUE N fIF(START)°
* frrsTOP) < fFLO

R Z IR FT B, &% Mode setup error;Stop RF freq must
be less than fixed LO freq (BEzUiE AN, ZibSHMR AN
TIEARIA)

AR ERZEE DEIRDL, 18N frpo 508> fipTOP)-
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HATH RN E
R PR I

ARG TR

DUT &AM FAehihe &, Blunsodsoipg s, A NFA K
MEyEE (N 10 MHz 8007 3.0 GHz i95i%) o 7Ell & KRG h 2k
A, BIEH S DUT SMERITRMESRAN SR 5 A28 NFA B

Fixed IF Variable LO ([ &2 41%)
LAR i AR B

DSB Rl

72 DSB ft, PR HEH T Fixed IF Variable LO £t :

* fRRSTART) > fFIF

T RAZ IR BB FT B, 245 Mode setup error;Start freq must be
greater than fixed IF freq (BizUWEHIIR; ALK T [H
TEHAID o

WAHERIZEE ARDL, 90> fprp B8N fRPSTART)

LSB [B#i
£ LSB 1, DUNBRAIEH T E Fixed IF Variable LO 5.

* fRR(START) > fFIF

IR R BB FT Y, &4 Mode setup error;Start freq must be
greater than fixed IF freq (FBIzUWREHTIR; ELHZ DK T [H
EHHID .

WG FRZE AR, 9> fprp BN fRRSTART)
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HEATH TSR E
53R PR

USB R4l
£ USB 1, LA FBRHIEH T4 % Fixed IF Variable LO #i=:

fRF(START) > fFIF

I HAZ PRI AT 0, &4 iMode setup error; Start freq must be
greater than fixed IF freq (FExUWEHTRR; RGN T [H
SEHAID o

BB RS RO, b fFIF oA N fRF(START)°

Variable IF Fixed LO (AAz 4 & A $%)
PATR i ] T AR B

LSB R

7 LSB 1, LUFBE T Variable IF Fixed LO

frRrsTOP) < fFLO

WRAZ R BB FT B, S2E% Mode setup error;Stop freq must be
less than fixed LO freq (B EHIR; ZAbMRNIUVNT[H 2 A
PAED .

AAEBRZ BRI, 18N frpo 208> fRrsTOP)-

fRR(START) > fIF(START)

RZ IR BT BE, &4 Mode setup error;Start freq must be
greater than start IF freq izl @EAE1R; HIGHIFRAINA T
SRR

BRIG BRI AT RO, B> fpr,o B N fRF(START) o
frLo - fRF(sTOP) > fSIFOMIN)

WAZ RGBT, 2 1kMode setup error;LO - Stop freg must
be >= min system input freq (FEEH1R; LO - &L NI
>= RARRGMATIZR) .

AAE BRZ DRI, 18N frpo 208> fRrsTOP)-
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HATH RN E
R PR I

USB BR
7£ LSB v, LU W& H] T Variable IF Fixed LO £ix:

* fRrsTART) > fFLO

I HAZ PRI AT 0, &4 iMode setup error; Start freq must be
greater than fixed LO freq (FExUWEHTR; RAGHIZR LUK T [H
TEARPRANE)

BRI BRIZ B ORI, Rlzb fFLO i fRF(START)°
* firsTop) < frLo

W HAZ R HI BT i, 242 Mode setup error; Stop IF freq must
be less than fixed LO freq (FRzUEEATIR; ZibA iR BI)N
T E AR .

BRIG FRIZ DR, B8N fpr,o Bk fRF(STOP)°
* fRRSTART) - fFLO > fSIROMIN)

WHAZ BRI, /B Mode setup error; Start - LO freg
must be >= min system input freq (W EHIR; LI - AP
HIAI >= ALK G AINZ) .

WA FRIZE BRI, 0> fpro B8N fRRSTART)
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HEATH TSR E
5751 5% PR 1
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PAT RS BRAE

AERRUPTHAT RGZ MRS, B0, FoE M AR S ir i s GPIB s
fib 5 CTBCIR DL o
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WITRGIRIE
FEARRE

AEAFRE
AT PRI

w'E GPIB Hutik

PC B H3 47 3

i # External LO  (AMEAHR) HFE
P A T R

WoRETR . RGABEAEE S

T P FRH HT A

58 SCHIETT A/ TRBOIRA

IS NINES

acnpsE Yl

H NFA FCEFTERHL
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WITRGERIE
% & GPIB it

& GPIB #iii
GPIB #1LO GPIB NFA {£J5 i 4P GPIB Ef:as. — &I Beas M 5 e P 44
B PRIk FIVF OB R, 73— R — LO GPIB — i NFA J THsI5h AR

NFA #/EHAH>*1T LO GPIB L f¥#il88.

#iE GPIB bk

SB’ 1. 1% System .
S|, 2. 1% GPIB S,

G R#s T iR System GPIB Form (RGO MEL) . S
K 5-1.

& 5-1 A% GPIB %

| NFA Address

Noise Figure Analyzer Address 8
- HWFARAddress
8

System GPIB Form

Noise Figure Analyzer Address|S
External LO Address
LO GPIB Address

i

Mowve the highlight to select a field using the 'Tab' keys.

HAB 3. ] Tab M R4, WY 2RACE GPIB 24,
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MITRGARIE
%8 GPIB ftiit

%4t GPIB %t W W& 5-1.

% 5.1 %% GPIB 2%
¥ B B
Noise Figure Analyzer | {¢#%f] GPIB ikl .
s (IO s 0 % 30.
BRUEN 8.
External LO Address | 4 LO GPIB i&#: /) External LO ) GPIB i
AR LD bk,
A 0 % 30,
BRUEN 19,
LO GPIB Address 55 LO GPIB % #: 1% B id ik i bk 5 {0 2% 8
CRYRE O R g | .
i AL 0 % 30,
BRNE A 8.
15t RR 15 Remote Port  Ciztf&ui 1) SE Y 1% % Remote Port(GPIB) Cizf#

i GEARE PR D ) .
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WITRGERIE
EEEH{THA

Ao & & 4T3 M
NFA it B —AN 87 0, v e fe 2 S i
ARG FRAT 0 1«

SB, 1. % System i,

S|, 2. 1% Serial (HAT) S,

System Serial Form (RAHFITE) B, HSHKE 5-2.

& 5-2 REBRITR
| Baud
Baud 9600
| 1200
System Serial Form
2400
Data Terminal Ready OFF
Request To Send OFF 4800
Baud 9606 JEE
Receive Pacing KON/ HOFF 9600
Transmit Pacing KON/ HOFF
19200
38400
Move the highlight to select a field using the 'Tab' keys.

HAB 3. Tab H ERAR NS, R EORECE BT 250
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x5-2

WITRGIRIE
B EBTiRmO

ARG HAT I D S B LR 5-2.

BT OS5

2 BiEH

Data Terminal Ready | %% DTR £k

CRESRERIAD | L OFF i85 DTR, W4t i1
e ON 3#F DTR, K F 5475
 IBF i ngKahfe /7K DTR A T-4die 2

Request To Send WE RTS gl

GER&IED

o OFF HUW 3 #: RTS, BRI 24 H 473 1
e ON %## RTS, il jHH 475 0
o IBF#ZNUKENFE) 4 RTS H T4l e 0

Baud ()

BEE NFA S4T30 F SRR

i S AR AL B PR R 6 0 5 3 e T )
BHFRAILRC .

Receive Pacing
(EAoED)

BEEBMOE AR AT

LRA

¢« NONE ()

¢ XON/XOFF
Transmit Pacing BRI BAETA
CREEEH) . NONE

¢ XON/XOFF

%5 Remote Port 32 i 4 1% &y Remote Port(Serial) Cefiisi 1 (i
7)) . W%\ Remote Port(GPIB) Gz fifi Il Gl iR ) A8
5, NFA FEPAT IR, A Reflissh L.
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LRA

BT RGHRE
fic & External LO (4MEXIR) 4HE

it ®E External LO (JMEAIR) 44

NFA g% {f ] LO GPIB i 1 #5H14M% LO. External LO 5 i fovFfHC &
5h% LO T SIRFALE -

o fEHIMTRSHEIMBNAE R SCPL, HE NFA 5 4hE se Vi 4 LO g Al
A AMEH SCPI 154 1 E Hl 121741 o

o LO /MU KMAIE: 1SS 206 51 “ T mHE 7,
o LO fEfimtial: S Fe% 206 51 “ E ML E 7,
o EHREIDIIRS CRAD , B, ek (CW) sl flRa.

SE MRS PIIE R “HFEE” IR — 0 76k

SE e L5
AE S HEAVFIE IR %, ik I SCPT e LO et

SE TR A5 SR AT LAFE TSR A 20 de 2 A B H LA 745 1K) LO. X4y
GRREELEIE SR EE &

MR RTSARG S B S Bk NFA 2 LO e 440k, AFK LO
HAARF R PR SRR FEN R B R T 2 NFA (92
UL NFA $AF o s
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BITRGIRME
Bt & External LO (4MEXIR) 4HE

RS TSR A 280 H r 2 e LO b5 5 it SevrE I sE 2 -100
£ +100 dBm. SEFrfHfE 5 A2 2] LO M5 S oA R .

iR 0 H e e LO i iabzhae, #lana H RF %
(OUTP:STAT ON) »

WAFICR ., FCEAME LO MFRRHE, TR N AR
SB® 1. 1% System .
IR 2. i%+¢ External LO 2T
HSB| 3. &L LO Commands (AIRIES) ik,

2B /R— External 1O Commands (AMEATEIES) F.

& 5-3 IMEEAIRIES R
- Agilent Im
| ChangePrefix
External LO Commands
Clear Prefix

Power Prefix ‘POH

Power Suffix ‘ DEBM

Freq Prefix ‘FREQ

Freq Suffix ‘ HZ

Auxiliary ‘OUTP:STHT ol

Move the highlight to select a field using the 'Tab' keys.

it AR INESIR L P A BEHA D2k
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BT RS IRE
fic & External LO (4MEXIR) 4HE

HB 4. 1% Tab BRI Rt 2R P ER AL E .

AT AZE PR FLUSHE 2 AR 2 AT /AN 28 Sl T LU i B 3
Lo AR AR SRR — 27

& 5-4 4 LO #Bhg i
- Agilent IW
Command
External LO Commands
Clear

Pomer Prefix ‘POH Command

Power Suffix ‘ DEBM

Freq Prefix ‘FREQ

Freq Suffix ‘ HZ

Auxilliary ‘OUTP:STHT ol

Move the highlight to select a field using the 'Tab' keys.

* &% Clear Command GE[RIE4) SCH, HER4YiiRS. WEEMH
5-4, o Auxiliary HiiBh) &gk,

» %% Change Command (T f54) SgitE, < 7r Alpha Editor.
AR LL R B RV IR N TR 2 H, 1S K] 5-5. 1% Prev fHi A
Y. ISR TTAE LT IUATAF.
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BITRGIRME
i E External LO (SMEXIR) 4HE

& 5-5 A LO H#Bhs 4 Ei
- Agilent Im
Auxilliary OUTP:STAT ON
. | HBCDEFG»
External LO Commands
HIJKLHMHN»
Power Prefix ‘POH
OPQRSTU
Power Suffix ‘ DEBM
VHXY 2
Freq Prefix ‘FREQ
Freq Suffix ‘ HZ Balk
Spac%
Auxilliary ‘OUTP:STHT ol
More
Move the highlight to select a field using the 'Tab' keys. 1 of 3
E AL Bt (8]
SEL S ] H B2 R NFA 75 H A% 8l s HE 2 5 55 R 2 08 K i 1a],
PUESE LO i foe .

1 Settling Time CGEN7IN ) S gl R VERH NFA BB EN N A%
) 5E AL ZE O ms A1 100 s 2 08 BRilfiik 100 ms.

BARAN B AR
BAGAIBF A0 LO (e 20, UMb NFA HI T B 0 43
KRB AR,

% Min Freq (AR SRt avrfs ik i NFA i1y External LO Hf
ARSI . BhAEh 10 MHz.

% Max Freq ClmdiigR) St v s NFA W1y External LO B
e A% . BRAEA 40.0 GHz.
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MITRGIRIE
B B A EREAE

Ao & Py s T

LA BN AE R L, A REm IR NFA SAEROHERITE. P9 iiH
AR R N, S RpEkigtT, Dtk NFA AR 2 ] DA NFA e
PER) 4 T AER .

RE ST 1 e 5 5 B AR A 1A — A S AT N A AR I A5 5 ORI A 5 iR
Fo SRJE RN A S POYME AT UL, DUSEIRA H R0 (1 e 45 DA TUSUI
Jir B IE .

TCAHN IR .
FTHFRISC I R
SB’ 1. 1% System .
S 2. i Alignment 57 4, 77HL Alignment Z .,

HB 3. 1% Alignment S5, HEEOKIE S Alignment(On)  GR#E (FT7F) ) &5
Alignment(Off) CiuE (LMD ) .

BRINEE N Alignment(On).

B SRS
SB] 1. % System .
S}’ 2. % Alignment 32548, {7 Alignment 2.,

HE, 3. 1% Alignment Mode CURAERID) S, Ml £Kkik+% Alignment
Mode(Point) Cifi#fEf:, () ) ok Alignment Mode(Sweep) CifiyfEf:\,
(FHHD ) o

ZRMI B E 2 Alignment(Sweep).
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MITRGARIE
e & NER A A

YIG fgugsss (YIF) ik

AR YTF yi#EDh EALE H T- N89T4A F1 N8ITHA 75 .

SB 1. 1% System .
SB] 2. 1% Alignment 328, f7H Alignment 325,
HB 3. 1% Align YTF S2ip g, Wi YTF k.

SR, BOREBEXIGZE . IR A S R ANER 4 YTF
WHHEH .
$B 4. Sk Alignment % 358 .

HB, 5. 4 Save YTF Alignment ({77 YTF i) Zif, 7% Alignment 3
#is o
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SR 1.
P&’ 2.

ST’ 1.
SR 2.

SR’ 1.
P&’ 2.

MITRGIRIE
BREIR. REMNBHER

BRR. REMEHER

10 M EcHT R A AE R IR BAF b, T LURIZ BN D 4 B i (s o feoofT
TS I BLAERAS (M Ti o BREs H R A S«

¥% System. More 1 of 3 32 i,
1% Show Errors (I nilis) i, KissiRg).

BRI ALY R BE%E, 1% Clear Error Queue (GERRESREIAD) o

ERRGHER
TSR DL R S5 80 P ARERR . BN PR DSOS H (R T
% System. More 1 of 3 =2 Hifg,

1% Show System (I RRZ) KHE, KMARLE R,

EREAER

% System %71 More 1 of 3 34,

1% Show Hdwr  CB/niiff) S, Rl fr4s .
TR AR P AR ) A4 BRI BUAS 5
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ST’ 1.
SR’ 2.
P& 3.

WITRGIRIE
TRgBR IR E S AT

LRA

Tv e AR Bt

% Preset i, fif NFA #E AN —FCAURA, JNBAT R E R4 — 07
A AL AT LUHIAZ T System T J7 1) Preset S fL g s i Tl vCIR A
(IR NN ER IR &I IE

F1IF NFA, J77 21 On 8GR IS TT A F2 07 58

1% System . More 1 of 3. Power On/Preset. Preset (Factory) iz {14z,
L) Preset .

TR D AT — TAL BEAS I, A A2 S R AER s . 4% Preset i
Brim AR gzl s . RRIRATF TN 0.

FTTT I HTAXIAT B T o T TT 0 W G 2 B T AE R s 375 kA A A i
b dts IRRPIRES TR 0. 2 (f ] System 8 F 51D

Power On(Last) C(HLJETTE  (hojm) ) G, TGS a5
W&
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SR 1.
P&’ 2.
SR 3.

PR’ 1.
PR’ 2.
P&’ 3.

P&’ 1.
SR’ 2.
P& 3.
SR A4.
SR S5.

MITRGIRIE
EXRBRFE / RS

e CRIRITE / BeRES

HLYSUT A ATFBEIR A T ARG ER AN R] o ] AR HLYEOT 3 sl B 4 NFA
BEA R e SCIRZS

WEHBIEERES
% System %1 More 1 of 3 34,
1% Power On/Preset 3 L4

A5 2K K Power On 1y Power On(Last) 5 Power On(Preset) (i
A (5O ) .

“HRLJT B ML I AR O P (AR
T FOREIEIE S TR
WEMBCRE

A IE B BE NFA, A2 R [0 1) BRYCIRS S e SOIRE . ATl
il ¥ Save User Preset ({RA7H i) s fRA7 2407 NFA R 77k
AL E I P SO

AR TRBCRSBA LT BIAE

% System 1 More 1 of 3 =2 ifufi .

% Power On/Preset > L4t

J& i Preset(Factory) (i (L) D) SEHgE.

AR TR BRSO F P SORES

¥ NFA FCE 0 fmifpRas .

% System %1 More 1 of 3 S fi .,

% Power On/Preset 5 i .

J3 H Preset(User) (Tl (') ) SR,

1% Save User Preset i, {17457 NFA IR
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MITRGIRIE
hERERIAE

WERGERINE

KA NFA BB R T BN Bl S14MEEF ENR & BRGIZL . M
bk BRI AR ) R A A 2 o

A RGERA

SB 1. % System .

HB 2. 1% More 1 of 3 37,

3 I& 3. 1 Restore Sys Defaults (1kE ZZERIE) S,
T1 /X #% Restore Sys Defaults > U4

AR SRR, FOREHHZZE . 2R T RIS A S MK R T Bk
BEE.
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SR 1.
SR’ 2.
P& 3.
PR 4.

SR’ 1.
P&’ 2.
SR 3.
PR 4.

SE|S.
SR’ 6.

BT RGHRE
B EFN B A

T B I [R] A0 H 3

NFA S VPGS Wm0 F e a7 LURGE 22 sfoks H B4 56 [ o i
e

BRIT A0 5% P I ) 41 H 351

1% System .

% More 1 of 3 & i,

% Time/Date =% .5

¥4 Time/Date = Ak, M4l ZoRki% £ Time/Date(On) Ciffa] / HI (4T
FF) ) ok Time/Date(Off) C(i[H] / HI (MDD ) .

2RiNE 4 Time/Date(On).

AR E I R H 3
% System .

% More 1 of 3 & i,
% Time/Date 3¢ LA .

¥ Date Mode ( HI#E) e R EKA MDY (H H 4 sk
DMY (H H ).

5 A% O BRI A
A hhmmss PN 4380 78D = AT ] .
M yyyymmdd (48 H HD #&=U A H .

$FHE 213



FTEDHLZEK

FTEDHL SR

SR 1.
P&’ 2.

SR 3.

MITRGARIE
P NFA ECE+TEDHL

I NFA R E{TEIL

» IEEE 1284 Ht#54TEHIHLALSE

o MR IFATE IS SCRHTEINL. R SCRHTEINLEZ 52 3 4ak & AT EIpLEE
T = AT EIHL

— PCL3 #THINL B K Z % HP DeskdJet TEIHL.
— PCL5 4TEpHL 35 Kk 2 % HP Laserdet 4T EIHLA HP 1600C
Deskdet $TEIHL.
BGFTEINLS NFA %3, i IEEE 1284 345474 EPHLH 4% T BNl
RS NFA 3T /O G\ / B R 084S,

WA, FCEAITEIHL A RECE AT ENHLI PR, , 152 BT ETHLIE I ST
) .

F NFA B E3TEIHL

FT7F NFA FI4TEPHLHLYE

% Print Setup CfTEI#&E) $#, SRJ51% Printer Type FTEINLRAL) S
i,

% Printer Type 771} Printer Type > .5, % Auto (H3)) fff NFA 2%k
BUREERE AT EIHL.

1L $E Auto 1104 Printer Type I,  NFA J M =Mk — N

o %75 Print Setup 3¢5, b Auto #kHE, WBonABIRAIT AR BR R
Ho KR NFA PUNERFTEINL, ToaEd— Pk E . KA
Printer Type 2 i i &% Ff Auto, 4 AT TR Print g1, NFA &
AR UATEINL. #% System. More 1 of 3. Show System, /it
FTEIHL.
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MITRGIRIE
A NFA ECETEDHL

7% Print Setup 351, Hih Custom CEHD BEWESE, I B s
BATH IR N2 Wi

Unknown printer, Define Custom to set up printer (3K

FOFTEDNL, X “Edl”, REFTEIHL)

No printer response, Define Custom to set up printer

(FHTEDHIRZE, RN “REf)”, REFTEIHL)

Invalid printer response, Define Custom to set up

printer (FREFTEMNE, EX “REH)”, IREBFTEML)

XK NFA Jovk AR AER ST EINL, 7% Printer Type S ik
T Custom. #% Print Setup (TEHL'E) . Define Custom (i 3¢
WD, R EARSTEINLRRE, T EppLE S (PCL3 8 PCL5) Fig
BITENRE ). 8 — B E X SURRE, (2 58 4T EDHURFIEAH ISR, 4T
ETHL B8 . % Custom 7 Printer Type = b (R FFIE £, 4
AT IR Print 81, NFA A& 2438 A sh il BE B0 EvbL.

7R Print Setup =25, 7 None (75) #E#ES, FHREHILE IR
AR

Unsupported printer, Printer Type set to None (f"&2x7
FOUFTEDAL, FTEMNLRENR N “F”)

XK NFA JUOIER T EINL, (BT EIHLAR NFA 8. H % None
7t Printer Type 3¢k £8, NFA SXHTATHTENFE AR N, 7k
BB R EIRESITH B8 Printer Type is None (fTEIHIZEALN
“I7) WE.

Printer Type 171~ 51§#:
None (%) None 2% 1I- NFA 25 AT EDHLR 4T ED . AT ERHLAR 5

NFA #&#, &g

Custom (E$1) Custom 4% A7H Define Custom (g SE ) S8

B, Define Custom 3¢ WL A4 F5 2 4T ENHLARE, 4
PCL U RHTENHLEERE T -

Auto (Azh Auto 7F Print ##4% 1 I 5% Printer Type #%1% 4 Auto I,

i NFA B3 U T ETpL.
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WITRGIRIE
P NFA BECETEDHL

MR IERH KT ENHLERAE

FTENHLR E SR, WRKIER ST DR URAE, J7:24% Print Setup. Print
(Screen) (4TEI (Bf%E) ) Al Print 8, FTEIA.

WUERSTENHLAE & L, FTEDHLRE Y, SHTE— 0 NFA SR8+ Bl
o GRATENHLARHESWIZE, Printer Timeout FTEINLERD HESH
UifE NFA B/r889 . Printer Timeout I HIE B /REEH, HETH
WLMERSies, BRE 2% ESC U 4T BN K o
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TSR NFA P8 0P S iR MRS o AT (8% e i
B, IF51 AR S L rp s RS Y (1S LB
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& 6-1

WLRA

AIERES %
MEASURE GRlIZ) #

MEASURE (Ji&) 4

NERBH

Frequency/

Auersaing’ | [

Ii ’ “ I

Frequency/Points (& / &)
2SS A A S U 2 0 1 R P S B S R 60 ] v 7 0 1S oS . 3 4k
EATHUE A, SOV T ORI B A0 30 A ST AR

HH AR MU A0 ] 0 0 0 258 A AR BAE Sl s s 1 R 7 ik v o 3K
P RIERE TN

BN, SR i iR € Hz. kHz. MHz 8t GHz #47,

D AAE I RIBG TAGES A S . I 85 2494 —4> 10 MHz (1
PR, AEAR LS ERRAE

« N8972A 1y L% 1.5 GHz.
« NB8973A 1y L% 3.0 GHz.
o NB8974A 1y L[N 6.7 GHz.
« NB8975A i) L[N 26.5 GHz.
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WLRA

LRA

BIERES %
MEASURE GlE) #

N89T4A F1 N89THA 745 iR A Fil e & ikt Sl 3.0 GHz JF
K, ARZITHFIFERESL 3 1 “3.0 GHz HLWITK 7.

fE42 4k External LO i, S BRI s dia g o A8 A PR A T 2240 )
LO &2 IF. A0XJ5imst—L i8], W25 115 o “ BATH 78 M

1= N

o

$R ¥ Frequency/Points 3 #.

| Frequency /I_pl FreqMode | Frequency  FreqList -} Freq List

Freq Hode;

Sreep |

Start Freqé_
18.0000000 MHz|

Stop Freq?j

Center Freqf
1.565090600 GHz|

Freq Span;ff
2.99000666 GHz!

Fixed Freq|
1. 56560666 GHZ%

More |

1of2;—|

Points

Sweep 11

Row Up Clear Table:f

List Full Span Row Down| Fill

Fixed Freq Listy— Page Up

Page Downé

Delete Rowg

More Hore'-é_ Horepé
20f2 lof2) 20f2
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Freq Mode
(REER)

Start Freq
GEEsRImE)

Stop Freq
(£21E35ED

Center Freq
(L EER)

Freq Span
REEED

Fixed Freq
(BIZEMZE)

AIERESE
MEASURE &> #

BRSNS AR R TR A PR . T AR A e ARSI
(L R TAZR

A A A A A

* Sweep (FIHifi) , MPITIEATA G AW B SO SO
o List (i), MR FAREUA .

o Fixed ([HE) , 7E[HEMARATIE.

A VIS B E I R AR . FERERS b, B NS AT R
Y Start Freq GEIGWIFR) #kP e, HLEE DR R rfdEd.

VIS BRI AR EIR . AEETER T, OB A L
¥ Stop Freq (Z1bMR) #akfe)n, BRI RAE R+

ZHE AV BE O, FEZ ORI AR A T B R R . Y
Center Freq CHuOii) #ik+)n, HEUE SR/ ot .

I ACVRI DO R QB B R [ MR G H . 2 Freq Span (Ji1E
FD #akdt)n, HBEERAEA Rt .

B SCVF A A [ IR P A AR . 24 Fixed Freq ([E 40
H) WOk FEIa, FBUEAR 2T AR 5t e i s R R E A 4k
{Ho
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Points (&)

L RA

Full Span (£3E)

Freq List (3fiZ#)

BIERES %
MEASURE GlE) #

AV BCEAE Sweep () B AR 2 () 8 S g DI AR
B RVFIRERK R 401 BRI 11, REHE B s a8 AR B o

R AE 401 a2 RS R BR o TR 5 55 22 1)
g /Ny e 5 10 KHz. B, 7iA3) 401 2, A5 Fl 4
KF 4 MHz.

ZER IR SO NFA 270l WoReiaceul. NFA 4R
PEANR L S T 5E o A7 SRR T 2L S5 (R Y [, TS 2 3 0T “ e A HE 40>
BrAXZhEE 7.

B SCVFIAF IR, LS\ i 4 A0 FL

WA SRV R AT T D0 A o R PR 401 /N4 H me miBE
BRERIRIB TR o BRI NN BRI B 347 i -

Row Up

(A LB—T ARV IE BRI — MR E S H, TR
e, fERP—km LS —1N45%H -

Row Down

(ATHB—T ARV IE BRI — MR E S B, TR
H, R —km S — 144 H

Page Up
(f) E#—70 ZBE ARV U LR B4 H .
Page Down

(A THB—ID VR U P AR B R A H
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AIERESE
MEASURE &> #

Add ) VRGN — B A H o R A% BN AR AR I A R
—MERGEAZ A A H R, SRR
Bl NS 2 71F SIE I /&2 S1ee S =KL O RTAZN UL T U R VA

{HHE,

Delete Row

(BT B NRPE R R BRI RATAH

Clear Table

GERR BTSRRI T & H . TR OZ S R
T —IRFOZ B, S HIR, BRI, 1t
— IR R — e s ThEe, LLDj & 4M% Clear Table
H, BRI

Fill (7 BT BRI F AR AR B 1) 1 A0 S 7 A

AL
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& 6-3

Averaging (Fi3)

L RA

BTERES%
MEASURE GRliZ) #

Averaging/Bandwidth (%1 / #3%)
T AT A T~ 28 R A o S B SR R
Averaging/Bandwidth P/ #%) 3AE

I Average Avg/Bwidth —p| Bandwidth

Averaging Averaging
0f o of o 100kHz
Averages Averages 200kHz

1 1
Average Mode 400kHz

Paint Sweep

Bandwidth
M 1MHz
2HHz
4MHz

N8972A 2 A HoAB A5 1 S B

ZHE SOV A AR D fe . 103 T, BCE Averaging(On) (13
(TP ) Thig. AZERFY), #E Averaging(Off) (CE¥) (i) ) T

&b
At o

WP R 1, PR L WS 5T B A8 AR R 1 4521
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Averages (Fg{E)

Average Mode
(D

LRR

Bandwidth (&%)

LRA

AIERESE
MEASURE &> #

BB E BN R . B 1R 999 Z I IEE . BRIMEY
1, FoRARPAT . & LU RPG & 3h & G BT - F (e, R B
By N NS A B A I, T 4% Enter 228l . IZAUEAE BN
A AT

B VIS IE RIS . AR AN ST EPIE S ) ] Average
Mode(Point) Ptz (£ ) Dk, ERNMSIH TP ME S EH
Average Mode(Sweep) CTfl (313 ) Thik. PR 2 5
Y, 1ES I 53 T “ IERTIIRL .

7£ N8T2A rhICiA il - S E D fiE

B SRV I BT e e N AR . A ORI R VLR, 15 S R
52 T,

* 100kHz
* 200kHz
* 400kHz
e 1MHz
e 2MHz
* 4MHz

75 N89T2A rh Ayl v b, e Wi AH BN BRIAE 4MHz.
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& 6-4

BIERES %
MEASURE GlE) #

Calibrate (&#E)

TZEEPAT P TR HE S W o RSV I AR AL, AN ] 2 Ak S 0 AN A O o 4%
mr, RUERH B IS8 R ARSI R T a = .

FHETT AR AT A5 P IR Calibrate 4. f—kIcH# G, 2B — 305 iE
HE, PRSP IRFEASUERE, TFaafeHE, B 1% Escape f i mivE .
FEAER R TR A B E R T8 IE S R, R R R R
TR

R o B A

Warning - calibration about to beginl

Press 'Calibrate’ to continue, or

'ESC" to abort
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Device Under Test
(HNES

System
Downconverter
(RET TR

LO Mode
(FKiRER)D

BTERE S %
MEASURE &> #

Meas Mode (fg#)

ZHAFH Meas Mode Form G , R AVFEILSE NFA JIl 4
o BEAT LU i PRI e 2RI LU [ 5 sl 42 LO - Cai& A

HI Tab S5 1 xR P HIITH o 49— DI H R s, SmT DL O #L
{Ho ZBMEAET ) R DML DD RE DX o

L PR A ) DUT R4,
e Amplifier (AXs%

* Downconv (T35

e Upconv (EZE5)

IZBERE N ARMIE L On (4TJF) b2 Off (KM o« 7L Device Under
Test ik 0 Amplifier GRUKEE) A BAE .

RS LO M2 Fixed ([H) &2 Variable (7]48)
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& 6-5 Meas Mode (JUE#R) KHE
DuT |Sys Downcony
Amplifier Off
Downcony On
Upcony

BIERES %
MEASURE (&) #

I L0 Mode

Fixed

Variable

E6E
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IF Frequency
(%)

LO Frequency
(FARITR)

Sideband Ga#)

LO Control
(EKHRIEHD

External LO Power
Level

(SMEFAREB T

AIERESE
MEASURE &> #

Mode Setup (R EE)

ZHEATH Mode Setup Form (B ERK) , %K AVFE K AT Meas
Mode G ERZL) BT k0 NFA MRS, o776 0% £ [ /2 R A
War. NFA X LO izl DUAFEAMAE AR LO 7.

M Tab B9 I W R AP I H o 24— I H 5 By, SmT DU SO EL
{H. IZHUMEAER T SR XML DX o .

AV E LO Mode (A4RSBT4 i B i 5 TF A5k,
0 RV LO Mode AR i ¥Eh [R5t i ¥ 5t LO #ik,

P SOV RAE e AR S feVF AR R i e O A LSBL Eid
17 USB B4 DSB.

A RV BCE SME LO 27552 NFA 19454 (LO Control(On)) , & /2L
T30 % LO (LO Control(Off)) . Q& f# /[ & LO, #alLUHT
TN E LO ;. B, #4%{E LO Frequency (A#RHA) A LO
(AR AR

I AVFEBEE AME LO Hif-. HAA7E NFA () LO #4130 LO
Control(On) CA¥RAEd (TT1) ) WA R IZThAE. SBMAKE, BT
LUH RPG iRz 2 A 0 8fe, sl 8/ i A\ s AT
bV CIERE TN IR R VA L 1R 22 ST RS G
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BTERES%
MEASURE GRliZ) #

K 6-6 B ErERER
= Agilent | Sideband
Sideband DSB
- LSB
Mode Setup Form
IF Frequency [ 36.0060960 MHz usB
LO Frequency | =
Sideband DSB DSB
LO Control Off

External LO Power Level | 0.0008 dBm

Move the highlight to select a field using the 'Tab' keys.
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AR RS

%

MEASURE &> #

ENR (&mgtt)

A7 S0 o VS PR B
WL S E —AMBORE Thop W3 FIFERE—AMEORER ENR (8.

N ENR %, 82— Teola

K 6-7 EMR 33K
| ENR .>| ENR Table J.| Edit Table  ~|  Spot ~  Tcold > SNS Setup
ENR Mode : Spot Mode SNS Tcold Preference
Table S Eclit Tabley Rowlp | g Thot| | off o | Normal SNS
Common Table ; Spot ENR User Tcold Auto Load ENR
05 o Serial Number» Row Down 15200 dB 0ff On 0ff O
ENR Table 1Dy Page Up Spot Thot Sere
Fill Table User Tcold
Cal Table» From SNS Page Down. From SNS
Spot
15.208 dB Add
Tcold
Default” Delete Row:
SNS Setup» Clear Table
ENR Mode %57 ENR Mode(Table) CHM:LLEIA (344D ) FI ENR Mode(Spot)
(BB LEAER) GEEmg et (R D) B2 4. BRA{E 4 ENR Mode(Table).

Common Table

(AR

4 ENR Mode(Spot) #)ri i, ENR F¥ul ¢ 2%, 1#Hh Spot ENR
(HChiABEEL) B Spot Thot (ki #WEIE) 558 BN BMH -

%8t Common Table(On) (I:H]% (477F) ) I Common Table(Off)
GEHZER D ) B2 4. BRA{E % Common Table(On).

*y Common Table(On) #4 i HI S, 76 5 FIAS ek it 4l FH A () ) g s s
ENR #i#z. 24 Common Table(Off) #)5 HII, B & R AERL R P4 A
I (e A ENR % .
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BIERES %
MEASURE GlE) #

ENR Table (8RR X5 AVFRHA. Eoaik s ENR &P R

b &)

Edit Table
(mEER)

e Row Up
(BLEB—1T

¢ Row Down
(AT

e Page Up
(ELEB—TD

* Page Down
(A TFHB—5D

e Add G#m

¢ Delete Row
(BRET

¢ Clear Table
GERBR®

Serial Number
(F8

B AV A S / ENR Xf ENR %, ENR
EMNZRWH. WS 28 7T “ AhBRE 7.

ZHE VPRI R PRI R A H . KIS,
ek — ki LS 17,

AV FER P I e A H, RIS,
AR — R R BT,

VISR ] BB E R R H

VR I P AR B R A H

VPSP H o RI%A BN R R
P, IFAEIZAT 8 BN E A N BRI HES1 %
#Ho

ki ENR A H, AR R frsE. g nTil
/1] Enter $20101%5<H , %4 HIEGAEY B
(A

MRS ER IS BRI AT 4 H .

SRR TR 4 H . BN RS
TS — RPN, S IR, BRI PR %
Me— P B — P A ThRE, ARG S R A%

Clear Table #, #EFREEE.

i AVFEMA S ENR RN SRS AL
8, f#H2/R1) Alpha Editor FIEC7 MR . AL
N, i Prev . IZHUEAET WS X RIPLH hREX

BN,
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Meas Table
g

Cal Table
(RHEFR

L RA

& 6-8

BTERE S %
MEASURE &> #

A VA S ENR RASCHE S A S . A AL
i, M~ Alpha Editor Fc7 /Nt . Ak5¢ G
N, 1% Prev 8. ZEUETE S R X FIELH D e X v &k

TNo

Fill Table From SNS

(M SNS xR % AVFEMN SNS B2 L4 ENR #£F 8. iZ32 e

A1 SNS &R A ReA . R L4 1% % Auto Load
ENR(On) (HZhEAN@BELL (]TFH) ), ZFEfRES

PR,

RV . e Al ENR &b i 8 .

ID (K#)

VRN . Sk A ENR &b i 8 .

— ENR £&mZ 144 81 M4 H.

BRREKEXAERAT ENR &

= Agilent | Edit Table
ENR Value 15.400 dB

Row Up

ENR Table
Frequency ENR Value Row Down
. . 10.0000000 MHz | 15.330 dB
Noise Source Serial Number 100000000 MH= | | 15.560 dB
[3318A14197 1.00000000 GHz | 15.360 dB Page Up
2.00000000 GHz | 15.120 dB
3.00000000 GHz | 14.970 dB
4.00000000 GHz | 14.910 dB
S.00000000 GHz | 14.850 dB
£.00000000 GHz | 14.900 dB ———
700000000 GHz | 14.860 dB Add
2.00000000 GHz | 14.890 dB
9.00000000 GHz | 15.010 dB
10.0000000 GHz | 15.110 dB

Noise Source Model ID

346B

Page Down

11.0000000 GHz | 15.260 dB Delete Row
12.0000000 GHz | 15.400 dB
13.0000000 GHz | 15.440 dB

Clear Table

Use 'File' key to Load or Save a table.
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Spot (HH)

LRA

AR

BTERES%
MEASURE GRliZ) #

ZHEAVHEIE R A AN ENR (88 Ty CGRIEFE {H. FriEEaesEm
D ok R P N T3NSR . 2203 ) ENR Mode(Spot) G LE AR
(HTKD) ) A REIZ1T. BRIAE/E Spot ENR(15.200 dB) (iR L
(15.200 dB) .

Spot Mode

(HeRIER) Z%4{r Spot Mode(ENR) (HURit GEEMEEL) ) 1
Spot Mode(Thot) CHUkiFEA (R O B 4%
. BRINE N Spot Mode(ENR).

Spot ENR

(BihI#BMR L) ZEE ARV Mo ENR A, iZ50E 2R fE R &
AR N T AR E . Y Spot Mode(ENR) Fil
ENR Mode(Spot) #f 3 H 5, &EUE#E N . BOIAE N
15.200 dB.

M N ENR (H, P ifr e a8 B izl
fEi.

dB [ TR -7.0 dB, LR 50.0 dB.
K. C 1 F[RFIMN dB BRI mkK .

Spot Thot

(RCRIAR ) ZHE SRV — AR Top 18, ZE A AR
AR R T REANE T E . Y Spot Mode(Thot) Fi
ENR Mode(Spot) # )i /)5, 28BN H . BRAEHR
9892.80 K.

FHACT NN T (8, 1P 007 30 00 B 1 %K

K BRI TS 0.00 K, R A 29000290.0 K.
C Al F BRI K PR 4E 4k
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Tcold CG4EE)

AIERESE
MEASURE &> #

ok T FH T AR Togrg P A H Togrg PIRERT, BRIN Tegrq 1H
296.50 K #lifi ], eyl it 4 Teold(Default) (AIEE CERIAED D .

* Teold(User) (ARE (D) #eR B, ME &% A User Value
CHAED , sk SNS C4i#:, WIfEH User Tcold From SNS (K
H SNS [ AR (. 4 Teold(Auto) (R (AZ ) B H
B, WM SNS FREGIR BEAE, e AN 2 5 2 8 . X st
SNS Dhfieffi Fl A% SNS HEAE ks . NFA fighy bz, IRl
FF U ) Tegrq 1H-

SNS Tcold

(SNS MiBE) % A VFE B M SNS PSR B 38 L Togg .
EEAE R G 8. 1ZIhRE A7 SNS C& ik
B A BE S .
21 SNS Tcold(On) (SNS Wi (FTHF) ) #ikF)a,
NFA Mt SNS L3 Togpq (. HAh, 4
SNS Tcold(On) # ik £, HAth Teold = fL 88 WGk Al
H. 4ERiA SNS Tcold(Off) (SNS AW LD )
WG, A& ASPIT Tegq L#K-

User Tcold

(RAPR%EE % ARV Togg (. 4 User Teold(On) (HI /¥
W 19 ) Mok$es, WIMEH{E User Value ik
HI%ef . 4 User Teold(Off) (/AR (i) )
wHEE, NFAFHEA 296.50 K 1.

User Value

(ARE iz ARVFIE LT 7 N Tegrg 18, 30 @ik SNS ¢
23592, 1% User Tcold From SNS, i%%{i U A 5
SNS Pk Lk L3k, HF57E User Teold(On) 4% )
Mg, ZBEAE 8. HEFDNES DT 77 U —A
B, HERISERE sy — 2 a8l

User Tcold From SNS

(3RE SNS WA FRERE) iz A Vr M SNS WEGR ALK 3k Teog
fli. HA57F User Teold(On) #i /e Fl o, %54 A%
ZIRE G SNS UL A e A o
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SNS Setup
(SNS &8>

AR

BTERES%
MEASURE GRliZ) #

R SO VF R PR AR T e AR A . A, I REEAEAE ] SNS, W< At
VPR B33 SNS (1 ENR ff.

Preference
(EIETR)

Auto Load ENR
(B FhENBEEL)

1%+ Preference(Normal) (sl C(IE%) ) W4 ff
+28V NOISE SOURCE OUTPUT PORT (+28 fk
M S I 1), E$% Preference(SNS) (4 1E
(SNS) ) W&fEH SNS PORT (SNS i), 412
SNS Ui, AT LLK SNS Fl +28V K5 1 Mk i i
[Fi 5 NFA %8, HE, NFA K +28V 55—k A
REOKBh— AN . DRI, A8 T Bk B W — A g
Po BRI Preference(SNS), A A iX & 485 48 I ik
e fHJE, Wik SNS Ki%EH:, NFA WA +28V
NOISE SOURCE OUTPUT PORT, Biffik$T
Preference(SNS) 7Rt .

1£#% Auto Load ENR(On) (Hai# N ($TFF) )
i SNS H2) 12 ENR &, J#%#i5 Common
ENR Table (Gt#EmELLER) #¢. 4 NFA 5 ITF
Jaul SNS Ci%Hefr SNS i [ LI 25 B EL A S B . ik
% Auto Load ENR(Off) ( FIzh# NiEEL: (561D ) 4
A A sh# N SNS #di .

2 SN'S 014 %4 )t . Auto Load ENR(On) )i I,
Common Table(On) CLHFR (4T7F) ) #AZ®E. Fik, SNS ENR
sk AN JLH ENR .
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& 6-9

Autoscale
(BBHER)

LRA

BIER S %
DISPLAY (&) ##

DISPLAY (B7) &

Display (E7) @#4

I

W DisPLAY NS

Scale (FzR)

AV R DU IS5 AR A AR SRl AT A s
AR (R FRRNOGE T B R

AR D00 5 R TR S LA PR 5875 A b RS S R T T A B
R WESHE 6-10, ZE LN IES Hobs RO .

P T R A AT AN 22 M e (9 27 D5, AN g Ml R Fy i L
RSB IR, S a SR A ) fe AL

Autoscale NEhREEAFfEHILE, PR LR B i .
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BTERES%
DISPLAY (&) ##

& 6-10 Scale (7R g
| Noise Figure Gain | Y-Factor | Teffective PHot PCold
Autoscale Autoscale Autoscale Autoscale Autoscale Autoscale
Units Units Units Units Units Units
dB Linearl dB Linear| dB Linear K C Fl dB Linear] dB Linear
Upper Limit Upper Limit Upper Limit Upper Limit Upper Limit Upper Limit
9.068 46,680 16.668 2808, kK 16,068 16.688
Lower Limit Lower Limit Lower Limit Lower Limit Lower Limit Lower Limit
-1.006 -16.660 0,668 B8.6 kK A.068 B.066
Ref Level Ref Level Ref Level Ref Level Ref Level Ref Level
4.068 15.6840 5660 1666.6 kK G.o6a 5.o6e
Display Ref Display Ref Display Ref Display Ref Display Ref Display Ref
Off On (n f On f Onl  Dff Onl  Off (n
Scale/Div Scale/Div Scale/Div Scale/Div Scale/Div Scale/Div
1.68@ 5.088 1.800 200.8 K 1.68@ 1.688

Units (#4D) O M T R B AL R TR RN R SR, TR 6-1

Ekﬂ—‘—\‘o
% 6-1 RSB Unit (A7) . Limit (fR#%])D 1 Scale/Div (3R / ZIE) K
i |
RSB Units. Limits 1 Scale/Div
Noise Figure dB gk tE
2O
Gain (35 dB B gt
Y Factor (Y &0 dB mkzk
Teffective K. C&F
CH R )
Phot (#4Th%) dB =&k
Pcold (A Ih#%) dB gt

=r
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Upper Limit
(EBRD

Lower Limit
CTBRD

Ref Level
(BEKE)

L RA

Display Ref
(RF=S%H)

Scale/Div
($rR / @E)

BIER S %
DISPLAY (&) ##

AR y B B vcE BRG] g MEAR UEA TRER AR R H L, S
6-11. thThe R/ LIS LRSS, BEE BRI/ S A RE
Z %

R y B R B RS AR A DR R B A H
ZK 6-11. b/ BZEES FRIBE, BE PRSI/ SEZE
EREZ %

ZHEAVFEIAS S KT E. ZE b RUEEH TR A& H, i
K 6-11. ff Display Ref(On) (WixZz% ($171)) #UsaHl, 3l
EBE ) — SR s . BRAANEUE, i By N .

Ref Level (Z%/KF) {H1XfEfE Upper Limit ( [fi) {f#F1 Lower Limit
CRRR) N E .

G AR VHIEAE e TR BoR iR S % K. B aRS %K, WE Display
Ref(On) (E5%% (J1JF)) . #KMS%/KF, ¥ % Display Ref(Off)
(W5 (RED ), WHEBAKRE.

A y B BB AR EER AT o B AR RUE A TR e & A 5%
H, 2K 6-11. Bz LRATN REEZ %, PO IX =N H A
G
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BIERES %
DISPLAY (&7 #

& 6-11 Scale Linear Termination (ArRZHEZ L) K

—

X1e9 (G)
x1leb (M)
xle3 (k)

X1
x1le-3 (m)
xle—S(H

®xle=-9(n)
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6-12

Format (#3%)

Combined
(#HE)

BIERES %
DISPLAY (&) ##

Format (#&=)

A P, PR BN R R e T AR TR . A A
VPG S Wl STpricz o

i Format (k50 #kE N Graph (EJE) i, EATLAGHANKEDE, ¥
OB LRAT 2 5 RIEAF At A, LURR RS, BAh, wr LG P BT Tt Ay
e

Format (#3X) ¥4

Format

Format,
Graph

Combined
tf (n

Trace,
Data

Data ->
Memory

Graticule
0ff On

Annotation
0ff On

ZHEAE o KUE R f) Format(Graph) (B30 (ETE) ) FILLEKIER B
45 R ) Format(Table) (faU (GRA%) ) sl LUK fi gl JL sk o i
AN SE FLY Format(Meter) il Qe ) 2 [AEHES . BRIAGE
iy Graph (HJE) .

Combined(On) (A& (T ) #a MG, R0 Wos i BT B4
GH—ANRE SR, JEREDS EEA K. Combined(Off) (414 (¢
WD O MR RG, BEASAE, WHERIAKE.
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Trace (#hiE)

Data->Memory
(47 -> Fhiks8)

Graticule (H#)

Annotation
(€i:9:P)

BIERES %
DISPLAY (&7 #

Trace =t LA - #4544 1~ Data->Memory  CEiis -> 17788 ) St s A4

REAL H o
Trace(Data) (4 (Hdls) > #OA MG, 2 W Sarll s, oA
W

Trace(Memory) (it (fifif#8) ) #8 M5, 4 %Wor Data->Memory ¢
PSP T 5 S ORAT A A TR DU 0

Trace(Data&Memory) ik CEES54E ) #a MG, SER
Data->Memory ¢ L 4% N o S ORAF 2 A7 fift 45 PRI S BUZs 0 >4 il
2. DR SOV EL IR AT

% T Data->Memory % )5, URTHIS B AR 2 KA, HRE
FSIESH. KW NFA, Fpul. siffki% Data->Memory = g
T2 — 483k . {34 Data->Memory 5 o, Trace S8 n] LUAE
. Data->Memory >z Hu A5 78 58 A 414 Ja A4 REAEEH .

Graticule(On) U7k (FTTF) D) #A MG, SITIFEIE k. HONERINE
. Graticule(Off) (Jik CCHD D G, SCHEITEI k. Tk ME
e Bk,

Annotation(On) (#IkiE (F1IF) ) #a )G, S3TIFETE B b Hettd:,
SoRE. ONERIAE . Annotation(Off) (fitiE (e ) B MG, &
KA ETE R B ety , b N BR8P bR . (HIE, SRR AL R
B FER.
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LRA

LRA

6-13

BIERES %
DISPLAY (&) ##

Result (4%)

T VP TE C EBA EAE P b BRI S RS R XGEH T
N - -

REICTRALFRE P AN Z R O DU GRS B3 (1 B A 1 SRR Y
WITCHANANF] o

EﬂmﬁﬁmTéﬁufJﬂﬂﬂﬂJ% R R A aR S, A

Result (43%) Xeg

Result

Noise Figure
Gain
Y-Factor
Teffective
Phot

Pcold
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BIERES %
DISPLAY (&7 #

Noise Figure IR AR R M AR

(BRFEHRED

Gain (##) T B PEIE 25 A 25 R

15 AA T R A R U A RATRIERIE $E Corrected(On) (IBI1E (FTHF) ) &
VEL @

Y Factor IR PR Y REUE MRS R,

Y &¥D

Teffective T2 B IR PR AR A A D 2

(BHRE)

Phot (#IhZ) L FEFA T R A A A DN 4R
Pcold G&THE) iR D)Asm /R A I 4 2R
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& 6-14

| Marker | State —»l Search

BIER S %
DISPLAY (&) ##

Marker (Fri2)

AT RO R, X BRA RO AL SO, T TR SR b
e ARG R S AT AR ERF . 2 a[H WUAARL, XEhric ] PLoy
MAEARF R L, FEFRAE S RaS I, — R R d—Xhnid. #%
FIRRRICH A “BLH” FRid.

T I8 FbRe g R BoRERIE L. M DhRicghiasa, AR Bos
EOLHIhREX

Marker (HFid) EHE

Search Type

1 2 ngkeg Off § s ngke[1 in
Bansdtggﬁ’ Normal Search Tvr«?aex’ T
Ref Bantijg’r?ni; Delta MCOntinug%i o
Data agr?;:ri Band Pair Find
Searchy
Markers
All Off
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Marker (#7i2)

State CIRZ)

BIERES %
DISPLAY (&7 #

MPUFREAT e kR TR P RE—xF: Marker(1) (4ric (1)) - Marker(2) (b
it (2)) . Marker(3) (hric (3)) #1 Marker(4) (bric (4)) . KA —Fibrid
ATLASCA B bR, ST A R a GO ER) o BRAE—Fh bR id ik
REUHbRS, B EA A C T N2, fitn, Marker(1) 23 HFRIC, 3
BRI DhREX B

Off (XD

Normal (FE#)

Delta (&)

1235 TIPSV LN ROl DN S VA B 15 A WP il N 2] Y 2
I SR a R O ERARES

Kbl BCE AR A BB PGE b ihiad BLT C 4 o Jf
P, WIAEARIC LLATHAE PRI AL B8 bR id . ARid
SRR EITRRH

M RPG bRt fr & . HAEREAD DX o,
PR AN S HUEAE KT LTS

2 Delta (Z44) % Band Pair %) IhREw: o R,
¥ Normal C(IE%), KMHZHknid.

FEE— MARIC I B FEE 5 —AMsid . B Mg Uil
N FEhd, HALERE. SRR BUERTARE, FRid
BORFEETE A S, s ARSI UL C 2 BeE, W IR
i — MRS E . ) dRid SR EZE RS BT RoR, B
% prid LI5S A R &R (B, 1R .
M RPG J ZE bt A7

ZEAHARC MR EAE B DI REX b s o eAbh, BRI
AR L, FoRAMRE 2 M 2. £
Fhchr BERFFAE, HEZEEEEM.
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Band Pair
€ o p)

Trace (i)

WLRA

BIER S %
DISPLAY (&) ##

Band Pair

(D N VPSRRI AR R T 22
fEARCB, AFZ bR LR 5 E R AR i S %
Fric. 1% Band Pair(Ref) CGilixf (Z%)) M
Band Pair(Normal) Ciisxf CIE#H) ) SR, £S5
WAHER ARG Z WA . ZH bl 5 R — D —4
R&ER (B, 1R), EHARCH MRl TiE& R,
AR SR AL IR DR X T R . BeAh, AR
HEHUEEETE LI, FoRPIAbRid Z 8] i 2218 .

SR LR PR T State(Band Pair) CIRZA GRS A REAEH .
Band Pair(Ref) (Xt (%)) F1Band Pair(Normal) CGirxd (1IE%H) )
FIPHAE S Z AL IE AR 2 M. S2HE bl S8 H— AN ErfM—1 R
Fon (B, 1R, EFEFFCH - Mrid5iBER. H RPG A uriksEm
FrRid e o

ZK PAEAE Data->Memory % a4 Oy B S g . 88 F TR — Ml
TBCE AR B Pl A7 ik 25 50k . Trace(Data) (Hulk (Bidli) ) K—Akx
OB AN Fo BN E . Trace(Memory) (BUiZE  (fEfi %) )
BRI BCE ARG AR L

i, i R R 7R, Haz B o bR iC MBI B2 ik 2 A7
I o

UARBEAEARCHT TF I A A S U o, il il ok
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BIERES %
DISPLAY (&7 #

Search (##3)  IZCPRAVFEARCE DS, RS G LIRS bR id
To T RIBR T BEE KA,

Marker (#xi2) Marker > g R VR E SO AR IC . PEAIUEIHTE S50
245 71 “Marker (brid) 7.

Search Type

(1RFHED % Search Type S iy, mIERE— PRk Iik e, 1T
(EECR

Search Type(Min) (#8525 (&M ) #EH G,
I FRICH FBCE AR B R B/ i b

MFRICIRA ) Band Pair Gt I, ZBEGAEH
Search Type(Max) (#5388 (X)) #HEME,
IR BRI FBCE AR B e K e b

Mkridk A Band Pair 1, 281G .

Search Type(Pk-Pk) (#5257 (g6 ) # )0 H
Jeis PR AR C TBCE A S s A R 2 (). 5%
FRic i e e W, IE AR IR A B (A . LA
A S HUEE R FJrkes . RRPAMRId 2 A 2%
R

24 A EFRCINGS ) Band Pair 1A g1 .
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BIER S %
DISPLAY (&) ##

Continuous

(8D Continuous(On) (£f4: ($T7F) ) )G, AR
TEPE ERPEL AR R /D Ellg R0, AR R R
EE R X TPrik 4452874 . Continuous(Off)
(Frgl MDD #a M, dnid Find (A3 S b
5461

AR WS R T, A S E T, Fond /MR KhRId. it “v7 A
/RIE, A7 hERERIE . WA TE I KB, SRR R AR R K
e,

Find (Z#) PATF-8)) 77 3% Find S8 ics — NI AR . Z%bn
107E Continuous(Off) %% 3 H1JG T iR 2. #bid Borsiig
A B HZEA. IEAh, 7E Find BiXrh, brid AR
EILH hREX T R o

Markers All Off S ITE ARG, ARSR IO,
(FrB R XED
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BIERES %
CONTROL (=% #

CONTROL (=) 4

& 6-15 Control (4] BEAH

Loss Comp (#H#E4M2)

I I VR EAMEBUR I T A AU VF NFA (MEBUERIDIRE, 1
., T iR, DUT ZRiH / 8z il . 2400 T LUZ 30
Y AR AR [ R R R R, B A T v 81 S (1 B H R £ B A Vs

AR
6-16 Loss Compensation (i#EhE) g8z
| Loss Comp —>| Before Comp
Setupr Off
Before DUT .
Table’ Fixed
After DUT
Table" velale
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BTERE S %
CONTROL Gz #

Setup Gg&H) ZHA7H Loss Compensation Setup (MFEAMEKE) .

& 6-17 MAEAMERER
= Agilent Before Comp
Before DUT Off
| Off
Loss Compensation Setup
Fixed
Before DUT Off
Before DUT Fixed Value Table
Before Temperature .88 K -
After DUT 0ff

After DUT Fixed Value
After Temperature 0,08 K

Move the highlight to select a fizld using the 'Tab' keys.

HH Tab 858 WoRRP I H . D00 H B9 WoR g, FLEUE B30% 20 [R] it 7E
SRR R, SRVRRETE O H PR EEUE .
Before DUT
(WMEEZED BB S 2 BT, BTk
o Off (XCHD, LI CHEMEEE 2 A, BRUCIRES A
Off.

e Fixed ([#E), ItEf i Before DUT Fixed Value
(CHEMBEE 2 mriE e {d) FM.

e Table (£#%), It Before DUT Table il
WEZR) FIEERAEH .
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BIERES %
CONTROL (=% #

Before DUT Fixed Value
(FMHEZATEEME) ZHEAERNIEE LA aME e M B e E. 125

{5 45 7¢ Before DUT(Fixed) (#{l%seE 2 ar (&) )
Wela G A AR BT LK BUEE A dB skt 2 i
No fHIE, PEEEp LR dB. TN

-100.000 dB, BE>5 100.000 dB. ERiAE N

0.000 dB.

Before Temperature

(ZRLRED

After DUT
(HNEREZR

AR R AR BB AN B A A e (B 1%
{177t Before DUT (I & 2 i) #d HJa A1
e BPTLLREEAE S K. CELF 4. &, CHIF{H
WA Ko TR 0.00K, LR 29,650,000.0K.
ERAE A 0.00K.

PRI B e AN . BT B
o Off CRHD , BUINTCHIGE 2 Jathes. BRURE A
Off.

e Fixed ([f5%E), LI/ After DUT Fixed Value
(BB 2 S e ) #ME.

e Table (F#%), LK After DUT Table C(H&ili%k
BZAR) PRBUEAE .

After DUT Fixed Value
(BENEBZEEEME ZHANIEE 2 o eMEE N e R E. %5

fH A 1E After DUT(On) (RS2 )5 (FTFF) ) #Ea
HIEA G Bl LLRZEiE R dB sl 3 fiimA .
{02, ZePEEUE M dB. PREIFIERAMES

Before DUT #H[f].

After Temperature

(ZRRED

VB M2 2 S R AR E A B A O ] o BB e
ZHUE R 7E After DUT(On) #5 JHJG A G % BT LUK
BUEE N K. CHLF fA. {HiE, CFlFEEHE#H N Ko
PR I FI 2R (i 5 Before DUT A 7] .

251



Before BUT
Table

(HWNREZHIFR)

& 6-18

BTERE S %
CONTROL Gz #

ZHA7H Loss Compensation Before DUT Table (Hill: & 2 i

BAEAMERD) ©

RSV SR / BUERCHAER, BUBEMNZE AT TSR 28

T REPEARAMS 7 B HIBE

Loss Compensation Before DUT Table (##li% & 2 ai#iiFEsh

(=9

i Agilent

Loss Frequency ———-

Loss Compensation Before DUT Table

Loss Frequency Loss Yalue

Use ‘File' key to Load or Save a table.

| Before Table

Row Up

Row Down

Page Up

Page Down

Add

Delete Row

Clear Table

M Tab B9 WA R T H o I0H M Woc)a, RN e g rh
7y SUVFRS SO H RS s A

Row Up

(Ea LB —T ZH AR P R AT, xR, BYE
xKrh—m LB —A%H.

Row Down

B AVFEIE R P IS e AT, iz l)s, B4
R — KA TN H, HEBRZAITIME.

(BT

Page Up

([ L#—730 VR ] BB R A H
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After DUT Table
(HNEEZRFR

L RA

Page Down
(B THB—TD

Add (g

Delete Row
(BT

Clear Table
G

BIERES %
CONTROL (=% #

ARV T P RSB RAS A H

B AVFIEI I — B4 H o FiZ 40 BRI 2380
IFAE 2% H 28 1 E IR 22 18 (1 S BT P HES %4 H

REEZBEAH, SRR AL, B8R LM H
Enter 2 1L 0UFE(E, AU BOAE ) dB A1 .

R P RS BRI AT AR

Al
m

SRR T 4 H o TS P IRA% S B

TSR — IR B, S IR, BRI PR %8t . b
— IR R — e s ThEe, LAY & 4M% Clear Table
B, BEERREE .

ZH 7 Loss Compensation After DUT Table (#ill3:E )5

PUBAMELD ©

VI AR/ SRR, BUREMZR AT . 555 28
b PRFAs 7 5 262 11 “Before BUT Table (#lI%E 2 /%) 7 F 7

MR

PUEAMER R T 201 MR H
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& 6-19

Limit Line
(PR#IZ)

Type (3H)

AIERESE
CONTROL Gz #

Limit Lines ([R#I2)

PRI LR U g SRR . IEA PUMBSI I BRI, 554 1 2 4, BRAIZ 1

25 BRI, REIL 3 A4 5T EASE. BRIIZ AT LU i E o fE A O
TR G P — 2R BRI I [y S A T 0 o PRI T AR D ERR R FR
Tl 3 ] AAEA SR BT A 2o

g Limit Line (fR#$14%) X3 E

| Limit Lines
Limit Line

1+ 24 38 4
Type
Lover Upper
Test
Off On|
Editor»
Display
Off On|
Limit Lines
All Off

IEREVUFP AT BERI BRI 22—, Limit Line(11) A1 Limit Line(21) 5 L& $Li%
2%, Limit Line(3U) F1 Limit Line(4l) 5 T BB AHIC . Frik B il 2k 7 T &I
2, HAB PR B2 rmt B i Tz BRI .

%S PR TR BRI 2k %k Type(Upper) CGRA! (1)) = Type(Lower)
R CR) D o Wil Test(On) CGURK (FTFF) ) # e, AR Fus xof B il
LR HAT IR .
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Test Glli)

Editor
(4miBEER)

& 6-20

BTERES%
CONTROL G=#l) #

2 PR AE R AN BRI B 5 A SO B S e o 12 B PITUE BR TR 2k i
DRI . AR, E Test(Off) CIEK OCHD ) o WA KE
BRAIZe s, 45 AR HEE R 22 EAARS . BRAEHTINR, X Test(Off)
G CGRHD D o B BRARE .

AP Limit Line C(BRIZE) ZiiHAE)y, %98 So Vi A ol 4
Pk BREIZ . & 6-20 WoR Tixgniafey .

PRAIZAC PR 201 PR A RIZ ), BRIZR 5% H 42 /N B R A I
Fr BB R o BRI AL Pk BT ) AL

#H Table Entry (R#4%&H) XEERRELZRERET

- Agilent | Limit Editor

Row Up
Limit Line 1
Frequency Limit Connected Row Down
- o o Page Up
- - - Page Down
- - - Add
- - - Delete Row
Clear Table
Use 'File' key to Load or Save a table.
Frequency
€9 A E T 4% B AR .

BB AT 4% H PRI BRIt — Ao A o fe
XEEA R 5 Z AN 1 B T B

Limit CBR&ID

Connected

€39 HEH TR T AU A AR R T RS T A
WrFt. ¥z Yes, Uui s ST —A miE . Kk
BN No, 9|7 s W 5 37— A W T o
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Display (&7F)

Limit Lines All
Off

(RHIFABRHIZ

1% A

AIERESE
CONTROL Gz #

THZ I 28 BT AP, 7 BT ST U AR P R A B B

e Row Up
() EB—1T R ACVFE R T R e & H e i n,
e —kn s —A47,

e Row Down
(ATHB—T AV RER PR A H, SRS,
BAERP— X FBEI—1T.

e Page Up
(8 L#B—5D AR VFERE I R IR A H .

* Page Down
(B TH—TD S VFRRE T P AR B R A H

e Add Ui VPN —H A H o R BN R
P, IFAEIZAT 58 BURHZE A N B R 51 1%

%H.
e Delete Row
(BRET MR TPTE R BRI RATAH
¢ Clear Table
GER® ZEERERTRTE & H .. BRI OZ S R,

TS — IR PR, S IR, BRI PR % 4
Me— PR B —Fh e ThRE, ARG R A%
Clear Table ##, & E.

K RN BRI 2 ER )5 A O P SE S . 2GR SRR B T R B
WERRHIZE . AU PR HIZ W, W& Display(On) (4l (179D ) . Aksk
FHBRHIZ s, ¥ & Display(Off) (Wi (GCHD D, HEAERIAKE .

OGP AT BRAIZ R Ah AT 2 R -

MR HE, PREIZEER AL, WERBRGILTHITIT, AR
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BIERES %
CONTROL (=% #

Full Screen (£5)

ZEEARVFINE S O KRB EoREs, BERSCRaE. DU S DR ek
AL, ZETHTIrE R K. REFNE{. TR Full Screen
A5y BRPIET—AN 2o P HAL iR B 1 2%, B N HIBEZ A
Zoom (#ifil) - Next Window (F—/"% 1) . Save Trace (fR{FHL
7). Help (1) . Preset (¥iiik) . Print (4JH!) . Power Standby

(HEJENE) Ml Viewing Angle (#iLf) #.
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AIERESE
CONTROL @zl #

Corr (BIE)

ZEEAVFEITIT BB IEN R . BRUCIRZRHCR T LU 17 S22 BEAT R HE
AT DL AR HE IR A R 1) NFA SN S0k %, X ARV R kA7
F e s v K3 28 DUT.

& 6-21 N8972A and N8973A Corrected (IN8972A F1 N8973A C&IE)
K
Corrected Input Cal fl Min Atten | HMin Atten
Corrected Min RF Atten
off on 0 " 0dB 30dB
Input Cab, Max RF Rtten, 5dB 35dB
10dB 40dB
15dB
20dB
25dB
More | | More
1of2 2of2
Corrected ZEE VB B IERARE IE 45 R 2 )ik # .
(B T LLik#2 ] Corrected(On) (21 (477F) ) 5l Corrected(Off) ({ZiE
CRPD ) #HATIE . B AT 2 B B R HEE e, U35 2 Ao
i o

BATIME) S, SRR SR I N R Corr HEVE.
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BIERES %
CONTROL (=% #

it AR U AR BRI B S SO KT 2 i, NFA WSO Uncorr CR1E
IE) o WURGEAY AL B A BT B IR, WA T %R 2 AT E B
FHE NFA. QR GRS B SO N T 2 ireiE,  NFA WA B
Corr. XKW NFAEMHIAMGETIR, WRES ML IREHR

Input Cal T2 LB SOV IS AT AT T i R R /N SR D L T L o
GRIAKIE)
6-22 N8974A and N8975A Microwave Attenuator (INN8974A fn

N8975A M Emas) FKHE

| Corrected | Input Cal ->| Min pK Atten

Corrected Min RF Atten

0ff O 0 d8" 0dB
Max RF Atten

Input Calr 50 4B’ 15 dB
Min pW Atten

0 dp’ 30 dB

Max pH Atten,
B dB

F6E 259



WLRA

AIERESE

CONTROL {=H# 4

N8972A #1 N8973A M5 ¥4 Min UW Atten (/M k) Fl
Max UW Atten (i KTSBERD Sl . Tl g A N89T4A I

N89T5A 7! 5 rhfifit,
Min Atten
(BINFERD S AV ISR HE IS R B o RF S B /NN 3

Max Atten
€ ¥ -3

Min UW Atten
(R IMYR B

Max LW Atten
(RARBTORD

. RF Eyas s B/ o+ 3.0 GHz. nl4%hd
sy 5 dB 7745 0dB % 40dB 2 [T F. 2R
IAMEH 0dB.

2 P SOV AR HE R R T S o RIF S0l dee KA\ 52
k. RF ZEpas iR TE /D T 8055 T 3.0 GHz. w4
TGk 5 dB 1f17577:7F 0dB % 40dB Z [ Tik#E. BR
WME % 20dB.

T TP VR AR AR S OB 5% /N B A\
e BRI PR T 3.0 GHzo W] $2 BRI Ik
15 dB 17541 0dB %2 30dB Z [HIEATEHE. BRIME N
0dB.

1% WU PRV AR RV LR O OB S A de KN
Mo T EERAS AR KT 3.0 GHz. Al 4R AR R I
15 dB 1) /77:4F 0dB % 30dB 2 [i) 4Tk 8. BRIME N
0dB.
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Sweep Mode

(R0

6-23

Manual Meas

(FHHNE

L RA

BIERES %
CONTROL (=% #

Sweep (HF##)

o P T NFA RS, DYEREAT — kel =

, JiH Sweep Mode(Single) (FH#i#i (—¥%) ) .
, JiH Sweep Mode(Cont) (it (Frek) ), ik

AR BT — U
AR E R AL
HERINBEE

e

Sweep () XKHE (N89T4/5A B5)

I Sweep | Manual Meas —>I Manual Heas

Sweep Mode Manual State Point
Single Cont; Off On 1
Manual Meas» Accept Fixed RF@HC;%»
Calibration Fixed pH Att
0ff On 8 dB
Noise Source Fixed IF Att
0ff On 59 dB
RF /pH Att
Auto Hold Fixed
IF Att
Auto Hold Fixed
More More

10f2 20f2"

AV /EE Manual Measurement (Fahill &) e, %8 i
f54e N89T4/5A 5 FUTFah i Xkt REF wEdiay.  TF ZEukas At w ol
o B 112 7T FahillEfF .

T IRAF AT N89T4A 1 N8ITHA 5 gt it
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AR

AIERESE

CONTROL {=H# 4

7t N8972A FI N8IT3A T '5rh, RF/UW Att A/ Tlipe k) S gy
A RF At GO k2. tbh, WA Fixed UW Att ([l 2 i s

W) SR,

Manual State
(FFHRED)

Accept (3EZ)

Calibration
€:2:9)

Noise Source

ZHE o Manual Measurement Mode ( T3l &
D 3 A Manual State(On) (FaikAE (17D
4% /] Manual State(Off) (T-zhRA G )« BRIAIR
% Manual State(Off), Manual Measurement
Menu AL B AEH, REF s ok s jias
AT kA B B o1 o

MRRINA AW B B IO AT H T Tl 2R UERT,
FOzcoR g Nz, NFAAETF N Ea
eh A 4 i FE YR A

* Manual Meas(Off) (F-ahill&E MDD ) #ikFE,
P2 A

R VIR E NFA 2B AT AERIN . A+
Calibration(On) CfiE (FTFF) ), WJSSAE Pk i s i
TAcHE. %% Calibration(Off) (ICHE (SCH]) D, N

SEPTEE AT R . BRUCIRZS A Calibration(Off).

) Manual Meas(Off) # k85, ZE g AEH .

(BER TLHE AVFIEAT IFRIOC e R . 7 1B
Noise Source(On) (Mg (17D ), MISEFTIEMSR
KT Phot (A=) il&. #ik+¢
Noise Source(Off) (MY (OCH) ), NIk
MAAT Peold (A% M. BRIMVRER
Noise Source(Off).
>4 Manual Meas(Off) # L5, 1% A AA A .
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RF/UW Att

BIERES %
CONTROL (=% #

(B3R / RURFERD  IZBEWN] T 1) RF MIRBOCE e s . 164

IF Att
(Hh3RZRD

Point (&)

Fixed RF Att
(EIEHIATRD

RF/UW Att(Auto) CFHR / fisczEnmk CH3D D <A
RF FIfope ekt B2 BV . BRI . 1EFE
RF/UW Att(Hold) 5l / sl (PRI O e
i RF S se s, A PR Rk il . 164%

RF/UW Att(Fixed) st / Sk ([HED ) 238 FHAE
Fixed RF Att ([l ey {fak Fixed pW Att  (J¥
SE OB EO 5 48 E 1B .

T T IF Sl i B . 7EFE IF Att(Auto)
(PSR CAZ) ) &) IF Zikes A Evufbl. it
HERINE . P IF Att(Hold) Crhsiigsl (fR8) ) &{f
2 IF sEas B iR, AR . kP

IF Att(Fixed) (et ([E) ) £ )i H7E Fixed IF
At ([E gD e e A

T VIS 1A BT I S AR AT IR T
AR T R R

| Fixed Freq ([#E4i%) ok Manual Meas(Off) (F3))
W COCHD ) $OERG, ZE R E A .

ZEE VSR T RF 0@ i — AW e e, g T
82%F 3.0 GHz. 4 RF/UW Att(Fixed) 4 /i i %
K

¥ AR 5 dB K 77754E 0dB % 40dB 2 [Ajik T iE
. BIAEHN 0dB.
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AIERESE
CONTROL @zl #

417 Fixed UW Att (@ s aeid) XA N8974A FI N8ITHA A rhifit,

Fixed LW Att

(BIERUETER) %8 A VFRR A T st i — AN AR, P T
%+ 3.0 GHz. 4 RF/UW Att(Fixed) 54l / filik s
W CRED ) AE HIIN R T2
ARG 15 dB 117714 0dB % 30dB [ AT
P, BRME Y 0dB.

Fixed IF Att

(BIEPHFERD %8 ARV E DI i — DM EE . 2
IF Att(Fixed) Crfofiizeyk C[E) ) B HIE Y A %3
fH.

FVER) B R IRA 70 dB. BREh 59 dB.
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BIERES %
CONTROL (=% #

Restart (E#HE3)

EM AT IR P 4542 F Restart 8, SZbillsE, JFam—NHllE. Bk
FHBCE, BT PAT KR AT .

7 Manual Measurement Mode (F-#hillfEf) T1it4% Restart 21
WR T, B AT = k.

AR Restart 7)) i 1]+ 2 A HEH L.
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BIEWRES %
SYSTEM (%% #

SYSTEM (R%) 4

& 6-24 System (R%) BHA

Preset

System (Local) (R% (&#h))

ARG AL TR AU, SR [FIA AR

7 NFA #CE e i b 5, % System (Local), K NFA JiUE fEA M
B, JF i AT AR . R EE LR T, P IR AT A

R e AR, RS A T, nEk s, RRRR. VTSRS S
K. 4% System (Local) & k47 LA R £
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& 6-25

I System

Remote Port
Serial GPIB

GPIB’
NFA Address 8

Serial,
Baud 9660

External LO»

Alignment»

More

System(Local) (R4 (&) ) HHKE

—>| System

Show Errors
Show System

Show Hdwr

PowerOn/’
Preset

Restore Sys
Defaults

Time/Dater

More

BIERES %
SYSTEM (H%)

—>| System

Diagnosticsr

Servicer

More

lof3

Remote Port
GEREiwO)D

20f3

Port(GPIB) Gzfisill (GPIB)) .

AR

30f3

W AR AT R GPIB i B X 2 ) AT
#0] L $R ¢ ] Remote Port(Serial) Gzl (#147) ) =i Remote

NFA & ST ISR A RE A i 1 s 2k
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GPIB
(GEREORL
& 6-26

BTERE S %
SYSTEM (&%) #

GPIB X #fr il system GPIB Form (RGO RLER) . %8 LI
A NFA ¥ GPIB it LO GPIB A5Gt

BrREBENZRSZE GPIB %
| NFA Address

Noise Figure Analyzer Address 8

-— —  NFA Hddresg

System GPIB Form

Noise Figure Analyzer Address|S

External LO Address 13
LO GPIB Rddress 8

Move the highlight to select a field using the 'Tab' keys.

M Tab B WoR R RITH . 24— DI H R M BoR)a, 1250 H RN

B BoR,  SRVFIE O H e .

Noise FigureAnalyzer Address

(RERHSHOGEID) 2B E A GPIB thlil. A a0hikN 0 2 29. B
kR 8.

External LOAddress

OMEFfRIND  ZBE S LO GPIB &4 External LO GPIB #h
hke ARG 0 42 30, BRHihlh 19,

LO GPIB Address
(FIFEREORGH) ZEKE S LO GPIB #&# 13 E 5 NFA @il
bk, HROmHEN 0 2 30, ERAMHEA 8.
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Serial ($T)

6-27

BTERES%
SYSTEM (%% #

Serial Z A System Serial Form (REAEHITER) . 1ZEH RVHEAE

NFA {847 5 L AC

HI Tab S5 1 xR P HIITH o 24— NIUH BRI o )a, 1Z30H RN 7R
bR, SRVFRE SO H U

£’K Baud Rate (B4R XEEKNRAFTE

| Baud
Baud 9600

1200
System Serial Form
2400
Data Terminal Ready OFF
Request To Send OFF 4800
Baud 9606 JEE
Receive Pacing KON/ HOFF 9600
Transmit Pacing KON/ HOFF
19200
38400
Move the highlight to select a field using the 'Tab' keys.

Data Terminal Ready

(BRemEEME) XMW E DTRATE S AR H A7 0 1 I HUH SCHF
DTR, #% OFF, it hBRABCE . #RH H # AT o 1 FSCHF
DTR, #% ON. #i s, 16 DTR #alickidh &
&, ¥ IBF.

Request To Send

GEREIE iz CE RTS AT#sM. AR 473 H IF 0N SCFF
RTS, #Z OFF, M ABRINVE . AR H AT 5 H T SR
RTS, # ON. #rHgshfey, I RTS Bl &
&, ¥ IBF.

F6E 269



AIERESE

SYSTEM (&% #

Baud G4

Receive Pacing
(RWED)

Transmit Pacing

(REED)

BB E R R . R A OB R BUABREAE
9600.

« 1200

* 2400

* 4800

* 9600

+ 19200

38400

BV B RUE S AT TR . AR AR S, T
NONE (), WABAKE. #3H XON/XOFF 7
7, F& XON/XOFF.

B RIR AR AT . AR ROEE D, 1%
NONE, IHOuBRNBE . #AH XON/XOFF ¥1f, 1%
XON/XOFF.
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External LO
(OMEEXR)

& 6-28

BIERES %
SYSTEM (H%)

o U T E External LO MRBIAE . R4 LO S b s 1R
AN PR PR AR A2 External LO 4R s 2 S et Tl . NFA Jovk
sk PANUR S B G

External LO (4MEA$R) KHE

I External LO

Command Set
SCPI Custom

LO Commands»

Settling Time
100.8 ms

Min Freq
103800088 MHz

Max Freq
40.6800008 GHz

Command Set

(848 Zat v E External LO 84155, WHE
Command Set(SCPI) (F54-4E (nlgufE i asbrififia
20 W EeFE 493 SCPI #e% 1 LO. 4
External LO 5 SCPI g, #&E
Command Set(Custom) (544 CEHD ), HiAE
R4 1

LO Commands

(XKiRES) %P External 1O Commands (AMEAIRIES) .

R VI TEAE SCPI A i External LO
4. BSR4, 1 Alpha Editor Fi%y /M
j’_g_

o
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BTERE S %
SYSTEM (&%) #

1% AA A External LO 84, 7EArE ) FJa 800 Or B 00 vl R0 B2
& 6-29 o &g r External LO 3#54%
# Agilent | Power Prefix
—_ Change Prefix»

External LO Commands
Clear Prefix

Power Prefix ‘POH

Power Suffix ‘ DEBM

Freq Prefix ‘FREQ

Freq Suffix ‘ HZ

Auxiliary ‘OUTP:STHT ol

Move the highlight to select a field using the 'Tab' keys.

e Power Prefix (HLJFERTZ) , & T % External
LO # P44 .

e Power Suffix (FEJEHEZ) , wEH T E External
LO #5415 %%

* Freq Prefix (JRm4) , wEMT % E External
LO S5 42 .

e Freq Suffix (Ji%)54) , wEMT % E External
LO SR 2 M a4

o Auxiliary il , &40 External LO (41,
ik LO sofs LO jeE e CW 1) B i Hish b

%,
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Alignment
GRAE

& 6-30

Setting Time
(REQRtiE)

Min Freq
(RARTZR)

Max Freq
(BBME)

BIERES %
SYSTEM (H%)

ZEEE NFA %) External LO 54 (F e AT Ta) . %8
EFR A KRR LO 2 5w FAE e AL IR « A3 30w & TR
£ 0ms Al 100 s 2 18], BRiA{E4 100 ms.

ZEE Y E NFA #5F External LO G S EH %, B
NME N 10 MHz.

ZHCE NFA Ty External LO BA i . 2R
WEH 40.0 GHz.

fFHC Alignment SEFREE, 2 BEHE NFA RAFRE, JF RVFEIE s

B,

Alignment CGA#) FHaE

I Alignment

Alignment
0ff O

Alignmnt Mode
Point Sweep

Align YTF

Save YTF
Alignment
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BEE

WLRA

Show Errors
(BTHEIR)

BTERE S %
SYSTEM (%% #

Alignment

GA%) £ Alignment(On) C#E ($T7F) ) JHH NFA (1 H3)
WHEDhRE, MOMBROINECE . 1E$E Alignment(Off) (i
CRHD ) ZER B 3hRAEDIfE .

et FEANESE BOPRE P s AE N AR 2P RIS DU R, Sl S0 W s v,
M TTTASE A T AE A o

Alignhment Mode

GRERER) 1 F% Alignment Mode(Sweep) CHERI (F9#5) D 3
M NFA FrRdEDiae, et oy BRIARE .
£ Alignment Mode(Point) CEYERI (5 ) H A
#E, TR A SR

Align YTF

GAXE YIG B3aEkes) IZBRIE R YIG s sy (YTE) (¥
M. il s AN e R, T E IR Align YTF SR
.

Save YTFAlignment

(RE YIG ESER A X8 YTE HAEEE (R A7 R R A A fifias . £
P RArAE NFA (4R R0k RAM b, JFAE il v sl s
WG HARIR AR S . BN E 4% T Restore Sys
Defaults (k=2 RGENED KB 5Ok B AEAAAf 2
. iR M, TSI IR IZ Save YTF
Alignment 2 U4

7 N89T2A 1 N8IT3A M5, JLykffiH Align YTF 1 Save YTF
Alignment =2 ¥,

AR R G 10 MRS o iR e 1 00 .

Clear Error Queue
GERRSEZPAT)) 751 Show Errors (I RE5R) EoRF IS REAS
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BIERES %
SYSTEM (H%)

Show System WIS ARG S RS BHUCS . B S . R BRROR.

(BRES) RAM #1 ROM #ikt. eANE St R b i PR &AL, 4T ED
WU IR AN R) -4

Show Hdwr WA S ZFR. PSS, RS B S . BshikA. RAM F

(BREH ROM %, ShAME SRR (WiEfD NFA SEEBIER R A5
5 RIRRA S

Power On/Preset 7O g, TEST FHIEN A NFARERME. BHIETR R AS
(BEFB/ Fig) &6 NFA (HBEETTFEIRE.

6-31 Power On/Preset (HIFEITE / Fiik) KEH

|Pwr0n/Preset

Power On
Last Preset

Preset
Factory User

Save User
Preset

Power On

(BRFR) i NFA 50T 2 I NFA 5K . Wl he bk ik
4y Power On(Preset), NFA [ HJEFF JEARA N5 Preset
(T3 #id% FIa RS Wl o) Ews % h Power
On(Last) CHEJETFE (Be)a) ), NFARENLE BT
Je B 3 FH FL RO AT IN FRAR S
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WLRA

Restore Sys
Defaults

(RERGFROAMED

BTERE S %
SYSTEM (%% #

1% Preset 225 Power On % &',

Preset (Fiig) ZH'E 24 Power On(Preset) Jy Fribk 2 i 4 FH A ¥l 1t
R 1% Preset 8] L NFA 4 Tk, dde
Preset (Factory) (T (1) D) R NFA #iik 4R
T W EBRIARCE . 5k Preset (User) (Filix (7))
fuiF NFA i 4t Save User Preset ({771 /i i)
BoE XIBE . IHZAT S 286 7T “Preset (Tl
w7,

Save User Preset

(RERARMIL K NFA 1900 RS A NE R a7 74, 7k
# Preset(User) I, 7F Preset 1 H .

iz s NFA KRG R T B0OARAE. BT 2L IR, 10— Rl 4
g, UABTEEAME NIk,
PRI H e A B2 3R s e e (e, il GPIB ik,
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Time/Date
(rtiE / BERD

6-32

A7 BUR T 317 0 mP R A8 s SIS ol ) i L

Time/Date (FfjE] / HH#) ¥HE

I Time/Date

Time/Date
On 0ff

Date Mode
0 Oy

Set Time
1a1387

Set Date
20000413

Time/Date

BIERES %
SYSTEM (H%)

(B8 / BED JA H] Time/Date(On) (i) / H (FTFF) ), FTIFSEHS
et R, B0 0 Time/Date(Off) (infia) / Hil (¢

MDD RIS I AR o

Date Mode

(A#AE) i H Date Mode(MDY) C(H# (HHEY ), HHAH
FEk B H I, 53 HH Date Mode(DMY) (3,
(HAS ), HHHFER R H I,

Set Time

GEERED B A VF IS LS S TR . 24 /NF HHMMSS

NI RRR ) A U A I 8], AP B /N P 4%
Enter £ 14 A . fAR0he (HHD $({EM 00 %2 23, £
By (MMD FiFk (SS) Hfi M 00 % 59.
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Diagnostics
G2HD

Service (BR%)

BTERE S %
SYSTEM (%% #

Set Date

GEEBR#D ZEE AV RCE SR R H . H YYYYMMDD (4%
HIED #& U Y, A EC /Nt 4i JT 4% Enter 24104
Ao FREFER (YYYY) FifEM 0000 22 9999, HRH
7 (MM) #{EM 01 £ 12, HHIHEM 01 £ 31.

75 Front Panel Test (HyTIHMAR) S s,

Front Panel Test

CATTETHR ) FOVFIEAZ SR N AT T I Sh e (Preset [R4M) o FRCEE
Wit N, R RRS A S I—Ik. 183 RPG &
dsk ka3 H . 1% Esc iBH .

17 Service SZ U, %8 PEEER A4 BEGkEAF I . TEI51E S 1 Noise
Figure Analyzers NFA Series Performance Verification and
Calibration Guide.
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Load (FHAN)

BIERES %
SYSTEM (H%)

File (o)

HAPIUR TS NFA B3 LA (R AP R SRR 3
B SO RGAFERIA DOS Wik, B ABRIKE. 54 C BN
St IR A F S

SO S 5 M A7 IUE P TR B R MO T AE o 15T DL SR RSP R S
PRSI AF 3R G h O SCUFAE R RBER 5 8, IFHT S0 RS AT H k. Tab
B S VAR T HE SR 2 IS 3 3 UL P OB . % Enter BEBUTHRAE
SRR TSR MU A KIS 2. M Load File (B ASCHF) f File
Manager CCIFSEURTE) S, % T300g— o, 0T NiTs
PRIt L AP TR, M Save File (IRAZSCHE) 8, 14735 4t
Alpha Editor i A B SC1F 47K, T3 MESRIT FIBA LR SCIR4 5

AR g, AVFENEREL (A IKshas ok u3etiy (Co) IKah#n NFA
A ENR . RA&. FREI. SR m, BUesMzER . RS, 1EHAT L
DG T

1. FO@E Y, RRIEA ERN RS EA, Flh, Rk
Limits, B0 AAUER—4MHIZ: 1. 2. 354,

2. WEhas PR Path (G4%2) AHGHE 0T . SR 1
Select #EFEAT TR RSN 28 . WERIE CLAEshgsh, 52 “..7 BBl
4% Select, E# 5 —&WRah4%. M T AU #el RPG ¥uE 1
X528 . 1% Select.

3. MEHER I RN, 4% Enter,
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AIERESE

SYSTEM (&% #

ENR

State (k%)

Limits (BR&D

Frequency List
(SREH)

Loss ()

ENR S8 H T e s PR AE ) ENR 7 S0R Fexf
*o WA AFRES (ENR) o &2md
FE3E 24 2 i v s ENR SCfE 2 Meas Table (il 3%)
X2 Cal Table (FEHEZR)

RE A A VA . BANRESCAR VA 1 LA
TRAFIHIEU . BERSCAF i =P R JR 2% (STAD

BRI SCAF L5 BRAI LA, ISR AR, DAEAf 2 ik
AT BRI AR o 8 7 S0 T 43 > RS PR e R
FISCAFEBRBIZ 1. 2, 3iL)E 4. HHRICAFHA =475t
g (LIMD .

AR A SO S F T SR R e R ., IS —
NERRES (LST) .

RSO S AT AME R 78 7 0 e 203 2 1 =5 o
PeEWFESCIE 2 Before Table (201 &

After Table (X2 J5) . W UHMH = NFREINES
(LOS) .

NFA T LI A S2P Sefbkssl. NFA 2 a b
TN REA B s2p. 1 M s2.
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Save (R7F)

LRA

BIERES %
SYSTEM (H%)

IR, RVFEK NFA (1 ENR. IRES. S, R, SR n, Bk
AMER R DR HAR R A R A (AD RSB BN (C IRBhH.

Save Menu ({1 5 Load Menu (ZEASEH) AL, A[FEZ b
{RAFSE A FR P AN RSO 2R A, BISGER BE5E o ARAT S PRA SOV R 0 E
eetr o LOS 3o, S2P #& AAAEH T3\ NFA.

ARORAF LA, AT T AP BR:

1.

FEE IO e, RIS BRI R, B, iR IEmIE R
ENR, N7 %% £ Meas Table (JllE %) 5{ Cal Table (&ZUEL) .

6%, {f Format O XfidtEr, i k.
Wk A ZhEFE ARG, T Alpha Editor S¢ fui# A\ — 44475
SCAFAARRALBRAE AN T4 o

Path (#4%) XHGHEEG, RVFETESCEE 1 H hoksh 2% . M
Select CEF) BEEFFIHMEIA. WRECEERSZF, 4 “..7
Wem i 2 Select 8, S — G Wshas. A T #ok RPG s
s K25 . % Select.

IEAEA IRATIERS I, 1% Enter.
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AIERESE

SYSTEM (&% #

ENR (iBREEL>

State (%)

Trace (FhiE)

Limits (BRI

Frequency List
(SREH)

Loss( #i#)

Screen (B#¥)

ENR S0/ 8 FH T e e s P45 1E [ ENR /A% il st
#. ENR ARVFEAEER PR ENR &, 87200 %
&R s ENR SCfF /2 Meas Table Gl #%)
it /& Cal Table (RHEE) .

RS AR E . State RVFEAEA-AE S ORAF
NFA R

Pt Mg Sk (CSV) kA fjfr, aTH PC L
Bl R B, (HOE, oA EIR] NFA,

et AdngE, HEPUL R TR I VR PR S
T 20 M R AR E PR SO 2 PRI 1. 20 3382
4. PR AE AR IRAT o

B BSOS T8 2 O T-D0 & A A,

WG S0 S TR AN R o 18 T B T 0 Y 1) i o
YLERFESCIE S Before Table (K2 ) b &

After Table (£ J5) . W HE ="FRN G5
(LOS) .

W5 DR EMGARAT 230, SOV IS AR B AN G SC A 2 2 )
WHTEF. Bitmap (f7ED HERZHM (GIF) £
R EEG, Metafile (Jo3cff) HE Dot
(WMFPF) kAR #E G thah, D4R IERE O
R RIEG, ERMEGHEEHR. 1%

Reverse Bitmap (jx[1f7&]) ¢ Reverse Metafile (/x
II\EI;BAJL‘#F) SRR, ORAF S ) B . BRI TC 4]
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BIERES %
SYSTEM (H%)

File Manager AP IARE, SRVFIEIATEE DL B30 T iy 44 SO 55 D) Re

(XHEERERF)

Copy (I

SO S VP A IR BT AT T D e

SEVFRS HIANIR] (R 44 F00RE S 95 DL g — AN SO ey — AN
ey FEMFPEIE T 52 R I A4 F0D .

Copy fFHUT #1582 i .
ENR GErEEL)
AVFEYE I ENR S0,
State (K%

FeVFIEPE DUIRZS SCA
Trace (#hidF)
FeVFIE P DU A
Limits (BRI

FoVEREFE DRI S
Frequency List (i)
FOVFEHE DU B A
Loss (%)

FOVFRRHE DUSREAMEE ST
Screen (B#)
FOVFRE P8 VUG5 0o
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AIERESE

SYSTEM (&% #

Delete (HE)

SV NI EL NFA AR A
ENR (iBEEEL)
VMR ENR S
State (X%
SOV BRIR A ST A
Trace (#high)
FOVFRE N BRI S Ao
Limits (BRI
FOVFRI R BR A1 ST A
Frequency List (3fiZ#)
FOVFRI R A A B ST AT
Loss (ifi#)

SOV BRAUEAMEE ST
Screen (B#®)
FOVFRI R B a5 S AF
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Rename
(EF®A)

Format (&%)

BIERES %
SYSTEM (%% #

RVFET B 4 0. U 2RI L (8) ANMF7F
L.

ENR CiBEEEL)
FOVFREEB a4 ENR S0
State (X%
FVFIS E R i AR ST
Trace (#high)

SOV E B i 44 P STA T
Limits (BR#I)
SOV EOF i 44 BRI SCA T
Frequency List (3fiZ#)
FOVFRSE B Ay 44 IR B
Loss (ifi#)

FOVFRE B dn 44 SRR AME S
Screen (R#)

SOVFIE EFT o 44 bR SCAT

Y X0 i A% ik 1.44 MB kg, ASFE 760
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WLRA

AIERESE
SYSTEM (%% #

Save Trace ({EEHZ)

U Eh R, (RAFAE File (CGOfF) FREEMNA . 4 2 ek 2R A1
ZHnS, Y% File, HSZSH. WM 279 0 “File (3P 7, G KR
A AT B E KB o

Preset (#ii%)

ZEE N R 2 BN A — AN TR . % Preset SR U3 N TSR,
SRR SRS Power On/Preset CHRIETIF / i) SRHIETITE . 155
25 294 71 “Preset/Power Up (Filik / HIEE 80 B4l 7, T4 Preset
Je BT A

ICER T D REPAT — DAL ER B IR, (AL AR . 4% Preset &35k
AT e, HRRRIRE TR 0. 1525 294 1 “Preset/Power
Up (Wi / ¥R Z)D BEAL” i TseRAS Ui .

JFiE NFA SHATEs i, e i0RuididE .  (f2 T System 8 5
) Power On (Last) CHEJEIF)E (I)a) ) #iEHE, NFA MEERE
CRRYE G Z /D B o
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& 6-33

Print (3TED)

BIEWRES %
SYSTEM (%% #

Print Setup GTEIEE)

IR, SR VFRE ST ENHLIFIE R T EDHLIE o
S VIR R BT BV B 4T BN DT L AT B B =) AT ERL

KA,

Print Setup GTEI®RE) XKHE

% Print(Screen) (4TE (BE%5) ), #AJ51% Print Z01E4, 4760 NFA WoR
5 LN % . #% Print(Report) (4TE0 (55D ), #RJ51% Print Z)1EHE, 47
BVl nF Show System (R £#40) et 51 NFA {5 8. Show
System (/8R4 5 E0H NFA (77565, 5. BERACR 225
TR .
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Printer Type
($TEPHLZERY)

Define Custom
(EXESF]D

Orientation
(mEAE)

BTERE S %
SYSTEM (%% #

#7i Printer Type S g, MBOEIEFTEINLIF% Print #57, NFA 224K
P HITENNL. SRR, £ A3)7E Printer Type S i &
None () ik Custom (i) . #n] LLESE Fo1—AN k.

None (%) Mtz Print BT H G ] EPHLECAN 2 SCHRE T EIAL
5 NFA &4+, Printer Type #% F %1% % None.

Custom CEHD 414% Print #3F 1 NFA ikl & K3 ENRLR, 24
Printer Type ¥+ 3% & Custom. 4 Printer
Type &%k Custom 7414 ] Define Custom
CE SCEHD g ST EIHL.

Auto (A3 1E#E Auto JF1% T Print )5, NFA 220 54T EIL#E
s HIRAHATEINUARAS . WERITEDHLER A, FTER R ),
WoREs LA PTG . a1 NFA JEik im0 4T Ep
Bl, Printer Type <z H35)iX4 Custom, Jf7x— &
IS, ZR% 3% Define Custom & FTEINL. WIETEN
WIAZSZFE, Printer Type #: 021 4 None, JfHIL—
TSR THE, Tl ANIEHT ENPLANSZ S FRF

FEVFIEE AT EIHL.
Language
GEE) FVFERATEILE X Language(PCL3) (i 7

(PCL3) ) . Deskjet 4T EIHLEL Language(PCL5)
(&= (PCL5)) . Laserjet Z5A44TEIHL.

Color Capable
(RBEEN SV E ATEIHLI R LRE T . 4 Color Capable(Yes)

CEfaRe ) O2)) ga)a, fFTEWLRSEAGR). X4
Color Capable(No) CEifg s (%)) #ia )G, FTE
WA R&EEARE

feiFfEkds Portrait (40[7) =i Landscape (ffi) FTEN. KE[AJGHELE
PCL3 (Deskjet) T EIHLH L .
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Color ()

Prints/Page
C¥TED% / TimED

Eject Page (i
TIED

BIERES %
SYSTEM (H%)

RVFEAER O BCR FHTENZ AP . AL T IRA R, BRARERRRI4T
ENHLFE R . BLE Color(Off) J5, FOITEIRAEM . ¥ Color(On) &,
RAAT BN H o

UL T Y E A Portrait B, ERRE U FTENMF 4 H . 7F Landscape §1
Elr, Prints/Page 2% 4 1.

> Prints/Page(1) ¥ )3 I, FTERHLAE AT BN s th 0L . 4
Prints/Page(2) #{ /et HII, 4T EPHLAE S — 041 B0 i Hs DT

SRS ETHLL L 2 i DU

Print 3TED
1% Print $22 45 = Bl a1 A% 28 LURTHR € I BBAT EDFL. A ST BN T
1, ST 214 v “ ) NFA BCE4TEIHL .

4z Print 5 B REAT EVE 40058 SURATED L. FRAERAURSE (Toit—8
I LA ST BB . 2B A “Print Setup (467
B B, T AR AT E B LR E XU P

RS E A IEAE AT ROSTED, {EH] Esc (Hfd) .

F6E 289



AR

BIERES %
Data Entry (BN &

Data Entry (FiE@mA) #

Numeric (%) &

XL T NS R . AR A BN G, TR R
[ BLA S Bk B, Enter £ 2% EHIN .

Back Space GB#%&)

T8 1E R i A s 4m A\ sk Alpha Editor 4 H . #% Bk Sp < 1 Tab
RIS TFHE G S IEZ A,

Enter (&A\)
FHBC /N NFA b2 A C.28 DGR TBEH A 2.

XTI R, b A ] oy S L b H .

e File B 5,  Enter S HH TIRA7. BN #8501 R E B dir
43
Up/Down Arrow (Lt / F&:%) &

RSB TR AR A DUH DhRE(E,  IF I TAESCAFEFE S i) A RS
2.
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RIEWRES %
Display and Menu Control (ER53$iEs) &

Display and Menu Control
(Bn53RBaEH)D &

Viewing Angle (#if)

PR AR R S . RS, 0T NFA 72 B W3 il
o XA AR VFRRR M RIS ISERE,  LME AR B A FEVE B AR«
AWt Viewing Angle 4, iz AEHEE.

On T
ZE T e NFA .

Standby (&H)
kR NFA s, Wb —/NBogiglkst. 4 NFA 4T Standby £
BF,  JCATART P 22 I 206 % Bl H 05 2 A AT AT LA Dy e 2 F8 HL i

WG BR YR T — /N ek e (4 NFA 4T Standby #xUF, %2k
H LR DR R D G R L U2k A NFA I Wit
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1% AA

AR

LRA

RIE RS %
Display and Menu Control (®R53%$iEH) &

Next Window ¢ F—1 &1

Next Window 545 H 76 XU E R B WA R e L& DR R g 10 2 )%
kP, BUHE A — N,

Next Window 54 T2 AIE Ao 2, 1SS 4. Bl
HII S Hbmdif — A e (A .

Zoom (4t)

FEVFREAEILH B 11 AR 3 28 5 4 A0 4 B s 2 TR e 4 o
ANE DRIER R EESSR, TR E R,

Zoom A AE KB b A R «

Help (B
TZSEAE T AT T AR B AR I R B . 4% Help 25, N — MBI
WA o ds

BB w TR L 0 S A B SR AR LA By . B ARG, DRIk,
B HLARE X 2 AT DD g -

BN, AR (B Preset A1) , JEBRHIBIE L. % ESC
FOVFETE ST B A 1, A R
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RIERES%
Display and Menu Control (ER53$iEs) &

Tab Keys (Zfif)

SR DA 7 4 R A IR 2 IR T3 8 4% H IR =) Tab . IXSUHE] Tk #%
ZH, SAVFESIAES H . BAh, XSS SRR R IR 4% H B2 1A

%l

o JLEHSKBEEKINS A%H.
o LEHEkB AR AERINEH

o HEIBET PERKEH.

=Prev (Fi—1")

FEBIR PR — NS, ERIZESE N 5 DIRTIE R R, fREER
“RT B T HEERISETRT, Prev AN,

Esc (#83)

BOBHAGR B TIRE, JF Ao ds EIEERBLH IR SC Y. IXAERERS A IR TCVE ]
RPG. iy i g sl 7N B A A M A AT el

1% Esc B2 bATENE . 5 ERE AN B AR 38 IR A ARPIR AT il
BREH DRI o
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BIERES %
Preset/Power Up (fig& / RiR/BEN) 84

Preset/Power Up (Fiii% / HIFEF)) B4

NFA 7 f I E s i &, X LR B AL XA B

Prese/Power Up ', i state CIRZ) XfF. PUAEEA LSS

o ANRRELIEAL, e E YRR IR S O B AR AE AR, AMES state SUfF
) — o DR A

o A “BRAFTIV” BEAL, FETOAEHRYRTEIN S IR AR AR A, AT RUE
Jy state XAFM—H AR

o A NGRAET BRAL, AETBIEUR IR S AR B AR R R . AMER
State SCPFI— B ORAFER -

o > state #f4l, FEPBECRIEIEIA G IR B AEAF AR o AL RS T
B HIRIEIAE B, IR state SCPFERAF A o

Preset/Power Up (Tl / B¥EE3) — “Fpgk” B4
T B

“CRREL” WEAAHiE(E NFA B9ES <0 RAM b, FRAETis alia 1T f s A

JaWAR R AN E . A AEN state SXAFI—H 0 A7, PRIAE 14
State MAFHIAEZ ., 1% System # 771 Restore Sys Default ({k
BRI Bzt A R AV

CRREE TR H BN A A

e Automatic Filename Counter (3304 FRHH40
e Viewing Angle (#Lf)

* Remote Port Czfisi) (H47) 8¢ (GPIB)

* GPIB (WEsfRE o Hriicbht)

* GPIB (External LO Hufil-)

e GPIB (LO GPIB #fiik)

e Serial (H17) (Hfli &omnE )

e Serial (H17) CiFkAKI%)
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ATEWRES %
Preset/Power Up (Fiig / BiRE#N B4

e Serial (H17) B

* Serial (H117) (GUENL)

* Serial (H117) (fFIXED)

e Power On CHJHTIF) (gehid =20 (Fil)
e Preset (Fitx) (L)) = (H/"

o Time/Date C(ffa]/ HD (FTIF) 2 (L0
* Date Mode (HIEAD (JJH) s (HHA)
e Printer Type CFTEIHLZEE)

* Orientation (UUHEIJ71H) (A = (BT
e Color CEf) (19 st (KHFD
 Prints/Page C(fTEIff/ GlifD (1) 24 (2)

e Language (i5%) (PCL3) a (PCL5)

* Color Capable CEfEE))) () 58t (&)
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BIERES %
Preset/Power Up (fig& / RiR/BEN) 84

Preset/Power Up (% / B — “BREWMER” B
A1 H
“HRAFTNR” BEAORATEE NFA AR5 k0 RAM , JFAE Pl sz AT s i
JEHE HARIR AR S 2 AR AL R A AR, 9 NFA gk e s
JSAE IR 5 1A A B T N B8
AR T IE N state UM 0476k, DILAE state ST, 1%
HEAWRHT . 4% System 1 /7 [1) Restore Sys Default Ki% 2 5 1% 4 ¥)
YIRS
XL I H AN T FI
e LimitLines (fE#HIZ)
ZIH GG Type (CRAD o HAHHE Test (On) 2 (Off) #1 Display
(On) gt (Off)
e FreqList (Ji%H) His
* Before DUT Table (I3 E 2 i) H1 After DUT Table (il
Z A3 WHEAMEEHRE
e LO Commands (#FiF#E%S)

EFlfE4H (Power Prefix. Power Suffix. Freq Prefix. Freq
Suffix. Auxiliary)

o External LO (JMEAPE) , EL7HSTH
o External LO (JMEATR) , HILHZE
o External LO (AMZAPR) , EEiix

1% AR ENR Table ¥#z ({145 Meas Table fll Cal Table) & “kfEFiik” LA
—HBr. IS, B IEARNE A B AFAELE State SCIFH.
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L RA

L RA

WLRA

BIEWRES %
Preset/Power Up (Fiig / BiRE#N B4

Unsaved (KRR TWH

AR AE PR B IR E IR 2 JG AT R . B R E state SCIFAH
MR o B AR B BT I .

TXECRARAE I H BN T FE

o YR

o K& YR E

o FRIERE T

o [RILER T

o UffRA

State CIR#E) TH

H State #1715 H /7t #E NFA (985 RAM o, JR7E YRR R J5 )
P AEZAL . X2 H AL R TR o R YR PR T R . X SR A A
State SCHF—H 0. ZIH A ITA RIS / wfE R, JIA
“Unsaved CR{RfE) HiH 7 — 5 BAERRIM.

NFA [{) State xffixf£f#% Calibration Data (Ke#E%iiE) 1 Marker
Memory Trace Data (Frid fritigs il dicls) « Bk, %841 State 3¢
R

Calibration Data & 5 KVESdE, fEHRIRIEI k. (HAETBE A

Marker Memory Trace Data & %) < VE5d, 76 P sl YR 5 3 2%
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#6-2

AIERESE

Preset/Power Up (fig& / RiR/BEN) 84

% 6-1 s NFA (WARZGEVCIRE . BUEAIWILIRE N AR RER IR, oS

RS R AE R 5

SR RUARE

After DUT (HIAE 2 J5) Off (kD

After DUT Fixed Value Inactive (IEELE)  (0.000
(RN 2 i ] 5 ) dB)

After Temperature ()il JE) 0.00K

Alignment CIF#E) On (#T7F)
Alignment Mode CI#ERE) Sweep (F##)
Annotation (#{t1) On (#77F)

Auto Load ENR On (4T7P)
CHBEN B

Average Mode CFIEBIA) Point (i)
GZEEAE N89T2A W Lk D

Averages CTEIH) 1

Averaging CFI#) Off (KM

Band Pair (#7%) Inactive(Ref)

CEEeE (%))

Bandwidth (77 %) 4 MHz

Baud (5 9600

Before DUT  (Hilllhe & 2 i) Off (LMD

Before DUT Fixed Value
Rt D2 5 iy ] D

Inactive (FEEGEH)  (0.000
dB)

Before Temperature (2 {iji %)

0.00K
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AIERES %

Preset/Power Up (Fiig / BiRE#N B4

Bk RIUARE

Cal Table (BHEFR) Inactive CIEEIE)

Center Freq (H0i%) 755.0 MHz

(N8972A)

Center Freq (Hu0oiis) 1.505 GHz

(N8973A)

Center Freq (H M%) 1.505 GHz

(N8974A)

Center Freq (L) 14.75 GHz

(N8975A)

Color C¥fh) Off (=MD

Combined (44 Off (i)

Command Set (3544 SCPI

Common Table (FLf#) On (TP

Continuous (#F4%) Inactive (Off)
ERGE  OHD D

Corrected (f51F) Inactive (Off)

CIESGE  CGRHD D

Define Custom (& X 5EH]D

Inactive C(AFE0FE)D

Data->Memory
CHUl -> AP6iEa)

Inactive CIFEE)

Date Mode (H##=0) MDY (HH#
Data Terminal Ready OFF (P
CHs ot 45 )

Device Under Test (B3 E)

Amplifier CBCk#)
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AIERESE

Preset/Power Up (fig& / RiR/BEN) 84

S BUARE

Display Cf£75) Inactive (Off)
IR CRHD D

Display Ref (Z/R"Z%) Off (KM

ENR Mode G H A0 Table (%)

ENR Table (g LZ)

Active (ILHD

External LO Address 19
CHMEARPRHAE)

External LO Power Level 0.0000 dB
CHMEARIR )

Find (&4 Inactive (Off)

s GRHD )

Fixed Freq ([ & 41%)

Inactive (IR0

Format (#43)

Graph (FEJE)

Freq Span (M5 HD 1.490 GHz
(N8972A)
Freq Span (M D 2.990 GHz
(N8973A)
Freq Span (Jii# 5 HD 2.990 GHz
(N8974A)
Freq Span (Jii#yGH]D 23.50 GHz

(N8975A)

Freq. Mode (Jli% )

Sweep (FI#)

Graticule (J5#%) On (#17F)
IF Frequency (Hisis) Inactive CIEHH)
(30.0 MHz)
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HIERES %

Preset/Power Up (Fiig / BiRE#N B4

S BUARE
Limit Line (PR#HIZ) n

LO Control (A4#%H) Off (KD
LO Frequency (A$EHIH) 30.0 GHz
LO GPIB Address (A& H 2 8

(WPEES7S: 16| P)

LO Mode (AR

Inactive C(AFE0FE)D

Marker (krit)

m

Manual State  CF-3PIREA)

Off (KHD

Meas Table &%)

Inactive C(IEE0E)

Min RF Atten C(&/Ni#iER)

0dB

Max RF Atten i RK5#iggs> | 20 dB
Min uUW Atten (/Mg 9> | 0 dB
CiZBAE N89T72/3A ik AF AD

Max UW Atten (e K smo | 0 dB
GIZHEAE N8IT2/3A rh kAl HD

Noise Figure Analyzer Address 8

(75 F 5o M A k)

Orientation (LI /7 [A])

Inactive (Portrait)

CIESGE - (i) D

Points (i)

11

Power On CHEJEITS)

Preset (i)

Preference (F ki)

SNS

Preset (Fii#)

Factory (1))
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AIERESE

Preset/Power Up (fig& / RiR/BEN) 84

S BUARE

Print (4TED Screen (Bi%:)
Printer Type (FTEIHLZEZAL) Auto (H3
Prints/Page (FTERE / T 1

Receive Pacing (e ) XON/XOFF
Ref. Level (Z%/KF) 4.000

Request To Send (iR &%) OFF (XpD

Remote Port Gt 1)

GPIB il JH# 1 s )

Search Type (483357

Inactive (Max)

CIEBGE (k)

Sideband CiZ17)

LSB

Spot ENR  CHCkzEE I b ) 15.200 dB

Spot Mode  CHURiAE) ENR

Spot Thot  (FFCHIHWE ) 9892.80 K

SNS Tcod (SNS 3 &) Inactive(On)
CIEBE (3T7F))

Start Freq GEAAMAR) 10.00 MHz

(AEFE N8IT5A A 5)

Start Freq GEIHMH)
(PR N8975A H5)

3.000000001 GHz

State  CIRZE Off (KM
Stop Freq (£ 1EMi#%) 1.50 GHz
(N8972A)

Stop Freq (£ 1E4%) 3.00 GHz

(N8973A)
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HIERES %

Preset/Power Up (Fiig / BiRE#N B4

S BUARE
Stop Freq (£ 1E4%) 3.00 GHz
(N8974A)

Stop Freq (£ 1E45i%) 26.50 GHz

(N8975A)

Sweep Mode (HIffit=)

Cont (4%%%)

System Downconverter

(ARG M)

Off (KD

Tcold (A

SNS o RZER)
Default CERIAED

(R SNS KER)
Test GIllA) Inactive (Off)

CAEBEE OGP )
Time/Date C(if[H] / H D On (4T9F)

Trace (L)

Inactive (Data)

CIESGS  (CBd) D

Transmit Pacing (&ki%E4)

XON/XOFF

Type (K7Y)

Upper (E£)

Units (A7) CBRIARE A HEEO dB

User Tcold (H A MRED

Off (GHD

User Tcold from SNS CkH

SNS R A5

Inactive C(AFE0FE)D

User Value C(FH/7ED)

296.50 K
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7 W= HERR

AT A3 A A e AR e AT SR AT g 2 BT SOR [RTEAT 4RI R
B SHMERIEITA BT R Bl .
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BIBEHERR
FEARRE

AENFRE

A AR A, 7 M 7 i 5003 BT 0 LR AT 23 BT DGR [T 4B 115

Ro THANEALFE T 43 BT AP B S

IR 3 BT S B T SRAE AT SE AR S5 o (ELIE, o TR A 30 ) st ol 2 75 2 B

{5 REA ST W EIERp#F, Agilent HI4ERE 5 IRS MM SR SR

A R P T I SR

— MM, T REE R ) R AR R B R . W IR LA

— MR, SR DS I ) R

1. PUATATE A AFEA N g F P A . DU ] B 2% 58 A
B 2 1 B

2. R, A LR

o FAATIEEEL: WESPIAT R “ geEikm ” —5.

o Ko HTGE P Agilent Technologiesf&HH; i B0 AT SR 7 1316 101
WEkE7E Agilent 4EE A RN, NARSEHOR A K ETH KB EE (PR
WAFMIFED
WAL 8 R el ) Agilent 4E45 11 RIWIFR, Agilent
Technologies fEf &A% 5 & E A BT FH . HERSTE S “ Wif i
7% Agilent Technologies” Fil “ Wi 20 Hr 4G [FIBEA T 4E15 7.

DA RAEMERAE REBRM. FhEBARETESE. A THILB,
EBAIT I B

306 FTE



S HERR
#;4 Agilent Technologies Z i

H

¥ Agilent Technologies 2 i

KA A 7 &

20y T LU 1 W e A N AT TR D SR A i . AE ST RS Agilent
Technologies 2 fif slokt 73 At (UR IBIHEATHEE 22 T, WEHEAT R A &

W

a
-
-

[SREREV) LN RN

i rh e TR Y 2

IITOCRBATIF? SRR EIS :, XN CEITH .

W BRSSO RIR R, e TRk A LA L Viewing Angle

LD B WR W A RS, AL TR A LA )R Viewing
Angle .

DR SR P R T A EAEAE A AT LA e % . FREANERL S, Il
OPRTES b2 SN 6 (S

F% B R AR I AT (DN D R . BT AT [ B AR AT LA 2

WER DI HATCVEF LTI PRZAS VR, 1% Preset (Tt 8, {E0HT (0GR
o] —Ff DR .

FL T E AT Preset (K500 . 40 LIS B /3 AT N0 &
HEMINTT RIEN FPRES, % System (R%0) . Power
On/Preset (HLJiJT)H / 1) . Preset (Factory) (Tl (I
J 7))
WA IEAEREAT 2 TS5 R AR A A AR R BB N ? Ak
NFA }its, %2z Agilent NFA Series Performance
Verification and Calibration Guide 1] “H A" —i,

K TAE AT SRS, DAUHAREDHT{C. 4% System. Alignment (%
#E) . Jf /5 H Alignment(On) (K#E (4TF5) ) o a1k Alignment(Off)
CRefe COGHD D A, B4R A 3 CIF,  S2RRAE T
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WP HERR
B4 Agilent Technologies Z#i

O O SR — AT BRIREL Y AR B, TS AT R “CRHR IR

Q g BEMNR K%, EHIT Agilent NFA Series Performance
Verification and Calibration Guide ({1 GERZ SR . PR
JEETEE REAZ SIS il sk R s T A &5 AL .

5] 52 4H R
A DA ORI E AT MBI o 8PSzt 0R, AR RE.
R T2 53— B AR, TSI AR .

YEBIEIR

Agilent Technologies it JLRH e ] 4B THRY, AEHE DRI S %5
IPMTACHRBE RS R 5% . VRN FLYA Agilent Technologies #8545 4t .

s Agilent Technologies

Agilent Technologies 7i {7t & #ids we A58 SRS Ak, I Hr iR
PET SR . AR A RGEBME R, E5R T-1 s i s s i
Agilent Technologies #4555 AR . 1EPTA AE R ECRIG AT R,
TR I AT A= i S s SR S AR . (4% System,
More 1 of 3. Show System (W RFRZ) , Ty, 55 FEAPFRALE B
SN BERE T IR D) SIAME T UG TR FIE A —AN 7 5 h5%
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S HERR
#;4 Agilent Technologies Z i

*7-1 Agilent Technologies 848 5 R4 4b
%

Agilent Technologies
HLig: 1800452 4844

JIIE-DN
Agilent Technologies Canada Inc.

I 0
FLiE: 1877 894 4414

R

Agilent Technologies
IRENESR ==

R E S LA

& (31 20) 547 2000

HA

Agilent Technologies Japan Ltd.
HLiE: (81) 426 56 7832
fEE: (81) 426 56 7840

BT S

Agilent Technologies
P ] SR PN DR ER, S
Hi%: (305) 267 4245
fEH: (305) 267 4286

BRI / 06 2%

Agilent Technologies Australia Pty Ltd.
HLiE: 1-800 629 4852 CGHUKHE)
fEE: (61 3) 9272 0749 GHCH)E)
HLiE: 0-800 738 378 CHti>=)

fEIT: (64 4) 802 6881 CHii=)
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%71

WP HERR
B4 Agilent Technologies Z#i

Agilent Technologies 458 5 k44t

M RHEX

Agilent Technologies, Hong Kong
Mg (852) 3197 7777
fE3L: (852) 2506 9284
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BB HERR
WG ST UR B THE S

1% A

AR

WAL 45 3 A SR [BIEAT Y4B

5 R TS

R E M GE 1] Agilent Technologies HEAT4EME, 1541 H ik
T, HBE AT 2T o W RS s . i SR E R T WoR
LA GORE, BEEIHE T “HEREIRIE R, BE AT AR
B I MTACE RS HAREE, E B 25 B H% DR 2 B A — T8 2 .

R A%

EEIEZ AT, PTG . AR B,
EE e

BSIAES T WAL T 8a A, DU > 128 FE P A A B T ek .
ZK 7-1.

ez kit 2 A A KBl s v, ATz 18 A vh A S A (K mT e
WEREAT Jss it at, AT A2 AU
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BIBEHERR
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formt122
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T

BB HERR
WG ST UR B THE S

H Atk

AR E WA BT RE A T A DIZIAE AR TR TN SRR 1
AR EATTIEAE N s (38 A BB b i e AR P g 2, i
AR, BT R R, FEAS AR, IR AR R
BB A SRR A0E 2 K B 37 B B A e P A B o IR SRR
ISR 0T BOT FLECRR, LA A < .

RET LA IR 2077k FH vy AR B R A3 s

1. A el s 10 B B R4S

. PERGBE IR 25 v 2 B S R A B 1 A

IR TR R, KA A b IR TR B, AR

TR LE T, DI AR T A o

BT E A A AR, DA /> DR e R S 2 P B8R 1 )

5. H—Agiseifigdfitr. ANEMa s BUE AT, A4, o]
{FHXUZ FLDFRE R 169 A1 (350 #5) M4t E. L2 My
/b 3 & 4 P, S Bkl

6. FEBLA VYA BCE = ST R AR R, bR S AR EN B af
WA A, BB B Sealed Air Corporation
(Hayward, California, 94545) /771y S.D.-240 Air Cap™,
Air Cap & b %% —Hulify 1-1/4 SR 8R40, ARt Air
Cap, WD, HIZM BN 3 LR RERE GRS 1 6, X RER 1R B 4%
EARENE).

7. 4L e el R e G s b

8. fEigfif LIEW “HRE, OIS, ABERAS EE YA EE.

9. RAZHTH I RH#E DL,

2
3

P
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WP HERR
NFA gtz 8

NFA ##if5 8

NFA fff AR dt, DMENAEORAFEdE . st 2ede HHENTE NFA Joiitk b
—A 2.

HTE 25° C B SR A 7 45, 76 55° C AR e H %4
frA AR n R ) v it b sl i B S R Lk, 1E S
Agilent Technologies £ % . 1§24 308 W “ Wifi i Agilent
Technologies”, K134 5B il i Agilent 4485 55 IR 45 b i 5.
RIS AS B AT S I, AR RS UL SO R R, SO R BT
BRI AEEAT S o

femr el ) Agilent #8545 5 540111 Agilent NFA 45 3 W S0

e NFA ijth)s, 85 tobeas B5 N dgith 54 H 3]
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BB HERR
EiRLR

G

RIS

IIMTAAEBRAE R R v 2 A8 s ds B AR RN IR o 0 = Al

A OB SR AUE R, 2T Tl XS B W S8 AR RARESA T
R EAE RO RS, W S E, R R L, EREHHR
BT, 4% ESC B ARREAT H s o) — WAHE

MR DA IE A 1) 7 BB 5 — Sl SR I M (9 R A7 S
) B, S HIUH P RIRE . B ER R N T R gm FEde &
2o E R . XSS E IR R AR RS AT, iR
B ongs, NIRRT, BB E R RS b, HREBR T
% ESC S /EIRSATh Won 7 — RS . 4% System. Show Errors

CRNEED MG 10 WS R HE R B4 . i e 16 2h A2 R
Je, WERE A R R IR R R O, TR TS A
WS, T EANR SIS AL 1E System. Show Errors 4 %51 K iR .

BRH T RO T BE AT 2T RO . BRI S s 2 o SR — AN T HE Y

Voo WERE AL R, HEPT 1T858 T I RO 212
o
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WP HERR
HIRHA

fFRIRE

PLUR IR T PG R . RIE S0 Son . 105 B IE T 65
/1, #ilhn <filename> 5% <name> 20K DLATHAL ) B AR N AR B

<filename> file loaded

TRE RIS AR D DN

<filename> file saved

FRIE I ST 2 FR D4 R AR A o

<filename> file copied

FROE SO PR gt i Lt #5 DL

<filename> file deleted

FRE SO AR 28 R i B B

<filenamels> file renamed to <filename2>

Filenamel B4 5t E a4 4 filename?2.

Duplicate frequency entered in table,
old entry replaced

7£ ENR %, B, REILRMBHER T oA T EE &
Heo B4 H o4« H IR,

Each result type selected must differ
from all others

R PR s G AR I TR P ] (R 45 2R
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BB HERR
EiRLR

Volume<name>formatted

i AL C 2 s Xtk

Zoom active in graph mode only

B2 BRSO Graph () B

Zoom inactive when showing combined
graph

I i B Combined (414 , (ST B
P

User cal now valid

TS s, DT ICI R EBLAEA 2L

Invalid frequency list for measurement
mode

AR B ) AR TEVE I T A A TR P AT I

ENR table will be extrapolated
2R A ENR 2B #1 ENR (4.

User cal will be interpolated

X IEDE, RS PR AR A

Memory trace invalidated

RS BN AA A A LT ONBRREI ER, ik
FHEFE o
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WP HERR
HIRHA

Maximum number of entries in table
reached

CIAE ENR &, B ok BRI b 46 H 5 K8 H -
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BB HERR
EiRLR

RS

W T SCPI 3G shEAX A% 1 B P AT RO, D) 1) i T AR S s R BA A
1 SCPI Gt 1) FHEAZIRS o 52 T ArmdaEsh s, W2k
AT S B BAA, R AT RE R I 4R 7 45 SCPI A% A4, B g T4 s
(A KPR Tl A 14657 20 S ASE KRN B

A —AME e AR S0, BE G 2 BHEX S 5 N AR 1R 7. g iR
G T i SCPT #4%, Filt, 4%i% -350, “RAFIREHL”, 4%Ei5BA
B O IR HH A L 2 A A TR . IE AR S HARA S

T 3R 4E %5 B A & SYSTEM : ERROR : NEXT? (R ftin: T—
DD o AW IR AR R A%,

FRRsiie e +0, “TBRIR”, FORBHRASIE . Bn] ARG N 750 5 58 A
F, HEERIIACER, Ea AREE +0, “JotiR” e

AN B A RE S AR — LD BB RIE . BRI, BUFAE AR 2 uiE
WG HER RS . WA, S TOVEIB AR LESR 4 5 MR L 5t

B ] BE A AEAE AR EL S doem R R ORI O T o 8T LR APIRAS
{5 DA P RS 7 A R . IRASE R T DUOE An o 15 B — 28104tk
KA. (HAZ, WAURAE BU A RS A AR R R R,
TR O TR ARSI, BRAFERAS AT AW,
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WP HERR

EiRRLE
x®17-2 IR BAFHFAE
FHIE AR 7~ SCPI ZfE#: 10
HRRAF REAF
o GRS 10 30
it AL FE MR e . Lerk, ek /s
PRI, EFER R FH UL T H B 4 S B i
Bk -350,Queue overflow
K4 H 4. System. Show Errors | /ij SCPI #&if]
SYSTem: ERROr?
BRI ¥%:. System. Show CER YRR
Errors. Clear Error Queue | A% *CLS 454
CGEBREEIRRATID [543z A A7 A 1 B g — AN H
AR TAERR

RYE AR SRS (“N 2 17 ) Tkt S E a1k,

PR HES o

AT, MRS MR, B DR RIS e R SRh BIY

o — MR (i, -400. -300. -200.
FEDAUE B s (R

-100) & “HKE” ik,

320
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BB HERR
EiRLR

IR RE

FAEAS AL R, G, A A WA R S A S A AR
P PATEHR LR

-499 % -400: XL TR AR A A S 42 SRS I 81— Wb, TR AS He i LS 6
Query Errors (& IEEE 488.2. MR FARE A7 TR ENTIERS. (F7 2)
HEEIR) (IEEE 488.2, % 11.5.1 1) . X555 IEEE 488.2, 6.5 H#ifiid il

SATHI B RIS Y o AEBERIEIE T -
o FEJCHA R H A A AR DE T Sl R BA S SR O,
o B BASI R EdE D2 E k.

-199 Z -100: TXEHER B A TR R I 2] — 4 IEEE 488.2 15748 . I BRHEHR K
Command Errors & RS FEL TSR (f75) (IEEE 488.2, % 11.5.1
€41 ) o AEHAMEIE T

o WFHENIE R LAl E —A IEEE 488.2 AR
Wz —id e IEEE 488.2 brufEff il 24 Bl E . W AR AT4
LA 1 5 AT A% A s B R B TC I S M B 2R A,
o R AR VUNIAR S . ELAEAN A ) H AR B R URIAN T ) 5 OE v
#i7H) IEEE 488.2 L[4 .

-399 Z -300 #n XK W EIRAERIE 780, T REPRIAN I3 AR [ RO TR
201 E 799: XA T ANE T AN R . SR BE SR A A7 4% T I B AR
Device-Specific REHAL (i 3) (IEEE 488.2, % 11.5.1 %) .

E:rors (RE%E  SCPI 4w LiFHHR <error_message> (HFRiE) .
AiR)
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-299 F -200:
Execution Error

(HITHRIR)D

WP HERR
HIRHA

XL WA BT I SR e h N 21— WS R . R AR RS 3Ry

KGR B EFPREF AT SATHRA. (L 4) (IEEE 488.2,

11.5.175) . @ RAETFHFZ —:

o PrEI—A <PROGRAM DATA> (FEJFHd) Bior vl e & vl A
VAR AT [, BCE AT T R R ) A A 2

o HITHMAERD, ToiaE AT — A R IR

FEF NNE VAR AT R 2B e e B s A TR . 8 AN K Bl 1oy A

SAEAPATHARIR S o AR PATH IR ISR A A ST Rk Al

DB R

0: No Error CEG#4%)

0 No Error (FHEiR)

MI=E. IIFMENMEIREIEIZIMSEGRIRMER
BiRFF B *CLS ERBATI.
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BB HERR
EiRLR

-499 % -400: Query Errors (&E#j4iR)

A H A B 2 R 0 ) — AW, HAR A H UL 6 5 TEEE

488.2. IR FAPRAZ A A T R E IS AL (2 2) (IEEE

4%2,%u51%doﬁ%%ﬁ%ﬂﬁm4%2ﬁ5¢%ﬁ%mﬁiﬁw
ST BRI RV

CESERIETE T, P £ Tok HH ol tH AR5 RO 0T 25l M H A S A

fhi, B G BAS T e C 2 Bk

-430 Query DEADLOCKED (&1%/43)

WA SCPI sy A g1 23, FHLiE3E— 2447 SCPI 54,
EXT ) SCPT % A\ B\ Hh Jo 3 43 ) 2 Th) ml B A i,
BB A ) . REES HA A, B IEAEBI.

-400 Query Error (ZHHBIR)

o F T AR T 2 FARGE 2 B 2R 8 A i i . 1%
N ERRE A IEEE 488.2, % 11.5.1.1.7 if1 6.3
e R AN A

-410 Query INTERRUPTED (&8THE)

PRI 5 INTERRUPTED (F36) 4SRRIk
W GEZH IEEE 488.2, % 6.3.2.7 45) . #ln, #E—
W 25 5e 4 k% 2wy, BhE &< 1L DAB { GET.

-420 Query UNTERMINATED (&IBTLELIE)

PHHEILE I UNTERMINATED (Gikgaal) Al
PRI GEZ 0 IEEE 488.2, % 6.3.2.2 75) . #
i, BEEMTAWR, WEI— AR PR .

-440 Query UNTERMINATED after indefinite
response (RNENEZBEEWLELL)

VEIE AT T SRAN 2 N ) 2 i A ) — R R e 2
—W#E) (=0 IEEE 488.2, 5 6.3.7.5 1) .
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WP HERR
HIRHA

-199 £ -100: Command Errors (3§448i%)

TR AL 2] — A IEEE 488.2 kA R IWISH RS E TR T
fras e 24 (7 5) (IEEE 488.2, # 11.5.1 1) . fEMAMETE
N

o HFE RSN SR E] > IEEE 488.2 ik ik
(W2 — Wit IEEE 488.2 prifE i ¥l 242 BAlR . AR AT N
LA 1 5 AT % A B B R B TC I e U B 2R A,

o R AN TEEVUNIAR S . ELAE AN TEA AR B AR BURIAN I 1) 557
#1471 IEEE 488.2 JL[F#E4 .

-160 Block data error (EIRHREEIR)
A1 LR -168 SR AE D MR S o i A e 1R
SE A R VB AR 28 B TR 1) 5 AR A A R I
-168 Block data not allowed (RAUFHEAEIRLR)
BR|—AEvEEER sy, B — W M E S .

-140 Character data error (FZFEIBIEIR)

TR DL TS -144 R -148 765017 R 4l i i 7
Jlo AZAE R B R VIR AR 2R TC T2 DN ) SRR A B R I A

o
-148 Character data not allowed (ABFHERZS
)

B A ) B A — R T RS A
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-144

-100

-110

-104

-123

-170

BB HERR
EiRLR

Character data too long (SRFHIBTK)

FHEUERA A+ A LLESE (% TEEE
488.2, #7.7.1.4 1) .

Command error (HEBSHIR)

LD TE e I 2 S R AR DR B SR R TR A R . AURS R
A HE IEEE 488.2, %5 11.5.1.1.4 %5 & K44
B,

Command header error (IESIEIMEBIR)

PRA ARSI BIEE 1% o IR AR B e VR R 2 S LA 2K
RIFAE R -111 % -119 (MR EH .

Data type error (¥UBEAEIZR)

IR R T — A VRS . B, TN $
T EE, EAE R .

Exponent too large (3BEUIK)

e 32000 (iFZ IEEE 488.2, % 7.7.2.4.1
).

Expression error (FRIATVEEIR)

AR LU R 178 A5 208 S8l e I A e 1%
R B R IR A 2R TG A 1 B B AR R R R I

g7
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WP HERR
HIRHA

-178

-105

-111

-114

-161

-101

Expression data not allowed (ARDFEREE
IRTUEIE )
| A AL, TR A AR R

GET not allowed (RAVFER GET)

FEREFP I ] — M EAAT IR & Gif 25 IEEE
488.2, # 7.7 1) . &IF GPIB #3527, LME GET
AHIAE GPIB R AR AT .

Header separator error (IREDRRIEIR)

FEP MR R o B AN AR S AR L) B A ) 54

Header suffix out of range (IRFGRBHT
&)

SRRy Wi M A AL SR A R TE 2 o

Invalid block data (FoREUEIR)

TAH B P H s 2, (HiZs T (G2 IEEE
488.2, 5 7.7.6.2 1) . B, fEIEFIANGKEZ /T, W
F)—] END & .

Invalid character (LWZEK)

R B & — N HZR B TR 7455 B, bRty
—N & 75, SETUP&. Z4% ] e84k 515
-114. -121. -141 VL& HARAS R S ISR .
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-141

-121

-171

-103

-151

-131

-109

BB HERR
EiRLR

Invalid character data (LR EFEIE)

A AR O AN ERCTAT B R R S A
ARNREAINLID Y

Invalid character in number (¥SZDPHIT
W)

I8 B AT B R TR AR . B, Rk
HIL—ANF 6, 83 R B B —14 “97 .

Invalid expression (FTRRIEXL)

FEAB IS T (20 IEEE 488.2, 5 7.7.7.2
T o B, AR T S ARE AT .

Invalid separator (FICDOFRRT)
SRR AR — N WA, (B R — AN ERE A i,
TP S AT G 70 5 B A B

Invalid string data (ICMSBEIE)

WIS A Bk oy, (HIZEEE R TR GiE2
IEEE 488.2, % 7.7.5.2 %) . #ltn, {E&im5|5 72
AFSCE]— I END U .

Invalid suffix (GWER)

JRgiA R IEEE 488.2, % 7.7.3.2 75 PR AR
W, B e N AR EAE .

Missing parameter (FR/DS%0)

W AR B S ECECH LT 2D Biln,  *ESE JLFAIYE4S
TR —AN2H, NI RVFE *ESE.

g7
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WP HERR
HIRHA

-120

-128

-108

-112

-150

-158

Numeric data error (EZEIEFEIR)

TR DURR -128 fE i — DR RRZECY (BdhE
TRERIECT IR AR I N R 2R S B RIUEAE
PEE ORI BT A A RN G

Numeric data not allowed (RIFERAEZH
)

WO — AR HAR S D B A0 — B R
2G5y

Parameter not allowed (RAHEBSED)

KRNI bR S H S U H . #ln, *ESE JLHE4
M — NS, A RVFZI *ESE 0, 1.

Program mnemonic too long (FZ2RICIZIBEK)

PRSP rHE A G2 IEEE 488.2, %
7.6.1.4.17) .

String data error (SBHIBEIR)

AR DL R 158 E 0T A7 A e 3 I A ko
TR R A R TR A O VRAGT I 1) T L AP A R A

String data not allowed (RAVHERZHH
)

BR| A B HEE Y, BRI T R E A SLVFIZOK
i
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-130

-138

-134

-102

-124

-113

BB HERR
EiRLR

suffix error (GZRFIR)

AR LS R <134 =188 0T AN E BRI L. %
i S B R TR AE 2 BTG T2k 0 21 S AR R R N A

Ssuffix not allowed (RARAUHEARGER)
TE— N RVF IR IECE R G B — N a4 .

Suffix too long (G&IK)

AT EREEE T =AY G2 IEEE 488.2,
7.7.3.475) .

Syntax error (BEHBIR)

BB —ANTVEVUN FE 2 s8R . fldn, i AR
2N AN R

Too many digits (E{iYZ)

TR A ey A B 255 fr . (AR
Tk %) Gzl IEEE 488.2, % 7.7.2.4.17 .

Undefined header (RFEREN)

FRmg Bk R, B ARA X Z B AR B e . filtn,
*XYZ REFSHTATERE E Lo

g7
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WP HERR
HIRHA

-399 = -300 1 201 = 799: Device-Specific Errors
(CRAEEHR

FELORE R ORBEIE 58 ), ARG B T AN IR AORE A F B B IR P 8. X
LA S ANE T BN R o SRR DR B E AR A AR T I A
EHiEA (7 3) (IEEE 488.2, % 11.5.1 1) .

SCPI k& X /Fi#F) <error_message> i .

304 Alignment failed (E/ELK)
S e S i PRI
e Gain less than 0 (8%z/1\F0)
e AR, IF 075 s i /T 0.

* Microwave noise greater than signal
(MRIBERTIES)
B YRR PR UEAT I A LG, AR o S e 75~ T I
IF s BB, PR AR £E 24 A iip S 2k

e
AR 4R YT R AR A 2 AR AT, 2 BT R
AR I REALE ] T N89T4A F1 N89T5HA.

* Noise greater than signal (IBFATE
S)
HWoRinE CW 5 5 IAHEE, 7R 7 s e R - i
W, IF R e e oK.
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614

219

615

768

771

774

779

BB HERR
EiRLR

Bad or missing disk (BifRIRSiiRE)

AT AN B H ST i A AN AL 1
i, .

Command not valid in this model (FBESEHI,
S PIEIN)
VI M ZEFE S O R 3RS i S ANEH .

Corrupted file (JHEIRIR)
TSR BN S CHUIR

Failed to load ENR data (FE#F A\ ENR XIE)
23N ENR it & AR #E

Failed to load Freq list (FTEBAMEKS)
AR BN IR e AL s

Failed to load Limit Line (IEBAESIZ)
SR BRIl 2 B A 2B W

Failed to load Loss data (IEFHAIREH
)

ARSI BB

g7
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WP HERR

HiRE

772 Failed to store Freq list (FTAGMEMES)
SEARPRAT IR I R A R

769 Failed to store ENR data (IEBAE ENR
)
2R ENR R kA .

775 Failed to store Limit Line (IEGMEES
%)
SR ARAT PR I 2 st o A i

780 Failed to save Loss data (ILERGIRFEH
)
SRR PUAEEH B A i

778 Failed to store Trace (FEGAEHIN)
SARARAF PRI A iR

610 File access is denied ({EBEESIEL)
AF AR B Ba,  ToVEAFE

604 File already exists (XHBL2HBHE)
LR CEAEAE R SO MM ER B Brdn 44 IH SO, FHT
2236
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607

612

754

500

BB HERR
EiRLR

File name error (N{HE2FREEIR)

SRR T AN A . BRSO S 8 A
URFERST)  HEH 3 A PR B4 . W,
RE 5 KNG S8

File does not exist (XHEARBEE)
ST TG TE R B R e 1 S .

File does not exist (XHEARBEE)
1S H RS AT AE

Hardware config error ((@HUEBHEIR)

BT 71— st DR A il A 15

* Unknown product number (GRRIF~RSHY)
R R, T ANEE ™ S i, ok 2 i il
5 NFA 1977 it 5 AR VLS o obb k7™ F A A2 e B
o

e HW ID x in slot y not required (y#&Ed
ARREHAS x)
1Ey B R IL—5RARRE S X (PR, AHAS S AN 2
KiZR o WA AE T EHAE RN B 1R

e HW ID x must be in slot y, not z (f8f
08 x WL y 18, MARE z 1BP)
1 z FE ORI —5RACRS A x ()R, AR A i 5 6
TRHIN SN y Rl o i kg ™ B A P R R

e HW ID x is missing (R x fkk)

AP b WU — KA x B, (HORHRE]. Bt
T AR I R

g7
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WP HERR
HIRHA

300

313

302

e Measurement not possible (ILEHRTUE)
SARPATIN L, AH I —S BART )™ AR IS
FH L & R AT o

e Option 'x' not installed (&Il “x” K&
i)
X T AP S A A0 F AR AR I “x”, (HAR 2
NFA $22308 FHAZIg o, R it . bk E Al
PR ER . (HRIEMET 23 .

IF autorange failed (DMEBEHHEDIELMW)

HT FARE 2 — IF 2075 vk A s HE

e RF att. is fixed (BB BERE)
REF iy o % ok [#] 7

e RF att. limit reached OGXRESHAZRFEHE)
1A% RE i 5 9ok FR 11«

If over range req. RF re-range: Meas.
restarted (PIBLTE, RRIFMEFHI: NS
SHTIE)

(EFRRSEIN SRR, R TR 2375 Y RO, 25k
B RF Fidm eyl AT —fE55, I 205 A
2.

IF PLD error;Power detector read timed

out (¥l PLD 1R ; BRSNS ZENBE)
IF 735 e 50K 0 45 B U I o
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603

770

763

776

781

BB HERR
EiRLR

Illegal MSDOS name given (R S IEA MSDOS
BFR)

B T — M eRoct . RS A2 8 N FAF
R BERIE ) » I 3 MR B4 . IR,
AR KNG FBE,

Incorrect filename, allowable

extension ENR (RIEBBISERFR, TRFT B2
N ENR)

20 ENR 0017 204 R I A4 10 301

Incorrect filename, allowable
extensions are GIF or WMF (RIFHBEITAESR
MR, TRV SN GIF 8 WMF)

K bR BUR R A A A IE Y R 44 10 30

Incorrect filename, allowable

extensions LIM (RIEFASINLERIR, DT B
N LIM)

FEUCRE BRI Ll PR A7 S AN IE R 44 1O SC A

Incorrect filename, allowable

extension LOS (RIEFBSARFR, TRFT BS
9 LOS)

AR LOS DS e 4 frAr A A -

g7
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WP HERR

EiRiLE

773 Incorrect filename, allowable
extension LST (ARIEMBISHRIR, TR RS
N LST)
SRR B R R A R A A IET Y 44 10 S0

777 Incorrect filename, allowable
extension STA (RIEWMBSHERIR, TR BS
N STA)
SR ERIRS R E R A A By R A S

762 Incorrect filename, allowable
extension CSV (RIEWMESAERIR, TR RS
N Csv)
SRR R AT R A A IR R A4 1 S0

782 Incorrect SNS data format (RIEHf SNS iR
B
SR SNIS $iodis W, B3 A BT iE B2 2 A
SNS, al# KA H iih

307 Input attenuation x dB not calibrated
(AR x dB RRAE)
C&ERBEME, 2R x dB RF 57563 & iR
BHE
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751

216

308

306

701

BB HERR
IR

Instrument state may be corrupt, state
has been reset to initial values (XZJIR
SO EERIR, RESEIRNBE)

SARBATTRERIRAPIRG . AR BN SN2
AR o WERAPRAS A T B, PR B
B L) IRAS.

Invalid baud rate (FCRUBIEFR)

AR . WS (a1
#5270 7 “Baud (B 75 270 s aud GERR) 7

Invalid frequency list for measurement

mode (YT NEEINBITTIINEKE )
B B B — AN AR TGV AR M ar i g AT

Invalid input attenuation (TGRHMAZE)
SR BCE LA RE i i e g v R o

Invalid printer response (FTRITENVIAIE)

FEZARVUNFT DL AR v, W) — ATy . K i
R ROFTENHLZ SCHF o RSB Tad 2 g, JFHA
B AR EERL .

g7
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WP HERR
HIRHA

301

606

LO GPIB error (AREBEEORLIEIR)
BT R — %4 LO GPIB 4.

Did not become system controller (K
N RFEHIZS)

A R GefE AR 2 kM, TR 2 T LO GPIB

RE ECH G

Need to be system controller (EE/N
ARGEHIER)

MHATER P, NFA 20k LO GPIB &4k I
PIRGEFERIE, AR R G H# 1) 2 i T BAET )
SRR M

Controller collision (4IL)MZR)

LO GPIB Lffh—afdlaezily NFA [ H &

Address bus timeout (IBHRL&BR)

PR S B 2 R — A 7T P S e

Write command timeout (EAIESHBHR)
K525 NBEE I 2RI — K A ke B i 2 7 A
Read response timeout (ZEVWEIBR)

MBI (1 2 R — R A ke Bt ik 5 GPIB
HuEAN A .

Media is not writable EEATEEAN)
SR n) e R AT
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605

315

305

BB HERR
IR

Media is protected (BAZIRIP)
SR ) GRS EARAT

Microwave input attenuation x dB not
calibrated ({RAAMARB x dBRRE)
LRI I, SR x dB G i 2 gl 58 i AR
Rt

Mode setup error (FEIREBIEIR)
T R AR 2 — R AR A B R R

System input frequency out of range
(REBMNINKBLECE)

A EZ ARG AR T R AR
AT 4 H T LT 4 i E sl

External LO frequency out of range
OMERIRMEBLCEH)

— A E AL LO HiFE a2 LO S
TR IR, IR A A IR A AR S

Stop freq must be less than fixed LO
freq (ZIHREWIVNTEERIRINEK )

I A ERZ BRI U Tl 52 LO M.
Start freq must be greater than start
IF freq (RIBMEMIAATEIBPN)

Rk RE () DUT $A) Sk
R T#A IF OANDUT #arti) B

g7
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WP HERR
HIRHA

LO - Stop freqg must be >= min system
input freq (AIk—-LKRIEMEWA >= RICARSA
LS

i AR CEOR [ € LO Mk RF - (jm DUT
HIN) K2 AN TR RGNS
Start freq must be greater than fixed
LO freq (ERIBMENNAFTEEAIRINEK)

2 I R SRR AR PR UK T € LO Hie.
Stop IF freq must be less than fixed
LO freq (RIEPHNIVN\FEEAIRINEK)

M R CE R &L TF (N DUT #iit) AR
INTHEE LO S,

Start - LO freq must be >= min system
input freq (EI5-ARMRUIMN >= RIERH
BNME)

M SRk RE (g DUT SN S s
KT AR RS MAIE

Stop freq must be less than stop RF
freq (RIERENIUNTLRIEGHR)

M E AR R &R T O DUT fiit) A s
NTZERF () DUT i) S

Start freq must be greater than start
RF freq (EEIGMKINIIATHIBETHN)

M E AR A TF O DUT fit) A
KTilEsh RF () DUT fi ) S,

Stop RF freq must be less than fixed
LO freq (ZILGHRUNIVI\TEREAIRIMNEK)
i EAR Rk 20k RF (1 DUT fa\) S
Zi/ T e LO S

340

BTE



310

309

BB HERR
EiRLR

Start freqg must be greater than fixed
IF freq (EIBMEDNZATEEDM)
Hri EAR KA RF (1 DUT fa\) Sl
UK T € TR i

Start LO freqg must be greater than
fixed IF freq (RIEARMKUWINATEED
M)

I R QB R LO AR 24200k F [ e TF 4
Stop freq must be less than fixed IF
freq (RILHMEWIVNTFEEDIR)

M EAE R 2R RFE - (g DUT fa ) Sl
Z/NTE TR i

Stop freq must be less than stop LO
freq (RIEREVIVNFRIERIRINEK)

AT EE A E R ZOE RE (7 DUT A A
N T20E LO B,

No entries in ENR table (BIRtLEXDLEH)

SR BT E B T ENR % SCPI & if], (H7EAHE
ENR #% (Common. Meas & Cal) T4 H.

No entries in frequency list (JAXRBDILF

SR PR BT, B BT R 3k SCPI
A, (ESR PR E .
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WP HERR
HIRHA

311

314

700

704

705

-350

312

No entries in limit line table ([BH|&FE
=)

SR BRI R BEATIN &, Bl BEAT BRI Ze % SCPI &
i, AHAERICRBIZR P& H .

No entries in loss table (REZXPLFH)

AR T e T kR SCPI A if], (HAEF kL
(Before =% After table) T4 H .

No printer response (FTEIHTLNZE)
ST B LRI

Printer interface error (GTENHLIEOEIR)
SOIT RN A R o A2 ST ENPL I JE O 0d i H.

Printer type is none GFTEINNZERNRRN “F”)

T NI A% None, (A TEIEHEI T 4T BN AR .
7t Print Setup &L i e, FH 4.

Queue Overflow GATSEE)
FRRAF R LS AL, BV R, EAR D%,

RF re-range required: Meas. restarted
(BRGAEFHAI: NEEFH/SH))
HERSENBIZP, BKRENRF AIERM. SRATI—
15, NEFBREHBH.
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217

-330

BB HERR
EiRLR

RS-232 Interface Error (RS-232 EZHR)
T R AN 2 — 84T 8 O rh I R

Input data overrun (AHIBBRIGIT)
A AT T B R

Input data parity (BIAEFERLR)
HRATHE T B R

Input data framing (AAHIEEZREAS)
FRAT L Fh Y LA R

Output data timeout (HIIBBER)
AT b B

Command input timeout (FBSHABR)
A AT b B R

Self-Test Failed (BMZELMW)
BT A RE . —, HIE MR

IF test [x][y] failure (PN [x] [y]
)

RF test [x] failure (NI [x] BE)

RF gain (x) out of range (F#HUZE (x) B
HSEE)

IF gain out of range (PHUBHBHTE)
RF cal x out of range amply] (B3$fR)E
HBESEE amp [y])

RF amp[x] floor too high (§i#l amp [x] ¥
EPNES))

Tuner EEPROM cal wvalue out of range

(1F1&88 EEPROM RUE(EBHTEE)

g7
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WP HERR
HIRHA

501

502

316

766

765

759

e IF filter offset x out of range (Dl
fruxfﬁi%%?‘f\f%‘ X E&;\ﬁ)

SNS read failure (SNSZEVHE)

AR SNS SR, AT RE d1 T SNIS R S5l e 2,
90 AR 214 4 e I S KT T

SNS write failure (SNS BAHE)

K SNS AR, ATfg2 d$ SNS L85l b 2L,
[ZLIE TR A PN pCE:3LPI

Thot must be greater than Tcold (FWREWD
MATRIEE)
f25E T ek Thot 82, {HARE R Teold i/ .

Unable to format drive (IEBRIAINTNEE)
RS AL R B B A AR R

Unable to load file (LEBANKH)
SRR SO ) e A i

Unable to load state file into
instrument with older firmware date (J

BRREXHEBATERESHOEBINES)

SRR B — BB AT A RAPIRS SN — B 4L
LA o

344



752

755

757

760

764

753

BB HERR
EiRLR

Unable to load state from file (FIGEMX
HENIRS)

ZiX ) File Manager ulifi il MMEM : LOAD : STAT # A
AR R A DETHUE AT TT i 10 BH 5 | Ak s g S 1A

Unable to load state from register (o)A
NEFFEBBENRTE

2 *RCL 8 N AF 2RISR B S T ]
fe Ui BH 5 | kS Wi ) TR A

Unable to load user state, factory
preset was done (FIABMABPRE, 2T
FR)

22347 User Preset ‘K, [AtAfH Factory Preset
. BHBIRASTEN User Preset, FHr22ik.

Unable to query state from the remote
(TOENTIZERT)

AR AR * LRN 454 1) — B 7> A i A v
G

Unable to save file (LERBNH)
PRAT SCAF I e AR s SCAFARARAT

Unable to save state to file (IERIRSIR
FEXH)

23 M File Manager sk ifi i MMEM : STOR : STAT {47
RSN AT AT AT B 1 B 5 1R e 1 B A

g7
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WP HERR

HiRE

756 Unable to save state to register (IER
REFEANSTEE8)
M * SAV FE A KPIRSTRAF R T A2 R TR AT
AT REUEIH 5 | ke ) R A

758 Unable to save user state (IHEREHAR
=)
217 User Preset JR & 2504 .

761 Unable to set state from the remote (F
EMEIRRENRTS)
ZRB A BEIRASAE N SYST : SET F84 10— 40w B it
P R A s

703 Unknown printer (GREIFTEIWL)
SARVONFTEIHLIN, WG RN, AR A OEE R AT
EIFL. 47T Print Setup /5 1#) Custom FTEIALZ AL
EATEDHL.

702 Unsupported printer (RSZIFHIFTEOHL)

S — SFTEINL, AR ZITENLCE S b
ELEAE . Bltn, —&1U5% Microsoft Windows 7§
T EDHLAE Aot — 4%
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303

660

BB HERR
EiRLR

User cal invalidated (BPREL)
BT FARE 2 —IA P RS TTRL:

Meas mode changed CUEEINERN)
WA O N, AT H PR,

Freq outside cal range (JMEXBHRED
B)

> B AR S e A S P T P A HE R R Y
.

Fixed IF changed (BEDHMEN)

i IF SR Cae i, ARSI .
Fixed LO changed (BEEAIREN)

i€ LO B Ca i, A2 T RHAER I,
Sideband changed ( 1HFENR)

A DAL AT RHERTL Y .

YTF align error (YTFIEEHIR)
HH TR 40— i AT o4 SR«

Peak / floor too small (I&{&/¥E@I/\)

72 YTF e RE b, o e s i e fead . it
IR R, YTTF kR FrE A5 .

Image / floor too small (B&/¥@EiI/)

£ YTF JAEdRE b, HE e s - 10 B 4R B A5 7Tt
Mo IR IR, YTF WU i A 5E .

g7
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L RA

WP HERR
HIRHA

-299 % -200: Execution Error (#474%%)

-222 Data out of range (FIEBLTEH)
B4 A NSEHE H 1Zie 4 A LTs .

-224 Illegal parameter value (FEESHIE)
BMAN—DNREAIMUE.  (Fln, ] IR AN D

-225 out of memory (RBEER)
AT SO S8 1 AT AT 1 SR IR A

-221 Settings conflict (8E/PR)
TV — AN GV e i B AT 20, AR T Y ike &
FPRAETCIEIAT -

-223 Too much data (YZEIR)

Bt as R, FeS sl i, REXl v H5
Bt Sl o A A BES AR BRI HH

-213 Init ignored (FIBHEKRAM)
Fon T MR IEARAT, TEYIA TR L.

Hi A Restart S A/ BRI R, A IERER S INIT : IMM 2/ Rt

FtiR.

-230 Data corrupt or stale (FIBIRIASITER)
nREE LR W BUR 8, (B B E —IRAFEAK
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EL]

¥

10 MHz &%%:#;: , 137

10 MHz ref out (10 MHz &%
i L, 10

10 MHz refin (10 MHz &%
A, 10

3.0 GHz J1=><, 3

3.5 mm ZEHE, 3

A

Alpha Editor, 29
Eirg
Variable LO Fixed IF
(System Downconvert)
CAJARARR [ e D (R
4D, 129
Fixed IF Variable LO
(Upconvert) ([l 5
AR (AR )
126
Variable LO Fixed IF
(System Downconvert)
CRJARARR [ e D (R
40 ARSI , 130
Fixed IF Variable LO
(Downconvert) ([iil 5
AATAEAY R CRASD D,
123
Variable IF Fixed LO
(Downconvert) (A[Z5H
AR EAYR) CRA4D
124
$% Full Span (45D , 46

B
Band Pair Giixf) gt | 246
Help 8 §, 8, 292
e

ENR #%d , 39
Save (fRf7) KHif , 281
Save Trace ({#fEHLL) #:

286

RAF A, 24

Save YIF Alignment ({47
YIG BgER a8 e , 274

Save User Preset ({377 ) ¥
W) EHE ) 276

R 2z, 10

%, 311

Device Under Test (il
H) SR, 226

After DUT Table (#:ill3zg >
Ja#) RHEE, 253

Before DUT Table iz il &
ZHIHR) R, 252

Standby (%) #, 291

Local (Ah) # , 266

LO Control (A4R#HD sEH
B, 228

LO Mode CA#E#E) Fmst,
226

LO Frequency (ARJEHHR) 3
gk, 228

LO GPIB A A#A R
) ,10

LO GPIB Address (A#=ii H
B Rkl Sregt , 268

LO Commands (AJEIES) %
gk, 271

Sideband (i) SEHE: | 228

Edit Table (%) St ,
231

YT

PRHIZE , 95

Editor (limit line) (Zn4EFeT
(PRILE) ) et |, 255

AL, 140

PR, 70

Scale (#x/1) ## , 236

Scale/Div (bR / ZIEE) K
i, 238

Marker 1 (#ric 1)

Marker 2 (brid 2)

Marker 3 (#ric 3)

Marker 4 (frid 4)

, 73
.73
, 73
, 73

Frid , 73

TGt | 79

Wi, 76

W3, 80

R, 73

RE&, 75
Marker (¥rid) e, 245
FAC At as L , 79
Marker hric) i, 244
PR A

714, 75, 76

frigas , 79
RAEPFERME , 101
JeATERAR , 10
Baud 45 Zemgt , 270

C
XN, 6
Color CEfh) Kk, 289
Color On Off CEfth
¥FIF/ RHED , 289
Color Capable Yes No CEfafi
Ji: &/ /), 288
BRAFFIEE , 296
ZERN, 72
Ref. Level (Z%KP) s,
238
W
4, 84
e , 18
Meas Table (JFEZ%) ok,
232
MEASURE Gl Zhiig , 6
AR
N8970B Lt%: , 131
ARSI, 125
A, 122
System Downconvertor (%
g8 M), 128
Meas Mode CilE0) 4,
226
FEa ARy, 3

=5l
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EL]

FEARIED , 3
R Y A TR SN, 83
B U 4 F ) RE #iN , 82, 83
HEnELL | 33
ENR Table GEEmM:LER) 25
g, 231
ENR G#Ergtt) 4, 230
ENR Mode G LERE) 3K
B, 230
i)
HieilE , 323
Find (&) g, 248
Z{fbRE , 75
Delta (State) (Z{H CRE))D
SRV 245
Fret , 294
Continuous (¥rsl) SEHgE
248
Rename (FEHifrf) e,
285
R, 25
Restart (FFiHz0) #, 265
Serial (H47) FHEE , 269
AT
wH , 201
HATHAR I , 10
AbEEZNS , 28
TR, 22
Fill Table From SNS (M
SNS R EHgEE | 232
Fhgastrid , 79
RS, 209
I, 322
TR , 320
SCPI @fe#:11 , 320
2o, 209
R, 209
FEIRTUE
-199 # -100, 324
201 3 799, 330
-399 % -300, 330
-499 %2 -400, 323
&, 323

%X, 320
AR B AR TR

-399 % -300, 330
AR (201 & 799)
FEFRBAF , 322
R 321
B4, 324

, 330

D
wrxtbRid , 76
Band Pair (State) Girxl CIR
D) KipsE , 246
Bandwidth (i58) SEeg
224
ID (fR1H) sgrpgd | 232
Bandwidth (##%) , 52
On (3170 f, 291
ffk , 308
mihis (SSB) |, 145
Units (Hf7) SEqgd , 237
TER , 289
FIEN, JHAT
deskjet, 214
epson, 214
laserjet, 214
paintjet, 214
thinkjet, 214
Print (4TE)) SEigd | 287
Print (3TED) 48, 289
Prints/Page (FTEIF / TUHD
SCHEE 289
Prints/Page 1 2 (4TEIff / ki
12) ,289
Printer Type (FTEPHLZEE) 3%
HLgd | 288
FEHLA L , 10
Print Screen Report (3TEI5#
A, 287
Print Setup ITEPE) 4,
287
Points (/%) gt | 221
it , 314

Power Suffix (WG p
g, 272

Power On(Preset) CHJ5IT /A
CFUBE) D g, 275

Power On/Preset CHJsIT/E /
i) Kk, 275

FLYRTF SRR A

EX, 211

Power On(Last) CHLJ5TIT
(BJE) ) RHeE | 275

Power Prefix C(HLJERTS) EH
272

IEHIA , 9

Tab Key i)

SEQI TR, 206

Settling Time CERiHfA]) 3
g, 273

Define Custom & SUEH]D 3%
g 288

Custom CEHD S , 288

SEMIES , 203

Tl &A1 IF, 83

IKTE /& RF, 82, 83

Huhk GPIB, 199

, 7,293

E

ENR, 33

ENR #E= , 34

ENR #KHE | 34

ENR R IE#EHHEHA , 34
ENR #ckifi , 39

F

Jif%, 68

Graticule (J7#%) g, 241

Reverse Bitmap (Ia4AzED
SR 282

Reverse Metafile (Jz 03¢
) ek, 282

Transmit Pacing (k%)
S, 270
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EL]

Freq Mode (Hlifizl) g
B, 220

Service (%) K , 278

Auxiliary GifiBh) ZH , 272

AUX OUT (TTL) iliBhiamt
(TTL) > , 10

AUXIN (TTL) il
(TTLH> > , 10

G
R R
WEiA , 119
MR, 119
Y rasiFEe , 117
KX, 61
Format (#&z0) S | 240
M AR |, 22
Format %) ## , 240
Common Table (FLf%) sgp
B, 230
GPIB Hbiil , 199
wWHE , 199
GPIB 5 5%, 15
KHbrid , 248
Limit Lines All Off CHRH
PR Kk | 256
Off (State) (GH CRE) )
i | 245
[i2 ENR, 39
Fixed Freq ([miZ) g
, 220
[l s (E B FEAMEE , 98

Trace (Hidr) SZipdl | 241, 246

H

Ja HAUER , 9

JETIACRFAE , 9

Escape (4#:f5) , 293

Esc (#4d9) %t , 5, 293

Restore System Defaults (%
HRFHINE) KN, 276

IFO, 83
IFU, 83
it

Help () , 292
Save Trace (fREFHLL)
286
Standby (&) , 291
Local A , 266
Scale (Fs/1) , 236
Marker (Fric) , 244
Meas Mode (&
226
ENR GEmr:Lt) | 230
Restart (FH/HZ)
On (317 , 291
Print (3TED) , 289
Print Setup (4TEN&E)
287
Tab CGEf) , 293
Format (%) , 240
Esc (#49) , 293
Result (4 , 242
Mode Setup (BzUEE)
228
Averaging/Bandwidth
By /), 223
Frequency/Points (Jii% /
M), 218
Prev (ii—14) , 293
Full Screen (45#)
Sweep (Hfi) , 261
Up/Down Arrow ( I/ F#i
S, 290
Viewing Angle ({1f) , 291
Enter (GA) , 290
Numeric (%) , 290
Loss Comp (#iFE4ME)
249

, 265

, 257

Zoom (4780 , 292
File (b 279

Limit Lines (fR#iIZ) , 254
Calibrate (&) , 225

Next Window (T4
), 292
System (R%) , 266
System (Local) (R4 (A&
H) ) o, 266
Corr (21E) , 258
Preset (#iiix) , 286
Back Space GE#%)
R FA R, 307
L, 12
2 A
A 48
FRHIZE , 95
R
Wi, 218
il , 249
Display (&7) , 236
System (R%) , 266
LA, 10
mikb 7
Result (440 %t , 242
SRR, 64
ST, 82
SRR , 61
Receive Pacing (e d) 3%
g, 270
WEUIRe , 12
Wbk 3.0 GHz JF=¢ , 3
25441
HEAT I 8 AR P i, 18
HATHEA RO M i, 84
TARSAR I, 153
RO ARSI , 174
B BRI
201 3 799, 330
-399 = -300, 330

, 290

K

DI

Copy (#U1) gk , 283
¥, 26
CONTROL (¥4 itk , 6
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EL]

L

User Tcold From SNS Gk H
SNS FIH AR SEHEE
234

Type (limit line) (M (R
2k) ) SR | 254, 255

Pcold (A% kg, 243

Tcold (A sKHAE , 234

Teold (AiJE) BiHE , 43

Teold (AiR)JE) gk , 44,
45

pUCE:2

10 MHz i3 , 137

H NFA £y 72l & , 137

R

10 MHz ref out (10 MHz =
FZa) , 10

10 MHz refin (10 MHz &%
wWA) L, 10

50 BXUBHIAN , 8

APC 3.5 mm, 8

LO GPIB A4z FH 4% 11 &
%) , 10

FEATE I, 10

AUX OUT (TTL) CiliBh#nt
(TTL)) , 10

AUXIN (TTL) @B
(TTL)) , 10

N#,8

RS-232 #1071 , 10

SNS, 8

M YR, 7

GPIB GEA#ENRZ |, 10

AN, T

415, 10

VGA, 10

WE P A, 7

AUX OUT (TTL) CifiBhig
(TTL)) , 10

N, 314

LO Wi &H , 206

VB ATEEK |, 146

M

Default States CERUIRE)
298
(52N
il B A, 51
Mode Setup (Bl E)
228

N

N8970B #is , 131
N8970B # [l , 131
P BB v

W&, 207
WIS RS, 54
NFA fig , 3, 4

P
M
HiTdm I, 201
GPIB i , 199
F RN E , 117
PUFEHME
#AMH , 101
[l 5 {E , 98
WHTE , 207
WHERL | 207
i YIF, 208
External LO (4MzA#R)
203
WA , 108
Averaging CF¥) |, 52
Averaging (F¥)) g, 223
Averaging/Bandwidth /1y
/AN, 223
Average Mode P 3¢
L, 224
Averages CP{H) Jrmig
224
AR HL
@, 48
AR, 50
i ze , 50

Freq List (Jii# ) g,
221
Frequency/Points (i / f1)
B, 218
Freq Span (JZJGH) S,
220
Freq Suffix ZE4) Hn
gt 272
SIES Y
5 , 46
i, 46
4 , 46
Freq Prefix CHiZRig) i
g, 272
SRR, 187
fitd: , 14, 69
Annotation fitiF) S
241

Q

R
WA, 5
I AR
RERBAAIRE , 320

Front Panel Test it
i), 278

AL |, 5

A TRTRR B N 2%
Ay, 3

Prev (ii—4> , 293

Clear Error Queue (kg4
AFD 274

Request To Send (iR &%)
SRR 269

Start Freq GEAMZE) L
220

Full Span (43D , 46

Full Span (4=yul) gt ,
221

4, 63

Full Screen (4)#) # , 257

K% 3.5 mm
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EL]

R
Phot (GIh®) K | 243
Thot (FEED #Uki{E , 40
RFO, 82, 83
RF A\ 3EpdulH , 58
RFU, 82, 83
3

WE , 213
Date mode MDY DMY (H#j

(%Y

HHE/ HAS)
HIww , 277
RPG, 7
RS-232 %444 , 10
WA, 22
el sy Agilent, 308
WHALEE o> BT SGR [RIE T 415, 811

S

S1 3%, 106

S2P fF# K, 106

S2 3k, 106

Spot ENR  (HUkEmBELL) SR
B, 233

ok ENR, 39

Spot Thot (ki )

Sweep (Hfif) # , 261

Sweep Mode (Ffifiz) g
i, 261

SCPI @ #4% H#5 iR b1

FHIE , 320

Delete (B> eipsd , 284

MRS, 27

A

Fixed IF Variable LO ([
g AR AR, 126

AR UL, 146

Up/Down Arrow (L / F#f
S B, 290

Upper Limit ( E[R) sgid |
238

, 277

, 40

BE
HATH A, 201
SELLET A, 136
GPIB il , 199
External LO (UMEATR)
203
A NFA f£4 7l &, 137
Bk LO % |, 135
e LO#iR | 135
% Teold (ARED
%E Thot ()
wEHY , 213
Set Date (& HEAD S |
278
WERE , 213
Set Time (WE IR SERE
277
Setup (loss comp) (KE (i
FEAME) ) Edg | 250
BRI AN , 60
I 7]
wHE , 213
Time/Date (H}fa] / H#H) S
W, 277
Time/Date On Off (ifa] / H
WD, 277
WM, 5
Viewing Angle (L) 4 , 291
WUATEH24% , 10
SIS I B
wWEH, 278
BEEINTE , 277
{EH#RM , 28
INEE
wE , 277
FINE , 110
Manual Meas (Fahillg) 3
HEE 261
FahlEfE Ay , 112
Data->Memory CHff -> 77tk
) SEHE | 241
Data Entry dEsiin) 4,
290

, 43
, 40

BT IE R, 16

Data Terminal Ready (%#fi4
e ) SRk, 269

LN

MR , 9

Enter UfiA) #t , 290

mARRIEH RF, 58

Ay N\ O , 59

WA , 58

Input Cal CiiAEHE) S,
259

HWIANIEH ENR ¥ , 34

INPUT 50 OHM %A 50 Rk
W ,8

Numeric (7)) &, 290

s, 7

SNS Tcold (SNS AiiE) s
B, 234

SNS iE#E , 8

SNS Setup (SNS % &) X
B, 235

35 , 80

Search (#3) gk | 247

Search Type (#328%) 3z
B, 247

Loss Comp (fi¥eshes)
249

PFEAMERCE |, 101, 98

Zoom (4ii) , 8

Zoom (g0 %t , 292

Markers All Off (Fifg#ric
1) SR, 248

e PRk , 93

i Alpha Editor, 29

PUEAMEAEA , 98

T

TR B PR 3% L 7

Eject Page (SfHTIM) i
f | 289

Teold Hi#i sk , 43

PHHE , 207

=5l
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EL]

Alignment Mode (internal)
CRERL (AR D SR
g, 274

Alignment (internal) CJJ#E
(NER ) Esft | 273

Align YTF(saving) G YIG
TSRS  (DRAF) ) S
B, 274

Align YTF Ci#: YIG R8s
) S 274

GPIB GEH##H R4 KRk,
268

Back Space GE#) ## , 290

B[RS ACEAT 4R , 311

w

External LO (4MEA$E)
FENLI ], 206
JEHIFES , 203
HE , 203
I (&R m A, 206
External LO (UMzAR) skH
B, 271
External LO Power Level (4b
BRI gt 228
External LO Address (#MEA
PRl e | 268
AMEREREES T
TR AT AR E B2 , 8
TS N SR, 59
Bitmap (f7[&) Hf, 282
“EfEIE DL, 308
REFRT , 54
R BFENCE , 108
WmEEIE , 44, 45
SCARAE , 24
AR IR
TRAE , 24
FwHwH4 , 25
%, 22
$#I1, 26
Misk , 27

HwA , 25
XFER A, 25
K S2P, 106
File Manager (CCAFEFIRLF)
S 283
File () #, 279
AL, 26
SCHEER , 27
AN, 25
VGA &%, 10
None () zmfg | 288
TR, 82
mEEIE , 43

X
ARSI
Fixed IF Variable LO ([fl&
PRI AR A, 123
Variable IF Fixed LO (nj4z
HROE E AR, 124
TARSRAS U, 146
BIR
R, 70
Frid , 73
st | 67
R, 209
HE, 65
Tk, 68
%, 61
ZERKA , 64
HtvE , 69
2JF , 63
WRsE | 72
RAMEHE , 209
EEE S, 209
AAEKETE , 66
Display (&) SkHift , 256
Display Ref (E/r&%) g
B, 238
Show Errors (E/ri5i%) ScH
B, 274
DISPLAY (&7 Lift, 6

Wi, 14
Show System C(E/RFRZ) EiH
o, 275
Show Hdwr CGrrfgiff) g
g, 275
Display and Menu Control
CRoR 53R psfD g, 291
AL , 73, 244
Limits(file) (PR (3CfF) D 3¢
FgE, 280
PR i £k
TR , 95
Limit Line (fR#I2k) s |
254
Limit Lines (FR#I2E) 4 , 254
PRI , 93
Limit Line 1 ([E#iZk 1)
Limit Line 2 ([R#fI2k 2)
Limit Line 3 ([ 3)
Limit Line 4 ([R#fIk 4)
WoRgiR 61
HES AL , 308
BHE , 54
AR R , 55
MANZEIRTEH , 58
JRIA , 54
AT , 56
Cal Table (K#EzR) ZEHgE
232
Calibrate iuE) 4t , 225
Lower Limit CFFR) Sgeaf
238
Next Window (F—A%H)

, 93
, 93
, 93
, 93

8

Next Window (F—ANE )
W 292

System (Local) (R4 (&
) ) 266

SYSTEM (E%) Dhfg, 7

System (F%) # , 266
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System Downconvertor (&4
D)
Fixed IF Variable LO ([f5&
AR AR, 129, 130
System Downconvertor (F%:
TASAY) SR, 226
RY N ARAR U , 165
RIE R
5%, 209
Corrected ({&1E) i , 258
Corr (BIE) % , 258
I, 3
%1 1D5, 3
ENR %34 , 33
bR, 73
WG, 52
BRI E A , 51
WY, 53
PRI, 48
PR AR, 46
Serial Number (J7'5) Zm
B, 231
PRIIATE , 187

Y

Orientation (UiffiJ[A) , 288
Orientation (TTHIJ7[]) SEH.
B, 288
YIF ###E , 208
TE i, 306
T4 I8,
B, 209
AT , 210, 286
User Tcold (HH /¥l Fm
B, 234
User Value (JU/'{H) SEH4E
234
Teffective CHRURE) gt ,
243
piiy
#0 (SCPD 442051 , 320

Remote Port CGzmfii) g
i, 267
Metafile o3ty St , 282
T H] , 8
Preset (#i¥)
JESCIRES , 211
ik , 210
REEINE , 212
Preset (Factory) (Wi (T
J 7)) EHEE, 276
Preset (i) %, 7, 286
Preset (User) (Hik (/7))
SR 276
Language (&%) PCL3
PCL5, 288
Y Factor (Y %0 4, 243

, 210

Z

Load &) s | 279

HmAN S2P wft , 106

WAL, 25

e 75 Y5

A=, 36
e, 36

WEFE YR, 7

YR E S, 33

YR RE , 33

Noise Figure (BEF45%0 SEH
243

Noise Figure Analyzer
Address (i FREHTIN
Hihb) Sk 268

Gain (i35) g | 243

Diagnostics (i2Ii) SEHg
278

IEH ENR #diim A\ Jrid , 84

IE IS 33

Normal (State) (iEH CR
D) SR | 245

FRAHRINE , 324

Command Set (3544) k5%
o, 271

HHEME SR (SNS)

etrid IFO, 83

fgodric IFU, 83

fenkric RFO, 82, 83

feabrid RFU, 82, 83

IF Frequency (4 32 ,
228

Center Freq (i) 3
G, 220

Stop Freq (&b SEmg |
220

State CIRA&) ZEiqfk | 245

State(file) CRRE CGUfF) ) =%
g, 280

M, 3

MAIN GPIB (Fi@EH AR
%), 10

Autoscale (HBIRR) R,
236

Auto (B3 R, 288

Combined (&) EHEE , 240

Ifk LO Bz | 206

Min Freq Opffsiiz) Eq
273

B, 206

Max Freq mmidis) gk,
273

, 33
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